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INTRODUCTION 

 
This document is for Consultant and State Employees responsible for the production or review 
of digital contract plans, specifications, supplemental contract documents, and contractor 
submittals.  This document covers the development, review and commenting, and submission of 
digitally signed contract plans in PDF format including revisions, the delivery of specifications in 
Microsoft Word format, the delivery of supplemental contract documentation in PDF format, 
and the delivery of contractor submittals in PDF format.  This manual also includes sections on 
the usability of these PDF documents.  
 
Questions or inquiries regarding the subject matter can be forwarded to the following contacts:  
 
William Pratt P.E. 
Transportation Principal Engineer 
AEC Applications  
HUwilliam.pratt@ct.gov 
860.594.3320 
 
Bruce Bourgoin P.E. 
Transportation Supervising Engineer 
AEC Applications 
HUbruce.bourgoin@ct.gov 
860.594.2760 
 
Mathew Calkins P.E. 
Transportation Engineer 
AEC Applications  
mathew.calkins@ct.gov 
860.594.2988 
 
             

 

Revision History 
 
Digital Project Development Manual Revision History 

 

 

 

 

 
 
 
 
 

mailto:Uwilliam.pratt@ct.gov
mailto:bruce.bourgoin@ct.gov
mailto:mathew.calkins@ct.gov
http://www.ct.gov/dot/lib/dot/documents/aec/digital_project_development_manual_revision_history.pdf
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DEFINITIONS  
ACD – The attribute applied to a revision requested by the Processing unit to an ADP discipline 
subset.   
 
ACD2 – The attribute applied to a revision requested by the Processing unit to an ACD discipline 
subset.   
ADP – The attribute applied to an Addendum discipline subset. 
 
Bluebeam – PDF software similar to Adobe Acrobat.  Bluebeam software will be required to 
package and markup all Shop Drawing Submittals. 
 
CSI – Construction Specifications Institute  
 
DCD – The attribute applied to a revision requested by the Processing unit to an FDP discipline 
subset.    
 
DCD2 – The attribute applied to a revision requested by the Processing unit to a DCD discipline 
subset.    
 
Discipline Subset – A multi-page PDF document that includes all the contract plan sheets for a 
discipline.  Example would be all the structures sheets would be packaged in (1) multi-page PDF 
document.   
 
DCO – The attribute applied to a design initiated change order discipline subset. 
 
DPD – Digital Project Development Manual. 
 
Engineer of Record – The engineer’s digital signature that is applied to the discipline subsets.  
For CTDOT staff this would be the Principal Engineer.  
 
FDP –The attribute applied to a final design plans discipline subset. 
 
FIO – The attribute applied to a “for information only” discipline subset.   
 
FPL – The attribute applied to an advertised FDP discipline subset 
 
Project Manager – Lead designer on the project.  For CTDOT staff this would be the TE 3 or 
Supervisor of the lead discipline or consultant liaison TE3 or Supervisor.     
  
Projectwise - CTDOT is currently using Bentley’s ProjectWise as a data management software for 
digital projects. Projectwise allows the CTDOT, and authorized business partners to access its 
data anywhere internet access is available. Projectwise shall be used by all consultant engineers 
delivering digital contract documents.   
 
Set File – Is a consolidated viewer file that is created using Bluebeam.  When this file is opened 
all of the contract plans, FDP, Addendum, Change Orders, are sorted by their page labels and the 
correct order.  
 
STD – The attribute applied to the “CTDOT Standard Drawings” discipline subsets. 
WDP – The attribute applied to working drawing for permanent structures submittals.  This 
includes the plans, calculations, or any supplemental documents in the submittal.    
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 Digital Document Requirements Section 1

1.1 Document Deliverable  
The following documents shall be submitted into Projectwise when delivering a digital project, 
see Section 3 of this document for submittal procedures for the documents below:  For CTDOT 
designed projects each discipline is responsible for uploading their own documents into 
Projectwise.  

Document Projectwise Folder 

PPI Form – Link for Video of Process: PPI Video or Document 
Workflow 

04.00 - Engineering Libraries\PPI 
Requests 

Final Contract Plans 100_Contract Plans 

Final Signed Contract 110_Contract Documents 

Contractor Submittals 

 Working Drawings (Permanent and Temporary Structures) 

 Shop Drawings 

 Product Data 

 RFI 

 RFC 

120_Contractor Submittals 

Engineering Reports 

 Hydraulic 
o Hydraulic Report and Hydraulic Report Data 
o Scour Report and Scour Report Data 
o Floodway Report and Floodway Report Data 
o Final Drainage Report and Final Drainage Report 

Data 

 Geotechnical Report 

 Environmental Compliance 
o Task 110 
o Task 220 
o Underground Storage Tank System Closure 

Reports 

 Bridge  
o Load Ratings 

130_Engineering Reports 

Executed Agreements 

 Sidewalk Maintenance Agreement 

 Lighting Agreement 
Bridge 

 Rehabilitation Study Reports 

 Structure Type Studies 

140_Project Administration 

Project Schedule 140_Project Administration 

Project Correspondence – Signed Copies of the Files 140_Project Administration 

ROW Documents 

 Property Map (.dgn) 

 Property Map (PDF) 

 ROW Parcel Files (.dgn and KML) 

150_GIS 

Project Photos (Engineering and Construction) 151_Project Photos 

Design Quantity Computations 210_Construction>Office of Construction 

Supplemental Contract Documents 

 Proposal Estimate 

 Federal Estimate 

240_Contract Development 

http://www.ct.gov/dot/lib/dot/documents/aec/ppi.wmv
http://www.ct.gov/dot/lib/dot/documents/aec/ppi_requests.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/ppi_requests.pdf
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 Calendar Day Estimate 

 Final Design Report 

 Categorical Exclusion 

 Design Approval Letter 

 DBE/SBE Approval with Percentages 

 Commitment List 

 Proprietary Item Approval 

 Standalone Transportation Management Plan Document, 
taken from the final design report 

Preliminary/Review Documents 

 Contract Plans 

 Contract Specifications 

 Other documents for review 

310_Review Documents 

Permit Applications and Preliminary Permit Documents 320_Permit Development 

Design Computations 330_Design Data/01_Final Design 
Calculations 

Microstation Design Model 330_Design Data/ Specific Discipline 

1.2 Projectwise Project Container 
CTDOT uses Bentley’s Projectwise as a document management system for all of our capital 
projects.  A project container will be created in Projectwise when a project is initiated.  CTDOT 
employees will have access to all projects, but access for consultants, municipalities or other 
agencies must be requested by the Consultant Liaison Engineer.  The Consultant Liaison 
Engineer can request access for these groups by emailing: Julie.Annino@ct.gov. 

1.3 Prerequisites and Policies 
1. All contract plans, working drawings, and applicable engineering reports submitted to 

the Department shall be digitally signed by a CT licensed Engineer or CT licensed 
Architect in accordance with this manual.  All contract plans, specifications, and 
supplemental contracts documents will only be accepted by the CTDOT if they meet all 
the requirements of this manual. Approval for additional development and testing of 
digital documents and procedures shall come from the AEC Applications.  

2. Digital contract plans, in the following stages: Final Design Plans (FDP), Design 
Completion Data (DCD), Addenda, Addenda Completion Data (ACD), Design Initiated 
Change Order (DCO), and Working Drawing (WDP) and all engineering reports shall be 
digitally signed in conformance with this manual. 

a. Digital signatures must meet the requirements of Adobe’s Certified Document 
Services (CDS) or Adobe Approved Trusted List (AATL).   

b. CDS, and CDS vendor information is provided at the following 
website: Uhttp://www.adobe.com/security/partners_cds.htmlUH 

c. AATL and AATL vendor information is provided at the following website: 
https://helpx.adobe.com/acrobat/kb/approved-trust-list2.html  

d. Trial CDS/AATL Signatures will not be accepted by the Department, a signature 
must be purchased from one of the CDS/AATL Vendors.  

e. Bluebeam Revu or Extreme is required for all digital signature processes.  
3. After contract plans have been advertised, the digital signature is not allowed to be 

removed.   
4. Standard Computer Aided Design (CAD) Applications shall conform to those listed 

here HUhttp://www.ct.gov/dot/digitaldesignUH.   
5. Use of digital signatures not conforming to the requirements of this manual must be 

approved by both the Office of Quality Assurance, and the Office of Legal Services.   

mailto:Julie.Annino@ct.gov;DOT.AECApplications@ct.gov?subject=Projectwise%20Access
http://www.adobe.com/security/partners_cds.html
https://helpx.adobe.com/acrobat/kb/approved-trust-list2.html
http://www.ct.gov/dot/cwp/view.asp?a=3886&Q=483668&PM=1
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6. This manual is designed to be used with the latest CTDOT Digital Design Environment. 
7. Digital Contract Specifications shall be prepared in accordance with the Departments 

policies and procedures for Contract Development.   
8. Supplemental contracts documents shall be submitted digitally in PDF format.  See 

Section 3.2.8 for supplemental contract document list and submission procedures. 
9. The Consulting Engineer acknowledges and agrees that Contract Plans submitted using 

the [Digital Submission Procedure set forth in this Manual] has the same force and 
effect for the purposes of the Consulting Engineer’s agreement with the State as a 
signature and seal of a Connecticut Licensed Professional Engineer or Architect as set 
forth in § 20-300-10 of the Regulations of Connecticut State Agencies or § 20-293 of the 
Connecticut General Statutes, as applicable. Nothing in this DPD serves as an 
authorization for, or endorsement of, the use of this [Digital Submission Procedure] 
generally by the Consulting Engineer, its subcontractor(s), or any Connecticut Licensed 
Professional Engineer or Architect with respect to other work it performs for the State 
or work it performs for other clients. 

10. Bluebeam Revu was used in the production of all figures and procedures in this manual.  
A license of Bluebeam Revu version 12 or higher must be purchased to perform all the 
procedures in this manual.   

11. Bluebeam shall be the only PDF software supported by the Connecticut Department of 
Transportation for the processes set forth in this manual. Import the Bluebeam profile 
as shown in Appendix A. This will place all the tools and tool bars in the correct location.  

12. When on call consultants are used for CTDOT projects, the title sheet shall be digitally 
signed by CTDOT following the procedure in Section 2.6.1 of this manual.     

13. All documents detailed in the processes in the following manual are uploaded to 
CTDOT’s Projectwise site.  To gain access to CTDOT’s Projectwise site fill out the 
following form: CTDOT Projectwise New User Form 

14. See section 3.2.1 for instructions on how to set up Projectwise the first time logging in. 

1.4 Format 

1.4.1 Contract Plans 
1. Digital contract plans (preliminary, semifinal, FDP, etc.) shall be in PDF format; PDF Plans 

must be sized either 36” x 24” for projects created before 6/2007 or sized 34” x 22” for 
projects created after 6/2007; PDF plans shall be measurable to scale in the PDF; PDF 
plans shall be able to be printed to paper and scaled appropriately; text must be 
searchable; and all levels must have the ability to be displayed on or off, unless 
approved otherwise.  All information on the digital contract PDF plans shall have been 
created from MicroStation or an approved alternate.  The only information that shall be 
added to the plans using a PDF editing software are as follows: 

 Page labels (see Section 1.6.2) 

 Sheet numbers (see Section 1.6.2) 

 Watermarks and flatten comments(see Section 2.4)  

 Any digital signature fields (see Section 2.5) 

 Digital Signature (see Section 2.6)       
2. Contract plans shall be grouped, by discipline into individual multiple page PDF files 

called discipline subsets.  Discipline subsets are not to be combined in a PDF 
Package/Portfolio.   Examples of discipline subsets are: 01_General, 02_Revisions, 
03_Highway, 04_Bridge, etc. See Section 1.11 & 1.12 for more examples of discipline 
subsets. 

Using a discipline subset format streamlines both the development of contract plans and the 
administration of the plans during preliminary design, FDP, DCD, Addenda, DCO and As-Built 

http://www.ct.gov/dot/cwp/view.asp?a=3886&Q=483668&PM=1
http://www.ct.gov/dot/cwp/view.asp?a=3886&q=459664
http://www.ct.gov/dot/cwp/view.asp?a=3886&q=459664
http://www.ct.gov/dot/lib/dot/documents/aec/ProjectWise_New_User_Form.pdf


 Connecticut Department of Transportation – Digital Project Development Manual

Issued 04-2016 10 Version 3.13 
     

submissions.  Moreover, it also leverages the ability to digitally sign the individual discipline 
based contract plan subsets per designer.    

 

Figure 1 Discipline Subset Bookmarks, Index of Drawings, and Signature fields 

3. See Section 2.5 for digital signature form field place holder cells.   
4. Plans For Information Only (FIO) shall be submitted digitally, in individual subsets based 

on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc.  These 
subsets do not require a digital signature, but each sheet in the subset shall be labeled; 
“For Information Only”. The subset numbers shall be selected by the lead designer so 
that the FIO subsets are last.  Each sheet shall be numbered correctly, see Section 1.6.2.    
Upload and attribute in accordance with Section 3.2.  

5. Utility drawings shall be submitted in accordance with the following:   

 Utility plans For Information Only (FIO) shall be submitted in a utility subset 
based on the utility company, AT&T subset, CL&P subset, etc.  These subsets do 
not require a digital signature, but each sheet shall be labeled; “For Information 
Only”.  FIO utility subsets shall be numbered so that they are the last subsets. 
Example Labels; 10_CL&P_FIO, 11_AT&T_FIO.  These subsets must have page 
labels assigned,  see Section 1.6.2 

 Utility company designed plans that include work being done by the State’s 
Contractor shall be submitted in a utility subset based on the utility company, 
AT&T subset, CL&P subset, etc.  These subsets do not require a digital signature.  
Example Labels; 10_CL&P, 11_AT&T.  These subsets must have page labels 
assigned,  see Section 1.6.2 

 Utility plans that are designed by a Consultant firm that include work being 
done by the States Contractor shall be submitted in a utility subset based on the 
utility company, AT&T subset, CL&P subset, etc., and shall be digitally signed in 
accordance with this manual. Example Labels; 10_CL&P, 11_AT&T.  These 
subsets must have page labels assigned,  see Section 1.6.2 

6. See Section 3.2 for uploading and attributing Utility Plans.  See Section 1.11 & 1.12 for 
more examples of discipline subsets.   

7. CTDOT Standard sheets shall also be delivered digitally.  See section 1.8 for how to 
prepare and submit CTDOT Standard Sheets.  

8. The first and second subsets in the project must always be the 01_General and 
02_Revisions respectively.  The Project Manager is responsible for determining the 
order of all other discipline subsets, Sections 1.11 and 1.12 show examples.    

9. Discipline subsets shall contain a maximum of 150 sheets.  
10. Discipline subsets shall be published directly from a CAD application. Scanned images or 

raster image formats will not be accepted with the exception of For Information Only 
sheets, these can be scanned.  
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11. Footers, displaying the sheet number, shall be placed on each page of each PDF subset. 
See Section 1.6.2, “Sheet Numbering”  

12. Each subset shall contain bookmarks; one for each page. Figure 1 displays an example of 
bookmarks. See Publishing_MicroStation_Content_to _PDF_Format.pdf for more 
instructions. 

 Figure 1 also displays examples of subgroup folders. While publishing, 
subgroups may be created to contain similar sheets. See 
Publishing_MicroStation_Content_to _PDF_Format.pdf for more instructions.  

13. Levels with the appropriate CTDOT names shall have the ability to be displayed on or off 
within the PDF document. 

14. The first page of the subset 01_General shall be the CTDOT digital project title sheet 
which includes an index of the subsets contained within the project, sheet count totals 
for all subsets, a list of drawings for the 01_General Subset, and an area(s) reserved for 
applying the digital signature(s) (see section Section 2.5).   

Link to digital title sheet: Digital Title Sheet  
Consultants will need to delete the CTDOT signature blocks on the title sheet and place 
a digital signature placeholder as detailed in section Section 2.5  CTDOT engineers can 
find the digital title sheet in the seed files on our W: drive.   

15. The 01-General subset shall include all detailed estimate sheets.   
16. The 02_Revisions subset must be included in each digital project and there shall only be 

(1) revisions subset.    
17. Subset 02_Revisions shall contain only revision sheet(s), titled “Index of Revisions”, See 

Section 4.3. These revision sheets are used for tracking all sheet changes due to 
addenda and design initiated change order (DCO) with respect to the entire project. 
These sheets are originally blank and unsigned, and shall be managed and updated as 
needed by the Project Manager. The CTDOT Revision Contract Sheets can be obtained 
here: 

  CTDOT Designed Projects - 02-Revisions Subset 
  Consultant Designed Projects - 02-Revisions_CE_Subset  

18. The first page of each subset shall be a subset cover sheet, this includes FIO subsets.  
This cover sheet shall contain both; an index of drawings contained within the subset 
that includes both drawing numbers and drawing titles and the form field place 
holder(s) which receives the digital signatures.  The following cell has a table for the 
index of drawings and the digital signature cell place holder BDR_Discipline_Cover Sheet 
cell.  This table must include the subset name and number displayed as a heading in the 
table. See Figure 1 for an example.   

19. As-built information shall be digitally applied to the contract subsets by District 
Personnel after the job is complete using Bluebeam.  See section 4.5.   

20. Preliminary Contract Plans shall be submitted to CTDOT in accordance with this section, 
but do not need to be digitally signed.  These review documents shall be uploaded into 
the 310_Review Documents folder in Projectwise.  

21. A Bluebeam set file shall be created at FDP and updated for any addendums or change 
orders in accordance with section 1.12. 

22. The Contract Plan subsets must be checked by the Discipline Subset PDF Checker in 
accordance with section 3.1. 

1.4.2 Contract Specifications 
23. Digital Contract Specifications shall be submitted in MS Word format and in accordance 

with the Departments policies and procedures for Contract Development.   CSI special 
provisions shall be submitted in pdf format.   

http://www.ct.gov/dot/lib/dot/documents/aec/Publishing_Mircostation_Content_to_PDF.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/Publishing_Mircostation_Content_to_PDF.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/ct_cgr_cps_proj_numb_titlesheet.zip
http://www.ct.gov/dot/lib/dot/documents/aec/02-revisions_ctdot.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/02-revisions_ce.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/bdr_discipline_cover_sheet.zip
http://www.ct.gov/dot/lib/dot/documents/aec/bdr_discipline_cover_sheet.zip
http://www.ct.gov/dot/cwp/view.asp?a=3886&q=459664
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a. For projects where a consultant is the Project Manager on the project, the 
Specification and CSI special provisions submittals shall be submitted in (1) 
zipped folder, see section 3.2.6.  

b. For projects where a CTDOT design unit is the Project Manager on the project, 
the Specification and CSI special provisions shall be submitted in individual 
zipped folders per discipline, see section 3.2.6.  

c. Design Initiated Change Orders shall be place in (1) pdf document, with “C#” 
and the date in the header.  An example would be “Rev. C1 - mm/dd/yy”. 

1.4.3 Environmental Permits – Under Development 

1.4.4 Supplemental Documents 
24. Supplemental documents shall be 8.5” x 11” pdf documents, except the proposal 

estimate which shall be in “.est” format.  These documents should be uploaded into 
Projectwise in accordance with Section 3.2.6 

1.4.5 Contractor Submittals  
25. See Section 6 for format, submittal and review requirements for Contractor Submittals: 

Working Drawings, Shop Drawings, Product Data, RFI, and RFC.  

1.4.6 Engineering Reports 
26. Hydraulic, Scour, Floodway, and Final Drainage reports: Shall be formatted in 

accordance with the following: 

 Shall be native PDF whenever possible. 

 Scanned sheets in the reports must have a maximum resolution of 200 dpi and a 
minimum of 125 dpi. 

 All sheets except plans sheets shall be sized 8.5” x 11”.  Plan sheets can be sized 
up to 34” x 22”.  

 Shall be digitally signed and watermarked in accordance with Section 2 of this 
manual. 

 Any data files that must accompany the PDF report shall be uploaded into 
Projectwise in a zipped folder.   

 The reports and zipped folder for any data files shall be submitted into the 
130_Engineering Reports folder under the applicable project in accordance with 
Section 3 of this manual. 

 Preliminary reports shall be uploaded into the 310_Review Documents folder in 
Projectwise.  

27. Task 110, Task 220, Underground Storage Tank System Closure Reports: Shall be 
formatted in accordance with the following.  The content of the report shall be in 
accordance with the Scope defined by the Division of Environmental Compliance: 

 Shall be native PDF whenever possible. 

 Scanned sheets in the reports must have a maximum resolution of 200 dpi and a 
minimum of 125 dpi. 

 All sheets except plans sheets shall be sized 8.5” x 11”.  Plan sheets can be sized 
up to 34” x 22”.  

 Shall be digitally signed in accordance with Section 2 of this manual. 

 These reports shall be submitted into the 130_Engineering Reports folder under 
the applicable project in accordance with Section 3 of this manual. 

 Preliminary reports shall be uploaded into the 310_Review Documents folder in 
Projectwise.  
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28. Rehabilitation Study Reports. Type Study Reports,  and Load Ratings:  Shall be 
formatted in accordance with the Bridge Manual and Load Rating Manual respectively.  

 Final reports shall be uploaded into the 130_Engineering Reports folder in 
Projectwise.  

 Preliminary reports shall be uploaded into the 310_Review Documents folder in 
Projectwise.   

1.4.7 GIS Project Location Documents 
29. Project location for all projects shall be submitted to CTDOT.  See Section 8 for the 

format and submission requirements. 

1.4.8 ROW (Rights of Way) Documents 
30. Property Maps and Parcel Polygon files for acquired property shall be submitted to 

CTDOT. See Section 9 for the format and submission requirements. 

1.4.9 Project Correspondence 
31. Final project correspondence shall be stored in the 140_Project Administration folder 

under the project in Projectwise in accordance with the following: 

 Shall be in PDF Format 

 The document must be attributed in accordance with Appendix E, table 7. 
Note: The discipline attribute must match the author of the document.  For example, if the 
Highway design unit sends out a memo for a design review, the discipline attribute on this 
document shall be HW.   

 Draft correspondence can also be created and worked on in Projectwise.  These 
file shall be located under the user’s applicable 330_Design_Data folder under 
the project in Projectwise.  

1.5 This Section Intentionally Left Blank 

1.6 Contract Plan Drawing and Sheet Numbering 

1.6.1 Drawing Number 
The drawing number is used primarily for sheet to sheet referencing, typically in, but not limited 
to; section details, section cuts, and detail callouts. Drawing numbers in digital contracts shall 
consist of the discipline designator followed by a hyphen and the sheet number.  Examples of 
discipline designators are HWY, PRO, IND, XSC, S, TR, A, E, etc.   
 
The CTDOT efficiently maintains the drawing numbers in MicroStation using the model 
properties and project explorer, See the following workflow Project Explorer to Manage Drawing 
Numbers  
 
 
The first sheet in a discipline subset shall have “01” in the drawing number as shown below: 
 

http://www.ct.gov/dot/lib/dot/documents/dpublications/bridge/bdm.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/project_explorer_and_detailing.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/project_explorer_and_detailing.pdf
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Figure 2 Contract Drawing Numbering 

1.6.2 Final Plan Page Labels and Sheet Numbers 
Page labels and sheet numbers are applied to the discipline subset after the contract plans are 
published to PDF. 
 
Page labels and sheet numbers shall be managed and placed on the discipline subsets, using the 
number pages and header and footer tools within Bluebeam.  Page labels and sheet numbers 
shall be applied to all submissions of contract plans. 
 
The first sheet in every subset shall start out at 01.  For example the first sheet in the 05-Traffic 
subset shall be 05.01.  

 

Figure 3 - Drawing and Sheet Numbering 

The page label and sheet number place holder shall be determined by the total estimated sheet 
count. For less than 100 sheets two place holders is adequate. For greater than or equal to 100 
sheets three place holders are necessary.  For subsets less than 10 sheets, two placeholders 
shall be used i.e. 01.01 thru 01.04 for a four sheet subset. 
 
The page labels and sheet numbers must be placed correctly because it is used to correctly 
assemble the contract plans into a properly ordered consolidated set that District Construction 
takes advantage of during construction of the project.  
 
Single Volume Projects: 
 
The page labels and sheet numbers, for single volume projects shall be a concatenation of the 
discipline subset number, a decimal point, and the sheet number. For example; the page labels 
and sheet numbers for subset “4” would be as follows; less than 100 sheets 04.01, 04.02, 04.03, 
etc or Greater than 100 sheets 04.001, 04.002, 04.003 etc.  
 
The Project Manager should determine the total number of subsets and give each discipline 
their corresponding subset number, see section 1.11.    
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Multi Volume Projects: 
For a multi volume project the page labels and sheet numbers shall be a concatenation of the 
volume number, a decimal point, the discipline subset number, a decimal point, and finally the 
sheet number. Example: Volume 2, Subset 5; 02.05.01, 02.05.02, 02.05.03.  
 
Volume numbers shall be used on large projects. They are effective because the Project 
Manager only has to deliver to the other engineers their perspective volume numbers, allowing 
them to manage their subset numbers independently of the other discipline volumes and subset 
counts, see section 1.12.  
 
Subset numbers shall start at 01 for all volumes. 
BLUEBEAM - Applying Page Labels and Sheet Numbers  
To apply page labels and sheet numbers in Bluebeam follow the figures below: 

1. First page labels must be applied to the discipline subset.  Go to the thumbnail pane as 
shown below, right click on a thumbnail and select Number Pages: 

 

Figure 4 - Adding Page Labels 

For subsets that contain less than 10 sheets the page labels can be applied to all the sheets at 
once.  In the case where there are 10 or more sheets in the subset the following will have to be 
done twice in order to get the correct number of place holders.   
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2. Select the correct style, insert correct prefix for the sheets being numbered, and apply 
to the correct pages.  For example, if the 04 subset has 99 sheets the prefix shall be 
“04.0” for sheets 1-9 and “04.” For sheet 10 through 99. 

 

 

Figure 5- Page Labeling 

3. Now the pages will be labeled: 

 

Figure 6 - Labeled Pages 
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4. Next we will apply the sheet numbers.  From Bluebeam select the Document tab and 
then “Header & Footer” 

 

Figure 7 - Header Footer Tool 

5. Place the sheet numbers, as shown below:  Note the margins may have to be adjusted 
as necessary.  After you select the font, set the margins, and type in <<PageLabel>> as 
shown below.  Then click save for save settings.  The next time you are going to apply 
sheet numbers to a subset, you can simply select the saved settings.  Then click OK. 

 

Figure 8 - Insert Sheet Numbers 
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1.6.3 Addendum and Design Initiated Change 
Order Page Labeling and Sheet Numbers 

Page labels and sheet numbers for an Addendum need to have “.A#” at the end and Change 
Orders need to have “.C#” at the end (see section 4 for addendum and change order sheet 
numbering requirements). 
 
To apply page labels and sheet numbers in Bluebeam follow the figures below: 

1. First page labels must be applied to each sheet in the addendum or change order.  This 
can only be done one sheet at a time.   

2. Go to the thumbnail pane as shown below, right click on a thumbnail and select Number 
Pages: 

 

Figure 9 - Adding Page Labels 
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3. Select None for a style, type in the sheet number of the addendum or change order 
sheet in the prefix line.  Then select which sheet you are labeling.  This has to be done 
for each sheet in the addendum or change order separately.  See below: 

 

 

Figure 10 - Applying Addendum Page Labels 

4. After all page labels have been applied, the sheet numbers can be applied.  From 
Bluebeam select the Document tab and then “Header & Footer” 

 

Figure 11 - Header Footer Tool 
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5. Select your sheet numbers saved settings from before and click OK.  Note the margins 
and size may have to be adjusted as necessary.   

 

Figure 12 - Applying Addendum or DCO Sheet Numbers 

1.7   CTDOT For Information Only Sheets 
 
Plans provided For Information Only (FIO) shall be submitted digitally, in individual subsets 
based on the entity providing the information, Amtrak, CL & P, AT&T, Designer etc.  These 
subsets do not require a digital signature, but each sheet in the subset shall be labeled; “For 
Information Only”.  The first sheet of each FIO subset shall be a subset cover sheet.  These 
sheets shall be placed on a border and numbered in accordance with section 1.6.2.   
 
The subset numbers shall be selected by the Project Manager so that the FIO subsets are last.  
See Section 3.2 for uploading and attributing FIO Plans. See Section 1.11 & 1.12 for more 
examples of discipline subsets. Information only sheets may be scanned, but must conform to 
the following specifications; Minimum Size 22”x34”, Minimum dpi = 300.   
 
This link shows a procedure that can be used to create a For Information Only subset using 
Bluebeam:  Preparing a For Information Only Subset 
 
 
 
 
 
 

http://www.ct.gov/dot/lib/dot/documents/aec/preparing_fio_sheets.pdf
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1.8 CTDOT Standard Sheets 
Standard sheets shall also be delivered digitally into Projectwise. The following shows how to 
obtain the latest version of the CTDOT Standard Sheets and how to prepare them for a digital 
project. 

1. Download the latest standards from the following link for the project:  CTDOT Standard 
Drawings Website 

2. Upload the standard subset into Projectwise in accordance with section 3.2.     
3. Next open up the standards from Projectwise by double clicking on it.  Once it opens 

click on the index sheet. 

 

Figure 13 - Preparing the Standard Subsets 

4. Then enter the project number and check the standards to be included in the project.   

 

Figure 14 - Enter Project Number and Check Boxes 

 
 
 
 

http://www.ct.gov/dot/cwp/view.asp?a=2303&q=410884
http://www.ct.gov/dot/cwp/view.asp?a=2303&q=410884
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5. Delete the standards that are not included in the project as shown below: 

 

Figure 15 - Deleting Drawings from Standard Set 

6. Next digitally sign all index sheets in accordance with section 2.6. 
7. Then upload the standards into the 100_Contract Plans folder in Projectwise in 

accordance with section 3.2 of this manual.  

1.9 Contract Plan Sheet Publishing  
CTDOT currently uses MicroStation V8i Print Organizer to publish contract plans to a PDF format.  
 
The workflow Publishing_MicroStation_Content_to _PDF_Format.pdf shows the fundamentals 
of publishing contract plans to PDF from MicroStation.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.ct.gov/dot/lib/dot/documents/aec/Publishing_Mircostation_Content_to_PDF.pdf
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1.10 Example: Typ. Single Volume Digital Contract 
Single volume digital contracts are used when each discipline or consulting firm designing the 
project is responsible for 3 subsets or less.  The following is an example of a single volume 
project.  Note:  The first and second subsets shall always be 01-General and 02-Revisions.  The 
03 subset does not always need to be 03-Highways, the 04 does not always need to be 04-
Structure, etc. The FIO subsets shall be placed at the end of a project right before the STD 
subsets.   

Label 

(Discipline Subset) 

File contents 

(but not limited to) 

01-General 
Title Sheet 

Detail Estimate Sheet 
 

02-Revisions 

Index of Revisions Sheets  

03-Highways** 

Index of Plans 

Survey Data 

Alignments 

ROW 

Typ Sections 

Misc Details 

Intersect Grading 

Boring Logs 

Highway Plans 

Breakout Drainage 

Highway Profile 

Highway X-

Sections 

Landscape Plan 

Wetland Mitigation 

04-Structure 

Index of Drawings 

All Structure Sheets  

Note: Multiple subsets may required for multiple 

Sites 

Ex: 04_Structure_Br.No.1266 

05-Traffic 

Index of Drawings 

Signing 

Pavement Markings 

MPT 

Traffic Signal Plans 

Etc. 

06-Environmental 
Index of Drawings 

All Environmental Compliance Sheets required 

07-”Utiltiy” Utility Design plans.  For example 07_AT & T, 
07_CL & P, 07_MDC, etc.   

08-CL&P FIO*** CL & P For Information Only plans 

09-AT&T FIO*** AT & T For Information Only plans 

 CTDOT Highway STD * CTDOT Highway Design Standard Index and 
Sheets required 

CTDOT Traffic STD * CTDOT Traffic Engineering Standard Index and 
Sheets required 

Figure 16 Typical Highway Project Discipline Subset Contents 

* For using CTDOT Standard Sheets see X1.8 X XCTDOT Standard Sheets 
** If a discipline has to be broken up into more than one subset See Section 1.11 for splitting up 
the discipline subsets.   
*** For Information only discipline subset shall be submitted as individual pdf files based on the 
entity providing the information only.   
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1.11 Example: Multiple Volume Digital Contract 
Multiple volumes are used if the project has 1 or more of the following characteristics: 

1. The majority of the discipline/firm designers are responsible for more than 3 subsets 
each. This allows the individual designers to number their subsets independently of the 
other disciplines. 

2. There are multiple sites on the project.  Splitting these sites up into volumes will provide 
better organization of the project.   

3. Combining multiple projects into one project.  
The larger the project is, typically the more subsets will be required and their labels will be more 
specific.     The Project Manager will need to organize the discipline volumes. The subsets shall 
be split up by volume and each volume shall be controlled by its assigned designer. For example, 
all the subsets designed by the highway designer shall be in the same volume (02) and each 
subset shall have a unique subset number.   

Label 

(Discipline Subset) 

File contents 

(but not limited to) 

Designer/ 

Firm 

01.01-General Title Sheet, Detail Estimate Sheet Lead 

01.02-Revisions Index of Revision Sheets Lead 

01.03-Wtlnd Re-establish Wetland Reestablishment plans Designer 1 

01.04-Stg Acc. Staging and Access Plans Designer 1 

02.01-Typ Sections Typical Sections Designer 2 

02.02-Alignments Alignment Geometry Designer 2 

02.03-Plan Plans Designer 2 

02.04-Profiles Profiles Designer 2 

02.05-ROW Brk Right of Way Breakout Designer 2 

02.06-Drain Drainage Plans Designer 2 

03.01-Retaining  Wall 1 Retaining wall details Designer 3 

03.02-Retaining Wall 2 Retaining wall details Designer 3 

03.03-Bridge 00456 Bridge_456 Designer 3 

03.04-Bridge 01983 Bridge_1983 Designer 3 

03.05-Bridge 01984 Bridge_1984 Designer 3 

04.01-Stage 1 Stage Construction Details 1 Designer 4 

04.02-Stage 2 Stage Construction Details 2 Designer 4 

04.03-Stage 3 Stage Construction Details 3 Designer 4 

05.01-SPM Signing and Pavement Marking Site 1 Designer 5 

05.02-SPM Signing and Pavement Marking Site 2 Designer 5 

05.03-SPM Signing and Pavement Marking Site 3 Designer 5 

06.01-IMS IMS Plans and Details Site1,2,3 Designer 6 

07.01-Env 1 Environmental Details Site 1 Designer 7 

07.02-Env 2 Environmental Details Site 2 Designer 7 

07.03-Env 3 Environmental Details Site 3 Designer 7 

08.01-”Utiltiy” Utility Design plans.  For example 07_AT & T, 07_CL 
& P, 07_MDC, etc.   

Designer 8 

09.01-CL&P FIO CL & P For Information Only plans Designer 8 

09.02-AT&T FIO AT & T For Information Only plans Designer 8 

CTDOT Highway STD * CTDOT Highway Design Standard Index and 
Sheets required 

Designer 1 

CTDOT Traffic STD * CTDOT Traffic Engineering Standard Index and 
Sheets required 

Designer 5 

Figure 17 – Multiple Design Firms CTDOT Project Subsets 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued 04-2016 25 Version 3.13 
     

1.11.1 Combining Multiple Projects 
When 2 or more projects are combined into one project, the following shall be done: 

 Each project shall be given its own volume. 

 The lowest project shall always be volume 1.   

 Each project shall have its own title sheet, which reference each other with a note.   

 There shall only be (1) Revisions subset.  This subset shall be in volume 1 and named 
01.02 – Revisions. 

 The Revisions subset shall be the responsibility of the project manager on the projects.   

 Each project shall have its own detailed estimate sheets.   

 There shall only be (1) set of Highway Standards and (1) set of Traffic Standards when 
the projects are combined.   

 There shall not be any duplicate special provisions after the projects are combined.   

1.12 Consolidating Contract Plan Discipline Subsets  
The consolidation of the contract plan discipline subsets is accomplished using the Set feature in 
Bluebeam version 11 or newer.  This feature creates a single viewer file called a “Set File” that 
allows users to take multiple digitally signed files, sort them by their sheet numbers, and view 
them in order without actually combining the files.   
 
The project manager shall create a Set file for the project at FDP that contains all the discipline 
subsets, DO NOT include the highway and traffic standard subsets.  When an Addendum or 
Change Order is required for the project, the set file shall be updated by the project manager to 
include the Addendum or Change Order subsets. 
 
The following shows when and how a set file will be created and updated throughout the life of 
a project.  
 
See Appendix C for general use of a set file. 

1.12.1 When a Set File is Created and Updated 
Set File Creation  

1. The lead designer shall create a set file of all the discipline subsets at FDP, see section 

1.12.2 

Set File Updates 
2. If any FDP subsets need to be revised during the DCD process, the set file shall be 

updated to remove the FDP subsets that were changed and add the DCD subsets.   

3. If any Addendum subsets are required for the project, these Addendum subsets shall be 

added to the set file.   

4. If any Design Imitated Change Order subsets are required for the project, these Design 

Imitated Change Order subsets shall be added to the set file.  

See section 1.12.3 for updating the set file. 
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1.12.2 Creating a Set File 
After all the discipline subsets have been submitted into Projectwise for FDP the lead designer 
shall create the project’s set file in accordance with the following:   

1. Launch Bluebeam from the desktop icon on your computer.  

2. Next Click on the Set Icon and select New Set as shown below: 

 

Figure 18 - Creating a Set File 
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3. Then click Add and then Projectwise and OK as shown below: 

 

Figure 19 - Adding Files to the Set File 

4. Next browse out to your project’s 100 Contract Plans folder and select all plans except 

the standard subsets.  Then click Open:  After you click Open it may take a minute for 

Bluebeam to load all the files into the set, please be patient.   

 

Figure 20 - Adding Files to the Set File 
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5. Next Click on Relative Paths and make sure the options are selected as shown below: 

 

Figure 21 - Set File Options 

6. Next click on Advanced and select and unselect the options as shown below: 

 

Figure 22 - Configuring the Set File 
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7. Next click Save, this may take a while depending on how big the project is, please be 

patient.  When the box pops up choose Projectwise and click OK: 

 

Figure 23 - Saving the Set File 
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8. Select the Advanced Wizard, and then on the Select target folder browse out to your 

project’s 100_Contract_Plans folder.  Then click next until you get to the attributes 

page.  Attribute the Set File as shown below: 

 

Figure 24 - Attributing the Set File 

 
9. Click OK after the set file has been saved into Projectwise: 

 

Figure 25 - Creating a Set File 
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10. Now the set file has been created for use of the Set File see Appendix C: 

 

Figure 26 - Set File 
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1.12.3 Updating a Set File 
The following will show how to update a set file. 

1.12.3.1 Adding a File to the Set File 
1. Double click on the set file from Projectwise and open as shown below:  This may take a 

while depending on how big the project is, please be patient. 

 

Figure 27 - Opening a Set File 
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2. Next click on the Set icon and click Add as shown below: 

 

Figure 28 - Modifying a Set File 

3. Next browse out to your project and select the files to add to the set and click Open.  

This may take a minute to add the additional file to the set so please be patient.  After it 

finishes click OK.   

 

Figure 29 - Adding Files to the Set File 
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4. Now the file will be added to the set, scroll down and you will see it.  

 

Figure 30 - Set File 
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1.12.3.2 Deleting a File from the Set 
1. Double click on the set file from Projectwise and open as shown below:  This may take a 

while depending on how big the project is, please be patient. 

 

Figure 31 - Opening a Set File 
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2. Next click on the Set Icon.  Then select the file to remove from the set and click delete: 

 

Figure 32 - Deleting a File from the Set File 
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 Digital Signatures for Contract Section 2

and Other Engineering Documents 

The follow contract documents must be digitally signed when submitted to the Department in 
accordance with the following section: 

 Contract Plans – FDP, Addendum, Change Orders 

 Engineering Reports 
o Hydraulic Report 
o Scour Report 
o Floodway Report 
o Final Drainage Reports 
o Bridge Inspection Reports 
o Task 110 
o Task 220 
o Underground Storage Tank System Closure Reports 

 Working Drawings for Permanent and Temporary Structures – Plans and Calculations 
 
This manual refers to digital signatures in two ways: certifying signatures, and signing signatures. 
The Engineer of Record or document signer will always digitally sign using a visible certifying 
signature.  If multiple signatures are required per document, the second signer or sub-engineers 
shall always digitally sign using a visible signing signature after the primary signer or engineer 
has applied his certifying signature.  Certifying signatures allow controlled changes, to the now 
certified document.  These controlled changes include; allowing PDF digital comments, and the 
application of additional signatures.  Signing signatures should always be accompanied by a note 
listing the sheets the signer is responsible for within a subset.   
 
In order to digitally secure a PDF document the signer(s) applies a digital signature(s) to only the 
first sheet of the document, regardless of the number of pages the document contains. This 
digital signature secures the entire document.  
 
A graphic image of the signer’s signature must be created, and shall be used for the following 
purposes:    

 It shall be attached to the digital signature and displayed when the digital signature is 
applied.  

 It shall be placed as a watermark on all contract plan sheets a particular engineer of 
record is responsible for (digitally signing for).   

 It shall be placed on the first sheet by the preparer and checker of an engineering 
report. 

 The watermark shall be placed on all contract plan sheets and all plan sheets contained 
in a working drawing submittal. 

 
A digital ID must be purchased in order to apply a digital signature.  Digital ID’s must meet the 
specifications of Adobe’s Certified Document Services (CDS) or Adobe Approved Trusted List 
(AATL).  The necessary hardware and software needed to apply the required digital signatures 
may be purchased from the vendor list provided at the following 
website: HUhttp://www.adobe.com/security/partners_cds.html UH, additional information on Adobe’s 
CDS is also available at this website and https://helpx.adobe.com/acrobat/kb/approved-trust-
list2.html for information on AATL.  
 
Before digitally signing any document Bluebeam must be set up as detailed in Appendix A.  
 

http://www.adobe.com/security/partners_cds.html
https://helpx.adobe.com/acrobat/kb/approved-trust-list2.html
https://helpx.adobe.com/acrobat/kb/approved-trust-list2.html
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2.1 Graphic Image of Signature 

2.1.1 Contract Plans 
The following figures display an example of both a state designer and a consultant designer’s 
digital signatures, and their accompanying graphic image(s) of their signature(s). See section 2.2. 
for instructions on how to create a graphic image.    
 
The consultant engineer’s graphic image must contain his companies name and address; his 
signature, his Professional Engineers stamp, or his Professional Architecture Stamp. The state 
employee’s graphic image must contain only his signature. See Below. 
 

      

Figure 33 - Graphic Image of Signature 

In addition to a digital signature being placed on the first sheet of any contract plan, working 
drawing plans, and working drawing calculations, CTDOT also requires that all subsequent pages 
be watermarked with a copy of the engineer of records graphic signature before they are 
digitally signed. Watermarks containing these signatures are applied using Bluebeam and are 
always placed in the border of contract plans and working drawings for permanent structures. 
This is to prove validation of a digital document if printed. 
 

         
 

        

Figure 34 – Watermarks 

 

 

1st page of Subset 

Watermark of State Design Graphic 
Signature 

Watermark of Consultant Designers  
Graphic Signature 
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2.1.2 Engineering Reports 
Hydraulic, Scour, Floodway, and Final Drainage Reports 
The following shows the watermarks that need to be placed on the first sheet of a Hydraulic, 
Scour, Floodway, or Final Drainage Report by the Preparer and the Checker and the digital 
signature of the Approved Hydraulic Engineer.  The digital signature must include the graphic 
image of the signer’s PE stamp and signature as shown below, section 2.2. for instructions on 
how to create a graphic image.  These reports shall be digitally signed in accordance with section 
2.6.7   
 

 

Figure 35 - Engineering Reports 
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Bridge Inspection Reports 
The following shows how Bridge Inspection reports are to be digitally signed in the bottom right 
hand corner of the report. The digital signature must include the graphic image of the signer’s 
PE stamp and signature as shown below, section 2.2. for instructions on how to create a graphic 
image.  These reports shall be digitally signed in accordance with section 2.6.7   

 

Figure 36 - Bridge Inspection Reports 
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Environmental Compliance Reports 
The digital signature for the Task 110, Task 220, and Underground Storage Tank System Closure 
Reports must include a graphic image of the Professional engineer’s signature or a graphic 
image of the signer’s signature where applicable, see section 2.2. for instructions on how to 
create a graphic image. These reports shall be digitally signed in accordance with section 2.6.7   

2.1.3 Working Drawings 
Working Drawings for Permanent and Temporary Structures 
The following shows the digital signature and Professional Engineering watermark requirements 
for the engineer who prepares the working drawing submittal.   These types of submittals shall 
be digitally signed in accordance with section 2.6.6   Note:   Working Drawing for Temporary 
Structures only require that the first sheet in the submittal be digitally signed, watermarks are 
not necessary.  See section 2.2. for instructions on how to create a graphic image. 
 
Working Drawing Plans 
The first plan sheet in the submittal shall have a digital signature and a watermark placed on it 
as shown below. All others sheets will only have the watermark.  A place in the border of the 
plan sheets shall have a spot for this watermark.  
 

 

Figure 37 - Working Drawing for Permanent Structures 
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Working Drawing Calculations 
The first sheet of the calculations shall have a digital signature as shown below: 

 

Figure 38 - Working Drawing for Permanent Structures 

2.1.4 Other Documents 
Documents that do not require to be signed by a Professional Engineer shall have a graphic 
image of the signer’s signature attached to their digital signature. See section 2.2. for 
instructions on how to create a graphic image. 
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2.2 Creating Graphic Image of Signature: 

2.2.1 In House CTDOT or Non-Professional 

Engineering Signature: 
The graphic signature will be used by CTDOT employees and signers that are not signing as a 
Professional Engineer.   
 
CTDOT graphic signatures shall be created as follows: 
 

1. Signer must sign a blank piece of paper. 
2. Scan this signature. 
3. Crop the image so that the image is approximately 300 pixels wide by 100 pixels high.  
4. Save the images, in PDF to an area on your PC. 

 

Figure 39 (Example of CTDOT Graphic Image of Signature – Used with Digital Signature and as a Watermark) 

2.2.2 For Consultant Staff PE Stamp: 
Consultant Engineers shall create two different graphic signature images: one that shall 
accompany their digital signatures and a different one that shall be placed as a watermark on all 
the plan sheets the engineer is signing for.  
 
This section shows an example of a Professional Engineer preparing their graphic image of their 
signature; Architect’s shall follow this section when they are preparing their digital signature.   
Graphic Appearance Attached to Digital Signature 
The graphic signature that accompanies the digital signature only needs to include the 
designer’s signature and P.E. Stamp. , and shall be created as follows:   
 

1. Stamp and Sign a blank piece of paper. 
2. Scan this signature. 
3. Crop the image to approximately 250 pixels wide by 250 pixels high. 
4. Save the image, in PDF to an area on your PC or server, where you can easily access it 

for later use in the signature set-up procedure.  

 

Figure 40 ((Example of Consultant Engineer Graphic image of Signature – Applied to 1
st

 page only with digital signature) 

 
 
 
 
Graphic Appearance used as a Watermark  
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In addition to the designer’s signature and P.E. Stamp, the graphic signature that is placed as a 
watermark shall also include the designer’s company name and address, and shall be created as 
follows:   
 

1. On blank paper – Print company name and address. 
2. Place P.E. stamp next to company name and address. 
3. Sign P.E. Stamp.  
4. Scan the image created in steps 1 thru 3 above.   
5. Crop the image to approximately 500 pixels wide by 250 pixels high. 
6. Save the image, in PDF to an area on your PC or server, where you can easily access it 

for later use in the watermarking procedure.   
 

 

Figure 41 (Example of Consultant Engineer Graphic image of Signature – applied to all pages as a watermark) 

Once the graphic images have been properly created and saved, the digital signature 
appearance preferences must be set as follows: 

2.3 Setting Digital Signature Appearance Preferences: 
 
Once the graphic signatures are created the digital signature appearance settings must be 
defined as follows: 
Bluebeam Digital Appearance 

1. Make sure your digital signature USB token is inserted into the computer then in 
Bluebeam go to the Document tab and select Signatures>Digital ID’s: 

 

Figure 42 - Digital Appearance 

2.  Next click on your ID and click Manage Appearances: 
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Figure 43 - Manage Appearances 

3. Next follow the figure below: 

 

Figure 44 - Setting the Digital Appearance 

4. Now the digital appearance will be saved and can be used to digitally sign. 
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2.4 Watermarking Plans with Graphic Image of 
Signature 

The Engineer of Record (Principal Engineers for State Design), for each discipline, shall place a 
copy of their graphic signature as a watermark on each sheet of each discipline subset, or 
working drawing submittal(Plans and Calculations) that they are responsible for.  For 
Engineering Reports the preparer and checker of the report shall place a copy of their graphic 
signature as a watermark only on the cover of the report.   
 
Bluebeam - Watermarking Plans with Graphic Image of Signature (CTDOT and Consultant 
Designed) 
There are two ways to apply watermarks using Bluebeam, see below for options 1 and 2.  The 
following shows an example of a CTDOT signature, but the procedure is the same for a 
consultant when they are placing their PE stamp in the border or on the first sheet of an 
engineering report. 
 
Watermarking Workflow: 
Option 1 

1. The watermark in Bluebeam is placed using the stamp function.  First go to the Markup 
tab and select Stamp and then choose your stamp.  If your Principal’s or PE stamp is not 
in the list follow Appendix A.  If your stamp is in the list go to step 2. 

 
2. Next place the stamp in the border on the first sheet.   

 

Figure 45 - Placing Watermark 
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3. Next right click on the stamp and select “Apply to all pages”.  If you are watermarking an 
engineering report you do not need to apply to all pages.   

 

Figure 46 - Placing Watermark on All Pages 

If more than one group has to watermark this subset, browse to the pages the other group is 
responsible for and delete the watermark.  Then they can come in a place their watermark on 
these sheets.   
Flatten Markups 

4. After the watermarks have been placed, the watermarks must be “flattened” to the PDF 
document.  Go to Document>Flatten Markups.  Use the default settings and click OK.   

Option 2 
1. Go to the Document tab and Pages>Apply Stamp. 

 

Figure 47 - Applying Stamps 
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2. Select stamp, input scale and coordinates as necessary, and page range as shown below. 

 

Figure 48 - Applying Stamps 

Flatten Markups 
3. After the watermarks have been placed on the subset, the watermarks must be 

“flattened” to the PDF document.  Go to Document>Flatten Markups.  Use the default 
settings and click OK.   

 
 

2.5 Digital Signature Fields  
Contract Plans 
Digital signature fields are form fields created using Bluebeam, and are used to house the digital 
signatures. Digital Signature form fields shall be placed within the form field place holders. The 
form field place holders are cells that are placed in the MicroStation file on the title sheet and 
the subset cover sheets and on any Addendum or Change Order Subset.  The figure below 
shows a CTDOT designed project with the form field place holders (circled) on the title sheet and 
the discipline subset cover sheet.    
 

 

Figure 49 - Digital Signature Fields 
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The figure below shows a consultant designed project’s title sheet and discipline subset cover 
sheet with their form field place holders.     

 

Figure 50 - Consultant Watermarks 

Place holders determine the location and size of the digital signature form field.  
 
Form field place holding cell library: CT_Digital_Sigs.zip  
 
The digital signature place holder and form fields shall be created on the first page of each 
discipline subset for each required digital signature. 
 
Note:  All signature form fields need to be created for both certifying and signing signatures 
before any digital signatures is applied to the document. 
 
Contractor Submittals 
Contractor submittals will not be required to have a digital signature place holder.   
 
Engineering Reports 
Engineering reports will not be required to have a digital signature place holder.   

2.5.1 Bluebeam - Creating Digital Signature Form 
Fields 

The following example shows how to place the (3) digital signature form fields on the 01-
General title sheet of a CTDOT designed project.  For a discipline subset or a consultant designed 
01-General title sheet, only one digital signature form field needs to be placed.    
 

1. Go to the Document tab and select Signatures>Add Signature Field. 

 

Figure 51 - Adding Signature Fields 

 

 

http://www.ct.gov/dot/lib/dot/documents/aec/ct_digital_sigs.zip
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2. Next place three signature fields in the appropriate location and hit save as shown 
below: 

 

Figure 52 - Placing Signature Fields 

2.6 Applying Digital Signatures 
This section describes how to apply digital signatures for contract plans, engineering reports, 
working drawing plans, and working drawing calculations.   
 
Contract Plans 
Contract plan discipline subsets 01-General and 02-Revisions and the Highway and Traffic 
Standard drawing subsets have unique requirements as described in the following sections.   
 
CTDOT projects shall have their discipline subsets digitally signed after they have been uploaded 
into projectwise because the Principal Engineer will be looking in projectwise to digitally sign 
documents.   
 
Discipline subsets designed by a single engineer shall be digitally signed, by the engineer of 
record, using a single visible certifying signature, applied to the signature form field located on 
the first page of each subset. 
 
Discipline subsets designed by multiple engineers shall first be digitally signed by the Engineer of 
Record who is responsible for the most sheets in the subsets.  This engineer will apply a visible 
certifying signature in the top most form field. The next Engineer of Record shall apply their 
signing signatures in the subsequent form fields. This Engineer shall also include a reason, when 
applying their digital signatures, listing the pages they are responsible for.  
 
Digital signatures must be applied to digital form fields, previously created. See Section 2.5  
 
Engineering Reports 
Engineering Reports shall be digitally signed, by the Engineer of Record using a certifying.  See 
section 2.7. for instructions on how to apply a certifying signature to an engineering report. 
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2.6.1 Applying Digital Signatures to 01_General 
Subset (FDP and Addendum Subsets) 

 
CTDOT DESIGNED PROJECTS: 
The following procedure applies to both the 01_General subset at FDP and any 01_General_A# 
subset.   
 
The project title sheet of the 01_General subset shall first be digitally signed by the lead 
discipline’s Principal Engineer, using a certifying signature.  The Principal Engineer should make 
sure that all three digital signature form fields (blue boxes in the signature block) are placed 
before signing, as these forms cannot be added after the document is digitally certified.  After 
processing has approved the 01_general subset for Advertising, the Manager, and the 
Transportation Engineering Administrator shall digitally sign the same sheet directly below the 
principal’s signature, using a signing signature while the plans are in the Manager and Engineer 
Admin. Sign state.   
 
Processing shall notify the lead designer when the 01-General subset is placed in the Manager 
and Engineer Admin. Sign state.  The lead designer shall then coordinate the digital signing by 
the Manager and Engineering Administrator of the 01_General subset.  When both signatures 
are applied to the plans, the lead designer shall then notify processing that the 01-General 
subset has been signed.     
 
 
See Section 2.7 Applying Digital Signature Workflows 
Note: When digitally signing the 01_General subset all signers shall leave the reason code 
blank. 
The following image shows a typical project title sheet from the 01_General subset that is 
digitally signed: 
 

 
 

Figure 53 - Title Sheet Digital Signatures 
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Figure 54  Example: CTDOT 01_General.pdf, Project Title Sheet Digital Signatures 

CONSULTANT DESIGNED PROJECTS: 
The project title sheet of the 01_General subset shall be digitally signed by the lead consultant, 
using a certifying signature.  
 
See Section 2.7 Applying Digital Signature Workflows 
 
When more than one consultant works on a CTDOT digital project the project manager (prime 
consultant) shall apply a visible certifying signature to the first page of the 01_General subset.  
By applying this signature the prime consultant is accepting responsibility for the entire set of 
digital contract plans.  However the individual subsets shall be signed by the corresponding 
firms.    
Note: When applying certifying or signing signatures leave the reason code blank.  
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2.6.2 Applying a Digital Signatures to 02_Revisions 
Subset  

 
This section applies to both CTDOT designed projects and Consultant designed projects.  The 
figures contained in this section show a CTDOT signature, but the workflows are the same.   
 
This subset does not need to be signed at FDP.  This subset must be signed when the sheet 
is filled out for an Addendum or design initiated change order, whichever comes first.   
 
The first index of revision sheet(s) located in the 02_Revisions subset shall be digitally signed 
by the lead designer, using a certifying signature.   
 
1. The lead designer shall apply a certifying signature as described in section 2.7 Applying 

Digital Signature Workflows with the following EXCEPTION; the option “No Changes 
Allowed” must be selected to eliminate unauthorized changes after certifying the 
document. See the figure below: 

 

 

Figure 55 Certifying Dialog Box for 02_Revisions.pdf 
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2.6.3 All Other Discipline Subsets - Single 
Signature  

 
This section applies to both CTDOT designed projects and Consultant designed projects.  The 
figures contained in this section show a consultant signature, but the workflow is the same.   
 
Each discipline subset shall be digitally signed with a visible certifying signature, by ONLY the 
responsible design engineer. As shown below. 
 
See section 2.7 Applying Digital Signature Workflows 

 
 

 

Figure 56 CTDOT Certified Plan Subset 

2.6.4 Standard Drawing Subsets – Single Signature  
This section applies to both CTDOT designed projects and Consultant designed projects.  The 
figures contained in this section show a consultant signature, but the workflow is the same.   
 
Only the standard drawing subset index sheets, Highways and Traffic Standard Drawings, need 
to be digitally signed with a visible certifying signature, by the responsible design engineer that 
submits the subset to Projectwise.  For example, in the case where the Traffic unit is submitting 
a Highway standards subset, the Traffic Principal Engineer is responsible for digitally signing the 
index sheets, not the Highway Principal Engineer.   
See section 2.7 Applying Digital Signature Workflows 
 

2.6.5 All Other Discipline Subsets – Multi-
Signatures  

 
This section applies to both CTDOT designed projects and Consultant designed projects.  The 
figures contained in this section show a consultant signature, but the workflow is the same for 
CTDOT designed projects.    
 
Multiple signatures per a single subset are required where two or more disciplines/firms are 
responsible for one subset. 
 
The lead designer that is responsible for most of the pages within a discipline subset shall 
digitally sign the subset using a certifying signature, and leave the reason code blank.  See 
Section 2.7 Applying Digital Signature Workflows 
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Once certified by the subset lead, the remaining designers(s) shall digitally sign the same subset 
using a signing signature, and complete the reason code with a note stating which pages, 
contained in this subset, that they are responsible for.  See table 2-1 below: 
See Section 2.7 Applying Digital Signature Workflows 
Table 2-1 Reason Codes for Prime and Sub Consultants 

Designer Certify or 
Sign 

Responsible 
Sheet 

Numbers 

Reason Code 

Lead Designer Certify   

Sub-Designer 1 Sign 03.78 Thru 
03.88 

I am Signing for Sheet Nos. 03.78 thru 
03.88 

Sub-Designer 2 – 
etc. 

Sign 03.88 Thru 
03.98 

I am Signing for Sheet Nos. 03.88 thru 
03.98 

2.6.6 Working Drawings 
Working drawing submittals shall be digitally certified in accordance with section 2.7 Visible 
Digital Signature using a Certifying signature, of this manual.   

2.6.7 Engineering Reports 
Engineering Reports shall be digitally signed, by the applicable person using a certifying.  See 
section 2.7 for instructions on how to apply a certifying signature to an engineering report.  If a 
report needs to be digitally signed by more than one person, the first person must apply a 
certifying signature as shown in section 2.7 and any subsequent signature will be a signing 
signature as shown in section 2.7. 
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2.7 Applying Digital Signature Workflows  
 
This section applies to both CTDOT designed projects and Consultant designed projects.  The 
figures contained in this section show a CTDOT signature where the document is located in 
Projectwise, but the workflows are the same.      
 

Certifying Signature: 
1. Left click on the signature field and then update the settings as shown below.  Examples 

below are for a CTDOT designed project’s title sheet and the first sheet of an 
Engineering Report: 
 

Discipline Subsets 

 

Figure 57 - Certifying Discipline Subsets 

Engineering Reports  or Documents that Require (1) Digital Signature 

 

Figure 58 - Certifying Engineering Reports 
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2. Next for document in located in Projectwise click Projectwise V8i as shown below and 
then click OK.  If the document is located on your computer click My Computer list 
below: 

 

Figure 59 - Certifying Signature 

 
3. Then select yes to overwrite existing file as shown below for projectwise or if the 

document is located on your computer overwrite the existing file or save to a new 
location: 

 

Figure 60 - Certifying Signature 

 
4. If using Projectwise check the document back into Projectwise.   
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Digital Signing Signature: 
Once the prime engineer applies his certifying signature the additional signing signatures can be 
applied by the sub-consultants as follows:  
 

1. Left click on the signature field and then update the settings as shown below: 
 

 

Figure 61 - Signing Signaure Bluebeam 

 
2. Next for document in located in Projectwise click Projectwise V8i as shown below and 

then click OK.  If the document is located on your computer click My Computer list 
below: 

 

Figure 62 - Open from Projectwise 
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3. Then select yes to overwrite existing file as shown below for projectwise or if the 
document is located on your computer overwrite the existing file or save to a new 
location: 

 

Figure 63 - Overwriting a File 

4. If using Projectwise check the document back into Projectwise.   
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 Projectwise and Submitting Section 3

Documents to CTDOT 

This section details Projectwise and the procedures for submitting and checking documents that 
are submitted to CTDOT.   

3.1 Discipline Subset PDF Checker 
The Discipline Subset PDF Checker software was developed to check that Contract Plan 
Discipline Subsets are formatted and delivered to CTDOT correctly.  This checker replaces the 
old requirements of attaching the discipline subset checklist to each subset and stamping each 
subset with the green QA/QC stamp.  These two things are no longer required.  
 
This checker is an add-on to Projectwise Thick Client and can only be run using Projectwise Thick 
Client.  See section 3.1.2 for the typical workflows for using the PDF Checker.  This section 
provides details for Projectwise Thin Client users.   
 
The following details what is checked with this software: 

(1) CAD Requirements have been completed correctly: 
a. Page Size (see section 1.4.1) 
b. Searchable Text (see section 1.4.1) 
c. Levels (see section 1.4.1) 

(2) PDF post processing steps have been completed correctly: 
a. Page labels (see Section 1.6.2) 
b. Sheet numbers (see Section 1.6.2) 
c. Watermarks and flatten comments(see Section 2.4)  
d. Any digital signature fields (see Section 2.5) 
e. Digital Signature (see Section 2.6)       

(3) The subset was uploaded and attributed correctly in Projectwise. 
 
After the PDF checker is run, an Excel report is created detailing what is incorrect on each 
subset.  Things that are incorrect will show up red and include a note on what is incorrect.  Also 
an attribute in Projectwise call Format Compliance will be set to PASS or FAIL when a document 
is run through the checker: 

 

Figure 64 - Format Compliance Attribute 

 
The PDF checker must be ran on all discipline subsets that are submitted to CTDOT, which 
includes the following submittal types:  FDP, DCD, DCD2, ADP, ACD, or DCO submittals.   
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3.1.1 Installing the PDF Checker 

This is step is for consultants only, DOT staff already have the checker installed.  
1. Download the PDF checker executable from this link:  Discipline Subset PDF Checker 
2. Close Projectwise if it is open. 
3. Run the executable. 

3.1.2 Typical Workflow for using the PDF Checker 
CTDOT Designed Projects  
The following details the typical workflow for a CTDOT designed project. 

1. Each discipline prepares their subset(s) and uploads their unsigned subsets into 
Projectwise in accordance with this manual. 

2. Then the PDF Checker is run on the unsigned subset(s).   By running the checker on the 
unsigned subsets, any errors can be found before the Principal digitally signs.  Note:  An 
error will be returned that a signature was not found and the Projectwise attribute will 
show FAIL.  

3. If there are any other errors, other than the signature error, they shall be fixed.  If the 
only error in the report is the signature error, then the plans can be digitally signed by 
the principal.   

4. After the plans are digitally signed, run the PDF Checker again on the subset(s) to check 
the digital signature was applied correctly.  If there are no errors then the check is 
complete.  If there are any errors they shall be fixed and the PDF Checker rerun.     

5. The project lead should check in Projectwise that all subsets have PASS in the Format 
Compliance attribute column. 

6. The Processing unit will be looking for the Format Compliance attribute column to be 
set to PASS before they process the subset.  

 
Consultant Designed Projects 
The following details the typical workflow for a Consultant designed project: 

1. Each consultant prepares their subset(s) and uploads their subsets into Projectwise in 
accordance with this manual. 

2. Then the PDF Checker is run on the subset(s).  If the consultant or sub-consultant does 
not have Projectwise Thick Client, contact your CTDOT Consultant Liaison or the lead 
consultant on the project to run the PDF Checker on those discipline subsets.   Any error 
shall be fixed and the checker rerun until the report does not have any red errors. 

3. The CTDOT Consultant Liaison or the lead consultant should check in Projectwise that all 
subsets have PASS in the Format Compliance attribute column.    

4. The Processing unit will be looking for the Format Compliance attribute column to be 
set to PASS before they process the subset.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.ct.gov/dot/lib/dot/documents/aec/discipline_subset_pdf_checker.zip
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3.1.3 Using the PDF Checker 
This software has the capability to check one subset at a time or multiple subsets.   The 
following shows how to check multiple discipline subsets, but the procedure is the same for 
checking one subset.  

1. Log into Projectwise. 
2. Browse out to your project and open the 100_Contract_Plans folder. 
3. Select a discipline subset(s) or all the subsets, right click and select DMSconform>PDF 

Check.  Hold control or shift to select multiple subsets.  

 

Figure 65 - Selecting the Subsets and Running the Checker 

4. Click OK on the dialog box shown below: 

 

Figure 66 - PDF Checker 
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5. After the PDF Checker runs click Yes Report on the dialog box shown below.  Note:  The 
PDF Checker may take a few minutes to process depending on the size of the files it is 
checking.  

 

Figure 67 - PDF Checker Report 

 
6. In the report, errors will show up in red and if you hover over a red piece of text it will 

show the details of what is incorrect.  If any false errors show up in the report, please 
notify DOT.AECApplications@ct.gov with the project and document(s) you are having 
issues with.  Example of false errors could be the page labels were applied to the subset 
but the report details they were not.   

   

 

Figure 68 - PDF Checker Report 

The Format Compliance attribute will also be set when the checker is run.  It will return a PASS 
or FAIL value as shown below: 

 

Figure 69 - Format Compliance Attribute 

7. If there are no errors in the report and all document have PASS in the Format 
Compliance attribute, this process is complete.  If there are errors, the errors shall be 
fixed and the checker rerun.   

mailto:DOT.AECApplications@ct.gov
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3.2 Projectwise 
CTDOT is currently using Bentley’s ProjectWise as a data management software for digital 
projects. Projectwise allows the CTDOT, and authorized business partners to access its data 
anywhere internet access is available. Projectwise shall be used by all consultant engineers 
delivering digital contract documents.   The following link is an introduction to CTDOT’s 
Projectwise Site:  Projectwise Presentation - April 2015  

3.2.1 ProjectWise  
Consultant engineers may use either Projectwise thin client or Projectwise Explorer Client (thick 
client).  
 
Thin client is a web based version of Projectwise, which does not require any software 
installations. All that is required to login to the appropriate webpage is a user name and 
password supplied by CTDOT. Thin client allows access to the CTDOT dataset anywhere internet 
access is available.  To use Thin Client a few internet settings must be set the first time a user 
logs in, see this document for setting up Thin Client for the first time: Thin Client First Time Set 
Up   
 
The thick client conversely requires the installation of the Projectwise client software. In 
addition to performing all the functions of thin client; thick client has the addition functionality: 
 

- Delta file transfer – Improves speed of downloads 
- Managed workspaces – Eliminates the need to install the CTDOT DDE 
- Attributing multiple documents at once 

 
Users can get Projectwise thick client for free if they have an active license of Microstation.  
Download Projectwise Explorer Client from Bentley using your select ID.  Once Projectwise is 
installed on your computer use this document to connect to the datasource:  
 

Connecting to Datasource Using Thick Client 
 
Users can get to our Projectwise Datasource using the following various applications.  The table 
below lists the server URL for each application:   
 

Applications  URL 

Projectwise  ctdot-ws.projectwiseonline.com/pwmobileaccess 
 

WorkSite https://Ctdot-ws.projectwiseonline.com/ws 
 

 
The following workflow shows how to log in and change your password: Projectwise Log in 
 
If you do not have a Projectwise User name and password fill out the following form:  
ProjectWise New User Form   
 
Consultant firms are usually given (2) user names that can be used by the whole firm.  More 
than one person can use the user name at a time.  It is the firm’s responsibility to manage the 
user name and password in cases where employees leave and work at another firm.  This way 
the employee that leaves cannot use their old company’s user name and password.     
 

http://www.ct.gov/dot/lib/dot/documents/aec/PW_Class_Presentation_AEC_Misc_.pptx
http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_thin_client_first_time_set_up.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/projectwise_thin_client_first_time_set_up.pdf
https://www.bentley.com/
http://www.ct.gov/dot/lib/dot/documents/aec/Connecting_to_Datasource_using_Thick_Client.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/ProjectWise_Online.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/ProjectWise_New_User_Form.pdf
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3.2.2 Projectwise Folders for Contract Documents 
This section gives directions on which folder contract documents will be submitted in 
Projectwise.   
 
If two or more projects are being combined into (1) project, all contract documents for these 
projects will be submitted into the lowest numbered project in Projectwise.   
 
100_Contract Plans (PDF) – This folder contains only final Contract Plan Discipline Subsets.  This 
includes all Final plans, Addendum plans, Design Initiated Change Order, As-Builts, and FIO 
Plans.  There shall not be any working documents uploaded into these folders.  
 
110_Contract Documents (PDF) – This folder contains final signed Contract and other related 
documents such as: SOM (Source of Materials), Insurance documents, DBE, Bonds, etc.  This 
folder also contains any revisions to the contract such as Change Order specifications.    
  
120_Contractor Submittals (PDF) – This folder contains all working and shop drawings 
submittals.  There shall not be any working documents uploaded into these folders.    
 
130_Engineering Reports  – This folder contains all the final engineering reports that are to be 
made available for the Contractor.  There shall not be any working documents uploaded into 
these folders.   

 Hydraulic  
o Hydraulic Report and Hydraulic Report Data 
o Scour Report and Scour Report Data 
o Floodway Report and Floodway Report Data 
o Final Drainage Reports and Final Drainage Report Data 

 Environmental Compliance  
o Task 110 
o Task 220 
o Underground Storage Tank System Closure Reports 
o Executed Agreements 

 Sidewalk Maintenance Agreement 
 Lighting Agreement 

o Proprietary Item Approval 
o Standalone Transportation Management Plan Document, taken from the final 

design report 

 Bridge 
o Rehabilitation Study Report 
o Load Rating 

 
140_Administration – This folder is for final correspondence such as agreements, letters, 
memos, etc. and the design phase schedule.   
 

 Design Phase Microsoft Project Schedule 

 Sidewalk Maintenance Agreement 

 Lighting Agreement 
 

150_GIS – This folder contains the project polygon and parcel polygon files and their associated 
kml files.   
 
210_Construction Folders 

 Construction Survey – This folder is still in development. 
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 Office_Of_Construction – This folder is still in development. 
 
220_FHWA – This folder is used for FHWA documents. 
 
230_Contract Administration – This folder is used by CTDOT Contracts. 
 
240_Contract Development – Designer shall submit the following supplemental contract 
documents into this folder: 

 All contract specifications and Notice to Contractors (NTC), in word format, both final 
and addendum specifications 

 Proposal Estimate  

 Federal Estimate  

 Calendar Day Estimate 

 Final Design Report 

 Categorical Exclusion 

 Design Approval Letter 

 Environmental Permits 

 DBE/SBE Approval with percentage 

 Commitment list 

 Agreements 

 Proprietary Item Approval 

 Standalone Transportation Management Plan Document, taken from the final design 
report 

310_Review_Documents – The designer shall submit all non-final design documents into this 
folder.  This includes plans, specifications, reports, estimates, Property Maps (pdf), etc.   
 
320_Permit_Development – This folder is still in development. 
 
330_Design_Data – Under this folder is a sub-folder for each discipline that is used for all their 
design documents.   
 
500_Pre_Design Folders 

 01_Planning – This folder is still in development. 

 02_Concepts – This folder is still in development. 

 03_Central_Surveys – This folder is still in development. 

 04_District_Surveys – This folder is still in development. 

 05_Property_Maps - CTDOT or Consultant Surveyors shall upload the following files into 
this folder: 

o Polygon ROW Parcel Microstation File (.dgn) for each affected parcel on a 
project.   

o Property Map (.dgn) 
o Final Property Map (pdf) 
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3.2.3 Uploading Documents - ProjectWise (Thin 
Client) 

The following shows how to upload Contract plans into the 100 Contract Plan folder in 
Projectwise, but this procedure can be followed for uploading documents into any folder in 
Projectwise.   

1. Once logged into Projectwise browse out to project and folder you need to upload into.  
Then go to View>Interfaces and select the “CTDOT_Doc_Code” Interface.  

2. Next select Document>Upload as shown below: 
 

 

Figure 70 - Uploading Document into Projectwise (Thin Client) 

3. Next browse out to the document you want to upload.   

 

Figure 71 - Uploading a File to Projectwise 
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4. After the file uploads, right click on the file and select Properties: 

 

Figure 72 - Select Properties 

5. Then assign the applicable attributes from the tables in Appendix E:  If you cannot assign 
attributes, the interface was not selected as detailed in step 1 or this section.   

 

Figure 73 - Thin Client Attributes 
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3.2.4 Uploading Documents – Projectwise (Thick 
Client) 

The following shows how to upload Contract plans into the 100 Contract Plan folder in 
Projectwise, but this procedure can be followed for uploading documents into any folder in 
Projectwise.   
 

1. Select the Interface  “CTDOT_Doc_Code”  as shown below, if the interface box is not 
shown go to View>Toolbars and select interface. 

2. Drag and Drop files into the correct folder in the Project. 

 

Figure 74 - Uploading Into Projectwise (Thick Client) 
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3. Select the “Advanced Wizard” 
4. Click “Next” until you reach the figure below: 
5. Then assign the applicable attributes from the tables in Appendix E:  If you cannot assign 

attributes, the interface was not selected as detailed in step 1 or this section.   
 

 

Figure 75 - Attributing (Thick Client) 

6. On the Document Properties page nothing needs to be edited.   
7. On the create document page click next and the document will be uploaded into 

Projectwise.   
8. Once the document is uploaded the user may need to click F5 (refresh) to see the file 

name update.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued 04-2016 71 Version 3.13 
     

3.2.5 Combining and Uploading Contract 
Specifications and CSI Special Provisions  

For projects that are led by a consultant designer, FDP and Addendum Contract specifications 
and CSI Special Provisions shall be placed in (1) zipped folder.  For projects that are led by a 
CTDOT design unit, FDP and Addendum Contract specifications and CSI Special Provisions shall 
be placed in individual zipped folders per discipline.  
 
Addendum specifications shall be placed in (1) zipped folder and submitted into the 240 
Contract Development Folder.  Each page of the specification section shall be marked in the 
bottom right corner of the footer with “Addendum No. Y”, where “Y” equals the addendum 
number.  Also a line shall be placed on the right side indicating where language was changed in 
the specification.   
 
Design Initiated Change Orders specifications shall be placed in (1) PDF document and uploaded 
into the 110_Contract Documents folder.  Each page of the specification shall have a “C#” and 
the date in the bottom right corner of the footer.  An example would be, “C1 - 01/01/13”.  Also a 
line shall be placed on the right side indicating where language was changed in the specification.   
 
The following shows an example of a consultant designed project, but the process shall also be 
followed for a CTDOT designed project.  
 
 See the figures below for how to zip a folder: 

1. Place all specifications (word documents) in one folder.   
2. Right click on the folder and select “Compress to” option shown below: 

 

 

Figure 76 - Compress Spec. Folder 

Specifications shall be submitted in a zipped folder for every submittal into Projectwise.  
Submittals include FDP, revised FDP specifications, Addendum specifications, and revised 
addendum specifications. Revised FDP and addendum submissions shall only include the revised 
specifications.  
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Submitting Contract Specifications 
Once logged into Projectwise the final contract specifications shall be submitted as follows:   

1. Make sure the Interface “CTDOT_Doc_Code” is selected. 
2. Drag and Drop the zipped specifications folder into the 240_Contract Development 

Folder or the pdf of the change order specs into the 110_Contract Specifications folder. 
6. Use the advanced wizard and then assign the applicable attributes from the tables in 

Appendix E:  If you cannot assign attributes, the interface was not selected as detailed in 
step 1 or this section.   

3. Click next until the document is uploaded.  The document name and file name will be 
automatically updated to match the CTCode when Projectwise is refreshed.    

3.2.6 Uploading Supplemental Contract Documents 
Once logged into Projectwise, the Final Design Supplemental Contract Documents shall be 
submitted and attributed into the 140 Project Administration or 240_Contract Development 
folder as follows: 

Document Folder 
Proposal Estimate, with signed checklist  240 

Federal Estimate  240 

Calendar Day Estimate 240 

Final Design Report 240 

Categorical Exclusion 240 

Design Approval Letter 240 

DBE/SBE Approval with percentage 240 

Commitment list 240 

Executed Agreements 140 

 Sidewalk Maintenance Agreement 

 Lighting Agreement 

Proprietary Item Approval 240 

Standalone Transportation Management Plan 
Document, taken from the final design report 

240 

 
1. Make sure the Interface “CTDOT_Doc_Code” is selected. 
2. Drag and Drop the document into the 140_Project_Administration or 240_Contract 

Development Folder. 
7. Use the advanced wizard and then assign the applicable attributes from the tables in 

Appendix E:  If you cannot assign attributes, the interface was not selected as detailed in 
step 1 or this section.  All agreements must have the applicable asset tags filled out.  

3. Click next until the document is uploaded.  The document name and file name will be 
automatically updated to match the CTCode when Projectwise is refreshed.    

 
Revised Document 
For documents uploaded into the 240_Contract Development folder, if a document needs to be 
revised, a new revised document shall be uploaded into projectwise with the addition of 
“Revised” being included in the Label. 
 
For documents uploaded into the 140_Project Administration folder, if a document needs to be 
revised, the old document shall be deleted and a new document shall be uploaded.  Do not 
include revised in the label.  Contact AEC Applications to delete the file:  
DOT.AECApplications@ct.gov.      
 

http://www.ct.gov/dot/lib/dot/aashto/estimator/estimator_checklist_dec-2013.pdf
mailto:DOT.AECApplications@ct.gov
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3.2.7 CTDOT Contracts Finalizing of Contract 
Specifications 

CTDOT Contracts shall finalize the specifications working in the 110_Contracts_Specifications 
Folder following this workflow CTDOT Contracts Workflow.  
 

3.2.8 Notification of Submittals 
 
When Contract Plans, Specifications, and supplemental contract documents are submitted into 
Projectwise the applicable personnel must be notified as follows as applicable:   
 

1. For consultant designed projects, the consultant will notify their Liaison Engineer, who 
will then notify, by memorandum, processing that contract plans or specifications have 
been submitted for review.   

2. For state design projects, the project manager will notify, by memorandum, processing 
that contract plans and specifications have been submitted.  

3.2.9 Contract Plans Workflow (FDP - Advertise) 
Table 3-3 below shows how final digital design plans (FDP) flow from delivery through 
processing to their final state in advertising.  
Processing personnel shall use the following workflow: Projectwise for Processing  
   

Final Design Submission (Subsets)  

Step Group Responsibilities of Group  

1 
 

Designer -Submits FDP subsets into the 100_Contract Plans folder 2 weeks prior to FDP. 

2 
Project 
Lead 

-Changes FDP subsets to the LEAD DESIGNER State.  This will lock the documents so the project lead can review the 
subsets prior to FDP.   

2 

 
Processing 
(CTDOT) - Change FDP subsets to the Processing State and digitally mark up with comments and save FDP plans.  Keep FDP 

Plans in the Processing State.  If there are no comments proceed to step 7.  
  
- Create a comment report of these comments and save on your computers desktop.  Then upload and attribute this 
report correctly into the 240_Contract_Development folder.   

3 
 

Designer 
- Change subsets to reflect comments made by Processing 
 
- Submits DCD subsets 

4 

 
Processing 
(CTDOT) 

 

- Change DCD subsets to Processing state 
 
- Perform a document compare on the FDP and DCD plans using Bluebeam. 
 
- Digitally markup DCD subsets with comments and save.  If there are no comments proceed to step 7. 
 
- Create a comment report of these comments and save on your computers desktop.  Then upload and attribute this 
report correctly into the 240_Contract_Development folder.   

5 
 

Designer 
- Change subsets to reflect comments made by Processing on DCD Plans 
 
- Submits DCD2 subsets  

http://www.ct.gov/dot/lib/dot/documents/aec/CTDOT_Contracts_Specificaitons_Workflow.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/Projectwise_For_Contract_Processing.pdf
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6 

 
Processing 
(CTDOT) 

 

- Changes DCD2 subsets to Processing state 
 
- Perform a document compare on the DCD and DCD2 plans using Bluebeam. 
 
- Digitally markup DCD2 subsets with comments.  If there are no comments proceed to step 7.   
 
- Create a comment report of these comments and save on your computers desktop.  Then upload and attribute this 
report correctly into the 240_Contract_Development folder.   

7 

 
Processing 
(CTDOT) 

- Change the Sub Category Attribute of the approved subset from FDP or DCD(1,2..etc.) plans to FPL plans.  STD and 
FIO plans shall not be change to FPL. 
 
- Copy the CTCode and make the document and file name the CTCode.  Make sure the file name has a “.pdf” on the 
end.   
 
-If is a CTDOT Design project, change all discipline subsets to the Manager and Engineering Admin. Sign State. Notify 
Designer they have to have Manager and Engineering Admin sign the title sheet.  When the Designer notifies processing 
these signatures have been applied to the title sheet, change all discipline subsets to the Advertise state.   
 
-If is a Consultant Designed Project, change discipline subsets to Advertise State.  
 
-Delete all previous versions of plans, FDP, DCD, DCD2, etc.   
 
-Keep Comment reports in the 240_Contract_Development folder for records if necessary 
 
-Formally notify Contracts when all subset have been approved for Advertising 

Table 3-1 Workflow for CTDOT Processing Unit (Contract Drawings) 

3.2.10 ProjectWise Project folder Security 
 
Through the use of Workflows and States, Projectwise can provide dynamic securities to a folder 
or document.  Dynamic security allows a different level of security to each document at various 
phases of its life cycle. This allows a document to reside in one location, in Projectwise, 
throughout the project life cycle.   

3.2.11 100_Contract_Plans (PDF) Folder 

(Dynamic Security) 
During the design submittal process the Projectwise workflow, “Contract Plans Processing”, shall 
be applied to this folder. This workflow allows three different states (securities settings) to be 
applied to documents within this folder. Each state provides a unique security. The CTDOT 
Contracts Processing Unit shall determine which state a document in this folder shall be in.  
 
The “Contract Plans Processing” workflow contains the following security states: 
 
Document Transfer State – allows either the Consultant or State Designer to upload, read and 
alter a document.   
 
Lead Designer State – Allows the project lead to lock the documents so they can review the 
project discipline subsets prior to FDP.  
 
Processing State – Allows only the processing unit read, write access, allowing them to review 
the documents in a secluded area. All other users shall have read access.     
 
Manager and Engineering Admin. Sign – Allows the Manager and Engineering Administrator to 
sign the project Title sheet.    
 
Advertise State - Allows all users file read access, allowing any user to open and read the 
document.    
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Once the contract is awarded to the low bidder (Contractor), the documents will move into a 
new workflow called “Contract Plans Construction” which hands control of the documents to 
the CTDOT Office of Construction (all offices).  
 
The “Contract Plans Construction” workflow contains the following security states: 
 
Construction State – allows construction to upload, read and alter a document.  All other users 
shall only have file read. 
Perform As-Built – allows construction to place as-built information on the plans.  All other 
users shall only have file read.   
 
As-Built Complete – All users will have read only when the documents are put in this state. 

3.2.12 Changing the State of a Document 
The designer and district construction will be required to change the state of documents for 
contractor submittals during the review process.  To change the state of a document, follow the 
figure below: 

1. Right click on the document that you want to change the state of, then select change 
state>change, as shown below: 

 

Figure 77 - Changing the State 
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2. Next drag the file(s) from one state to another as shown below: 
 

 

Figure 78 - Changing the State 

3. Click OK when the comment window opens up and the documents state will change.  
Next close the change workflow state window. 

4. Notice the “State” column, the state of the documents has been changed.    
 

 

Figure 79 - State has been changed 

3.2.13 Paper Plan Order Form 
The Paper Plan Order Form was created to allow each unit in the Department to order contract 
plans and specifications for DOT Projects.  This form is located in each project in Projectwise and 
each unit in the Department that needs paper copies of contract plans and specifications is 
required to update this form for their paper needs.  This form is then used by the Department’s 
Engineering Records unit to make the prints and send them out.  
  
Any Addendum or Change Order that is submitted for a project will be printed and sent out 
using the information indicated on the form.  Addendums will be printed and sent out 
automatically.  When a Change Order is submitted, the designer must notify Engineering records 
that a Change Order has been submitted and that paper copies of the Change Order need to 
printed and sent to the applicable units indicated on the Paper Plan Order Form.   
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This following shows the procedure for how the Paper Plan Order Form is filled out and the 
prints are made. 
 
Contact Information for Engineering Records:  
 Print Shop: 860-594-3086 Plan and Specification Printing 
 

Step Project 
Stage/Submittals 

Group Action 

1 FDP Processing After the contract plans and specifications have 
been submitted for FDP an email is sent to each 
unit in the Department that requires paper copies 
of contract plans and specifications.   

2 FDP Units Open the Paper Plan Order Form from Projectwise 
and fill out the form for their unit’s needs.  Save 
the form and check the form back into 
Projectwise. 

3 DCD Processing At DCD, lock the form by placing it in the 
Processing state. 

4 Advertise Contracts Notify Engineering Records that the project is 
going to be advertised and they can print the 
required paper copies indicated on the Paper Plan 
Order Form. 

5 Advertise Engineering 
Records 

Print the required paper copies indicated on the 
Paper Plan Order Form. 

6 All Addendums Contracts Notify Engineering Records that an Addendum is 
going to be advertised and they can print the 
required paper copies indicated on the Paper Plan 
Order Form for this Addendum.  Make sure to tell 
Engineering Records which subsets are included in 
the Addendum. 

7 All Addendums  Engineering 
Records 

Print the required paper copies indicated on the 
Paper Plan Order Form for the Addendum.  Make 
sure to print all the subset that were affected by 
the Addendum including the 02-Revisions subset. 

8 All Change 
Orders 

Lead Designer Notify Engineering Records that a Change Order 
has been submitted and they can print the 
required paper copies indicated on the Paper Plan 
Order Form.  Make sure to tell Engineering 
Records which subsets are included in the Change 
Order.  If a unit is not listed on the Paper Plan 
Order Form, give Engineer Records those units’ 
contact information so those units’ can receive a 
copy of the Change Order.  

9 All Change 
Orders 

Engineering 
Records 

Print the required paper copies indicated on the 
Paper Plan Order Form for the Change Order and 
for any other units’ requested by the Lead 
Designer. Make sure to print all the subsets that 
were affected by the Change Order including the 
02-Revisions subset.   
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 Contract Plan and Specification Section 4

Revisions (Addenda and Design Initiated 

Change Order) 

4.1 Addenda 
Contract plans that are revised or added due to addenda shall be submitted in digitally signed 
PDF discipline subsets containing only the changed sheets.  The sheets being revised or deleted 
shall not be included in the Addenda submittal. The first sheet of each addendum subsets shall 
be digitally signed in a digital signature place holder, that is placed in Microstation as described 
in Section 2.0 of this manual, DO NOT ADD an index of drawings sheet.   Once digitally signed, 
the addendum subsets shall be submitted to CTDOT using Projectwise, as described in Section 
3.0 of this manual. 
 
Addenda sheets from different subsets cannot be combined and submitted as one subset, they 
must be submitted per their respected subsets.   
 
The discipline Addenda subsets shall be attributed as follows, when uploaded into Projectwise 
(See Section 3.0): The addenda subset shall have the same Projectwise label as the original final 
plan subset with the addition of (_A##) added to the end, where the ## equals the addenda 
number.  The sub-category attribute shall be ADP and ACD if the ADP plans are revised. See 
example below: 

 
PROJECTWISE LABEL ATTRIBUTE 
 

Original Discipline Subset:  04-Traffic 
  
Addenda Discipline Subset:  04-Traffic_A01 
2nd Addenda    04-Traffic_A02 
6th Addenda    04-Traffic_A06 

 
The contract sheets (previously submitted final plans or earlier addenda plans), being revised by 
addenda shall UNOT be modified except; the Engineer of Record shall place an addenda stamp on 
the affected sheets.  This addenda stamp crosses out the entire sheet with a red X and adds the 
following note; "THIS SHEET REPLACED BY ADDENDUM NO."Y"; where "Y" equals the addendum 
number. This stamp is placed over digital signatures therefore; removal of the signatures is not 
required prior to placing the addenda stamp.  For this process see Section 4.4.   
 
WARNING – When placing the stamps, removing the digital signature is not allowed.   
   
The Index of Revisions Sheet(s) located in the 02-Revisions subset(s) shall be managed by the 
project manager for all addenda, and submitted as described in Section 4.3.1.  A new subset 
must be updated for each addendum.   
 
A watermark of the signer’s signature; signature only for (CTDOT), or PE Stamp for (Consultants) 
shall be placed on all added or revised sheets.  See Section 2.2 
 
Paper copies for all Addendums will be requested by the Department’s Contracts unit and sent 
to all applicable units following section 3.2.13. 
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4.1.1 Revised Plans - Addenda 
Microstation Processes 
A note shall be placed, directly above the bottom right hand corner of the title block, on the 
replacement sheets stating “ADDENDUM NO. “Y”, where “Y” equals the addenda number.   This 
note is a level in Microstation that needs to be turned on and edited.  
 
For revised sheets the drawing numbers shall not be modified.  
 
The areas on the sheet that are being revised shall be clouded and a numbered triangle shall be 
placed within this clouded area.  A like numbered triangle shall be placed in the revision block of 
the changed sheet, accompanied by a description of the revision itself. The revision number is 
specific to a particular sheet, and increases in consecutive order per revision and per addenda. If 
a sheet is changed for the first time under addenda five the revision number is 1 NOT 5. If it is 
changed again under addenda 7 the revision number becomes 2. 
 
Note: If there are a lot of changes to a sheet and it is not possible to cloud all the changes in a 
clear manner, do not void out the existing sheet and create a new sheet.  In these instances, 
the designer shall place a cloud just inside the border of the revised addendum sheet. 
 
Note:  When preparing an Addendum that will change quantities on a project that includes a 
"Detailed Estimate Sheet", never revise the "Detailed Estimate Sheet."  A "Detailed Estimate 
Sheet" is never included in an addendum.  Also, the "Quantities" box shown on the General 
Plan sheet for any structure is never to be revised. 
 
Bluebeam Processes 
Sheet numbers for revised plans shall be as follows: 
Original Final Plan Sheet; 
 
 Original:  02.25 
 Addenda 1:  02.25.A1 
Previous Addenda Sheet; 
  

Original:  02.25.A2  
Addenda 4:  02.25.A4 

 
If a sheet requires further revisions by a subsequent addendum, the addendum shall be 
prepared, as detailed above. The previously revised sheet shall now be stamped using Bluebeam 
after addendum approval, see Section 4.4.   
 

4.1.2 New Sheets - Addenda 
Microstation Processes 
Changes that require a new sheet(s) to be added to a discipline subset shall be formatted in one 
of two ways, as follows:  
  

1. If the new sheet does not have to be placed in a specific location within the discipline 
subset, the new sheet shall be placed last, and numbered sequentially from the last 
sheet of the discipline subset.  The total number of sheets noted on the project plans 
and discipline subsets stays the same.  A note shall be placed on the new sheet stating, 
"NEW SHEET ADDED BY ADDENDUM NO."Y", where "Y" equals the addendum number.  
This note shall be located directly above the right hand corner of the title block.   This 
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note is a level in Microstation that needs to be turned on and edited.  The revision block 
on the added sheet, shall not be filled out. 

 
2. If the designer determines that the new sheet must go in a specific location within the 

discipline subset, the new sheet number shall be the number of the previous sheet 
followed by (-1.A#), where # is the Addendum Number.  For example, if the new sheet 
must be placed in a discipline subset right after sheet 02.57, the new sheet shall be 
numbered 02.57-1.A1, if an additional sheet needs to be added, in this case it would be 
02.57-2.A1.  The total number of sheets noted on the project plans stays the same.  A 
note shall be placed on the new sheet stating, "NEW SHEET ADDED BY ADDENDUM 
NO."Y", where "Y" equals the addendum number.  This note shall be located directly 
above the right hand corner of the title block.  This note is a level in Microstation that 
needs to be turned on and edited.   

 
When adding a new sheet a new drawing number is also required. As with the sheet 
number the drawing number of the new sheet shall be the drawing number of the 
previous sheet plus a decimal and the sheet count.  For example, if the new drawing 
must be placed in the project plans right after drawing number S-5, the drawing number 
shall be S-5-1. 

 
Bluebeam Processes 
Added sheet numbers, inserted NOT added to the end of Subset, shall be as follows: 

 
Original Final Plan Sheet; 
 
 Original:  04.31 
 Addenda 3:  04.31-1.A3 
 
Previous Addenda - Added Sheet; 
 
 Original:  03.24.A1 
 Addenda 4:  03.24-1.A4 
 
Previous Addenda - Revised Sheet; 
 

Original:  05.14-1.A1 
 Addenda 2:  05.14-1.A2 
 
Previous Addenda - Added Sheet; 
 

Original:  05.14-1.A1 
 Addenda 2:  05.14-2.A2 
 
If adding sheets to the end of a subset, the new sheet number shall be a continuation of the 
previous sheet number plus .A#, where # equals the addenda number. 
 
Original Final Plan Sheet; 
 
 Original Last Sheet:  04.31 
 Addenda 3:   04.32.A3 
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4.1.3 Adding New Subset – Addenda 
The new subset shall be submitted by an Addendum and be  prepared the same way as an FDP 
discipline subset, with the addition of an A# in the sheet numbers and a note shall be placed, 
directly above the right hand corner of the title block, on the sheets stating “ NEW SHEET 
ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addenda number.  This note is a level in 
Microstation that needs to be turned on and edited.  The label attribute on the new subset shall 
contain an “_A##”.   The first sheet of a new subset to the contract will be a subset cover sheet 
and contain an index of drawings.     

4.1.4 Voiding Sheets 
 
Sheets submitted within final design plan subsets and addenda subsets shall UNOT be deleted; 
but shall voided by the engineer of record with an addenda stamp, using Bluebeam. This 
addenda stamp crosses out the entire sheet with a red X and adds the following note; "VOIDED 
BY ADDENDUM NO.”Y"; where "Y" equals the addendum number.  See Section 4.4   
 

4.1.5 Addenda Plans Workflow 
X 
Table 4-1 Contract Processing Addenda File Workflow for Contract Drawings            below shows how 
addenda subsets are delivered and processed for advertisement.  

Table 4-1 Contract Processing Addenda File Workflow for Contract Drawings 

Addendum Plans  

Step Group Responsibilities of Group  

1 
 

Designer -Submits ADP subsets into the 100_Contract Plans folder. 

2 

 
Processing 
(CTDOT) - Changes document to the Processing State and digitally mark up with comments and save.  Keep ADP Plans in the 

Processing State.  If there are no comments proceed to step 7. 
 
- Create a comment report of these comments and save on your computers desktop.  Then upload and attribute this 
report correctly into the 240_Contract_Development folder.  Notify the designer when this is finished. 

3 
 

Designer 
- Change subsets to reflect comments made by Processing 
 
- Submits ACD Subsets 

4 

 
Processing 
(CTDOT) 

 

- Changes ACD subsets to Processing state 
 
- Perform a document compare on the ADP and ACD plans using Bluebeam. 
 
- Digitally markup ACD subsets with comments.  If there are no comments proceed to step 7.   
 
- Create a comment report of these comments and save on your computers desktop.  Then upload and attribute this 
report correctly into the 240_Contract_Development folder.  Notify the designer when this is finished. 

5 
 

Designer 
- Change subsets to reflect comments made by Processing on ACD Plans 
 
- Submits ACD2 Subsets.   

6 

 
Processing 
(CTDOT) 

 

- Change ACD2 Subsets to Processing state 
 
- Perform a document compare on the ACD and ACD2 plans using Bluebeam. 
 
- Digitally markup ACD2 subsets with comments.  If there are no comments proceed to step 7. 
 
- Create a comment report of these comments and save on your computers desktop.  Then upload and attribute this 
report correctly into the 240_Contract_Development folder.  Notify the designer when this is finished. 
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7 

 
Processing 
(CTDOT) 

- Change the Sub Category Attribute of the approved subset from ACD(1,2..etc.) plans to ADP plans 
 
- Copy the CTCode and make the document and file name the CTCode.  Make sure the file name has a “.pdf” on the 
end.   
 
- Change discipline subsets to the Advertise State.   
 
-Delete all previous versions of plans, ADP, ACD, ACD2, etc.   
 
-Keep Comment reports in 240_Contract_Development folder for records if necessary 
 
- Formally notify Contracts when all subset have been approved for Advertising 
 
- Notify the designer that the plans are going to be advertised and they can put the addenda stamps on the affected 
sheets. 

4.1.6 Addenda Specifications 
Contract Specifications that are revised or added due to addenda shall be submitted digitally in 
accordance with section 3.2.5. 

4.1.7 Addenda Report 
Addenda report shall contain all the changes to the plans and specifications and any contractor 
questions and answers.  This report shall be submitted in Word format into the 
240_Contract_Development in Projectwise with the following attributes: 
 
Discipline = CT 
Main Category = DOC 
Sub Category = RPT 
Label = “Addn. No. # Report”, where # is the addendum number.  If a report is revised the label 
shall include “Rev.” at the end.  If the report is revised a second time the label shall include “Rev. 
2” at the end, etc. 
Description = Give a brief description of the submission.  

4.1.8 Addendum CTDOT Standard Drawing Subsets 
The designer shall prepare an addendum to a CTDOT Standard Drawing subset in accordance 
with the following. 
 
The Addendum for a standard subset shall only include the added sheets, do not include all the 
standards for the project.  Follow section 1.8 to prepare the standard subset, only include the 
added sheets and check off only those sheets on the index sheets.  
 
When uploading to Projectwise, add an “A##” to the end of the label attribute.   
 
Update the 02-Revision subset to record this change.  

4.2 Design Initiated Change Order (DCO) 
 
Design Initiated Change Orders (DCO) are change order requests in which the designer alters the 
original contract by: 

 A revision to an existing plan sheet(s) or specification(s) 

 The addition of a new plan sheet(s) or specification(s) 

 The deletion of an existing plan sheet(s) or specification(s) 
 
The creation and management of DCO’s shall be as specified in this section. 
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Contract plans changed or added due to DCO’s shall be submitted in a digitally signed PDF 
discipline subset(s) containing only the added or changed sheets. The sheets being revised or 
deleted shall not be included in the Change Order submittal. The first sheet of each DCO subset 
shall be digitally signed in a digital signature place holder, that is placed in Microstation as 
described in Section 2.0 of this manual, DO NOT ADD a cover sheet. Once digitally signed the 
DCO subset(s) shall be submitted, to the CTDOT, using Projectwise as described in Section 3.2 of 
this manual. 
 
DCO sheets from different subsets cannot be combined and submitted as one subset.  
 
The discipline DCO subsets shall be coded as follows, when uploaded into Projectwise (See 
Section 3.0): The DCO subset shall have the same Label Attribute as the original final plan subset 
with the addition of (_C###) added to the end, where the ### equals the DCO number.  The sub-
category attribute shall be DCO (Design Initiated Change Order) See Examples below: 

      
 
 
PROJECTWISE LABEL ATTRIBUTE 

Original Discipline Subset:  04-Traffic 
 
DCO Discipline Subset:   04-Traffic_C001 
6th DCO    04-Traffic_C006 

 
Original Addenda Subset:  04-Traffic_A03 
  
DCO Discipline Subset:   04-Traffic_C001 
3rd DCO      04-Traffic_C003 
 
    

The contract sheets (previously submitted final plans, addenda plans, or DCO plans), being 
revised by DCO shall UNOT be modified except; the Engineer of record shall place a DCO stamp on 
the revised sheets using Adobe Acrobat.  This digital DCO stamp crosses out the entire sheet 
with a red X and adds the following note; "THIS SHEET REPLACED BY DESIGN INITATED CHANGE 
ORDER NO."Y" –mm/dd/yy; where "Y" equals the Design Initiated Change Order number. This 
stamp is placed over digital signatures therefore; removal of the signatures is not required prior 
to placing stamp.  For this process see Section 4.4  
 
WARNING – When placing the stamps, removing the digital signature is not allowed.   
 
The Index of Revisions Sheet(s) located in the 02-Revisions subset shall be updated by the 
project manager for all DCO, and submitted as described in Section 4.3.2.    
 
A watermark of the signer’s signature, signature only for (CTDOT), or PE Stamp for (Consultants) 
shall be placed on all DCO sheets.  See Section 2.2 
 
Paper copies for all change orders will be requested and sent to all applicable units’ following 
section 3.2.13.   
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4.2.1 Revised Sheets – DCO 
Microstation Processes 
A note shall be placed, directly above the right hand corner of the title block, on the 
replacement sheets stating “DESIGN INITIATED CHANGE ORDER NO. “Y” – mm/dd/yy, where “Y” 
equals the Design Initiated Change Order number.  This note is a level in Microstation that needs 
to be turned on and edited.   
 
The areas on the sheet that are being revised shall be clouded and a numbered triangle shall be 
placed within this clouded area.  A like numbered triangle shall be placed in the revision block of 
the changed sheet, accompanied by a description of the revision itself.  The revision number is 
specific to a particular sheet, and increases in consecutive order per revision and per change to 
the sheet. If a sheet is changed for the first time under addenda #5 then change for DCO #1 
revision number is 2 NOT 1. If it is changed again under DCO 2 the revision number becomes 3. 
 
Details shown on the original PDF, but no longer required, shall not be deleted on the revised 
PDF, but shall be crossed out.  Any details to be deleted shall be crossed out with an “X” on the 
revised sheet.   Engineering judgment must be used to produce clear and concise information 
for the contractor. 
 
If the number of changes to the sheet cannot be clouded in a clear and concise manner, the 
existing sheet should be voided in accordance with Section 4.2.4 and a new DCO sheet created 
in accordance with Section 4.2.2 
 
 
 
Bluebeam Processes 
Sheet numbers for revised plans shall be as follows: 
 
Original Final Plan Sheet; 
 
 Original:  02.25 
 DCO 1:  02.25.C1 
 
 
Previous Addenda Sheet; 
  

Original:  02.25.A2  
DCO 4:  02.25.C4 
 

 
Previous DCO Sheet; 
  

Original:  02.25.C2  
DCO 4:  02.25.C4 
 
 

Drawing numbers shall not be modified on revised sheets.  
 
Approval blocks on all new sheets shall be watermarked with a signature (CTDOT) or PE Stamp 
(Consultant) and the first sheet of the subset shall be digitally signed in accordance with Section 
2 of this document.  
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4.2.2 New Sheets – DCO 
Microstation Processes 
Changes that require new sheet(s) to be added to a discipline subset shall be formatted in one 
of two ways, as follows:  
 

1. If the new sheet does not have to be placed in a specific location within a discipline 
subset, the new sheet shall be numbered sequentially from the last sheet of the 
discipline subset.  The total number of sheets noted on the project plans and discipline 
subsets stays the same.  A note shall be placed on the new sheet stating, “NEW SHEET 
ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy” where “mm/dd/yy” 
equals the month, day and year the change order request was submitted.  This note 
shall be located directly above the title block.  This note is a level in Microstation that 
needs to be turned on and edited.   
 

2. If the designer determines that the new sheet belongs in a specific location within a 
discipline subset, the new sheet number shall be the number of the sheet it most closely 
relates to followed by (-1.C#).  For example, if the new drawing should reside in the 03-
Highway discipline subset right after sheet 03.57 but before sheet 03.58, the new sheet 
shall be numbered 03.57-1.C#.   
 
The total number of sheets noted on the project plans stays the same.  A note shall be 
placed on the new sheet stating, “NEW SHEET ADDED BY DESIGN INITIATED CHANGE 
ORDER NO. Y – mm/dd/yy” where “mm/dd/yy” equals the month, day and year the 
change order request was submitted.  This note shall be located directly above the 
bottom right hand corner of the title block.  This note is a level in Microstation that 
needs to be turned on and edited.   

 
When adding a new sheet a new drawing number is also required. The drawing number 
of the new sheet shall be the drawing number of the sheet it most closely relates to 
followed by (-#).  For example, if the new drawing must be placed in the project plans 
right after drawing number HWY-10, the drawing number shall be HWY-10-1. 

 
Bluebeam Processes 
Added sheet numbers, to a specific location, shall be as follows: 
 
Original Final Plan Sheet; 
 Original:  04.31 
 DCO 3:  04.31-1.C3 
 
Previous Addenda – Added Sheet; 
 Original:  03.24.A1   

DCO 4:  03.24-1.C4  
 

Previous DCO – Revised Sheet; 
Original:  02.45.C1 

 DCO 2:  02.45.C2  
Previous Addenda - Added Sheet; 

Original:  05.14-1A1   
 DCO 2:  05.14-2.C2  
 
Previous DCO – Added Sheet; 

Original:  02.45-1.C1  
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DCO 2:   02.45-2.C2 
If adding sheets to the end of a subset, the new sheet number shall be a continuation of the 
previous sheet number plus C#., where # equals the Design Initiated Change Order Request 
number. 
 
Original Final Sheet 
  
 Original Last Sheet: 04.35 
 DCO 4:   04.36.C4 

4.2.3 New Subset – DCO 
The new subset shall be submitted by DCO and be prepared the same way as an FDP discipline 
subset, with the addition of an C# in the sheet numbers and a note shall be placed, directly 
above the right hand corner of the title block, on the replacement sheets stating “NEW SHEET 
ADDED BY DESIGN INITIATED CHANGE ORDER NO. “Y” – mm/dd/yy, where “Y” equals the Design 
Initiated Change Order number.  This note is a level in Microstation that needs to be turned on 
and edited.  The label attribute shall contain “_C##”.  The first sheet of a new subset to the 
contract will be a subset cover sheet and contain an index of drawings.    

4.2.4 Voided Sheets 
Sheets submitted within final design plan subsets, addenda subsets, or design initiated change 
order subsets shall UNOT be deleted; but shall be voided by the engineer of record, with a DCO 
stamp using Adobe Acrobat or Bluebeam. This DCO stamp crosses out the entire sheet with a 
red X and adds the following note; "VOIDED BY DESIGN INTIATED CHANGE ORDER NO. Y – 
mm/dd/yy; where "Y" equals the Design Initiated Change Order number.  See Section 4.4  

4.2.5 DCO Specifications  
Specifications shall be created in accordance with the Departments policies and procedures for 
Contract Development.  The Engineer shall also combine all specifications into (1) PDF document 
and upload that into the 110_Contract Specifications (PDF) folder in Projectwise following 
section 3.2.5. 
 

4.2.6 DCO CTDOT Standard Sheet Subsets 
The designer shall prepare a DCO to a CTDOT Standard Drawing subset in accordance with the 
following. 
 
The DCO for a standard subset shall only include the added sheets, do not include all the 
standards for the project.  Follow section 1.8 to prepare the standard subset, only include the 
added sheets and check off only those sheets on the index sheets.  
 
When uploading to Projectwise add an “C##” to the end of the label attribute.   
 
Update the 02-Revision Subset to record this change.  

4.3 02-Revisions Subset 
The project manager is responsible for managing this subset.  The subset can be downloaded 
from these links: 

CTDOT Designed Projects - 02-Revisions Subset 
  Consultant Designed Projects -  02-Revisions_CE_Subset  

http://www.ct.gov/dot/cwp/view.asp?a=3886&q=459664
http://www.ct.gov/dot/cwp/view.asp?a=3886&q=459664
http://www.ct.gov/dot/lib/dot/documents/aec/02-revisions_ctdot.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/02-revisions_ce.pdf
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Each project has a 02-Revisions subset and this subset only contains the, “Index of Revisions 
Sheet(s)”.  These revision sheets are used for tracking all sheet changes due to addenda (ADP) 
and Design Initiated Change Order (DCO) with respect to the entire project.  The 02-Revisions 
subset starts out as an un-signed blank place holder in the project.  The figure below is an 
example of a blank 02-Revisions subset: 

 

Figure 80 - Blank 02-Revisions Subsets 

ADDENDA: 
 
When the project requires an Addendum, the Project Manager must record these changes on a 
NEW 02-Revisions_A## subset, where A## equals the Addendum ##.  New 02-Revisions subsets 
shall contain all previous Addendum information.  For example, Addendum 4 shall include all 
changes made from Addendums 1, 2, 3 and 4.   
 
Note: A New 02-Revisions subset is required for each addendum because there are times when 
multiple addendums are being submitted to processing for the same project.  An example of this 
is if Addendum 1 and Addendum 2 are submitted to processing at the same time, two 
addendum revision sheets must be submitted. 
 
DESIGN INITIATED CHANGE ORDER: 
 
When a project requires a Design Initiated Change Order (DCO), the following process shall be 
followed: 
 
For each DCO, the Project Manager shall AMMEND the 02-Revisions subset.  The 02-Revision 
subset shall always contain all previous Addendum information and the new DCO information.  
For example, when DCO #1 is prepared, the 02-Revisions subset shall include all Addendum 
information as well as the changes made for DCO #1. 
 
The following figures are an example of the “Index of Revisions Sheet(s)” completed up to 
Addendum #3:  
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Figure 81 - Index of Revisions Sheet 

Detail A from figure 1 shows the information typed in for a change to the contract plans.  The 
project designer inputs the Addendum or DCO number, the sheet number, the date, a 
description of the change, the person who made the change, and checks the appropriate box 
for: new sheet added, revised sheet or deleted sheet.  

 

Figure 82 - Detail A 

Detail B from figure 1 shows the title block information.   

 

Figure 83 - Detail B 
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4.3.1 02_Revisions Subset Workflow - Addenda 
Each time an addendum is issued, the “Index of Revisions sheet” must be updated by the Project 
Manager as follows: 

1. The user will export/download the latest 02-Revisions subset out of Projectwise to their 
local computer.   

2. With your digital signature USB key inserted within the USB, right click on the Signature 
Box and select Clear Signature as shown below, this is the first Addendum this step can 
be skipped since the subset will not have a signature on it:  

 
Figure 84 Clearing the Digital Signature 

 

3. Enter the information into form fields as described in section 4.3.4.  

4. Add note “ADDENDUM NO. Y” in the bottom right hand corner of the sheet above the 
title block, where Y = the Addendum number.   

5. Add new revision sheet each time previous sheet becomes full.  Add note “NEW SHEET 
ADDED BY ADDENDUM NO. “Y”, where “Y” equals the addenda number.  Follow section 
4.3.3 of this document.   

6. When finished sign using a certifying signature as shown in Section 2.6.2 

7. Upload the document into Projectwise. 

8. Attribute the subset:  Main Category = CON, Sub-Category = ADP, Label = 02-
Revisions_A## 

9. Make the document description 02-Revisions_A##. 

4.3.2 02_Revisions Subset Workflow - DCO 
The following workflow shall be used by the Project Manager for recording DCOs to the 02-
Revisions subset.  In this workflow the user edits the subset in Projectwise, they do not have to 
export the document out and submit a new subset: 

1. Check out the 02-Revisions subset from Projectwise. 

2. With your digital signature USB key inserted within the USB, right click on the Signature 
Box and select Clear Signature as shown below, this is the first Addendum this step can 
be skipped since the subset will not have a signature on it:  
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Figure 85 Clearing the Digital Signature 

 

3. Enter the information into form fields as described in section 4.3.4.  

4. Edit the note above the title block with “DESIGN INITIATED CHANGE ORDER NO. Y - 
mm/dd/yy” 

5. If a new revisions sheet is added, add the note above the title block with “NEW SHEET 
ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y – mm/dd/yy” 

6. Resign the 02-Revision subset in accordance with Section 2.6.2 

7. In step 7 “Check In” the document into Projectwise 

4.3.3 Adding a New Revisions Sheet to the 
02_Revisions Subset 

1. Download a new “Index of Revisions sheet” from  Section 1.4 step 16. 
2. Insert the new sheet into the existing 02-Revisions subset pdf.  Update the title block 

information and update the sheet accordingly.   

4.3.4 Filling Out Revision Index Sheet 
To fill out a form field simply click on the box and begin typing. The first column is the 
Addendum or Design Initiated Change Order. The second column is the revised or new sheet 
number. The third column is the date, followed by a brief description that is similar to the 
description on the actual sheet being revised. Finally click in the appropriate check box per row 
to describe the action taken, new sheet, revised sheet, or sheet deleted.  Note:  The Engineer is 
not required to input changes numerically by Sheet No.  If another changed sheet is added to an 
Addendum in the eleventh hour, it can be placed at the bottom of the list on the “Index of 
Revisions Subset”.    
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Figure 86 Modifying the “Index of Revisions Subset” 

4.4 Placing Stamps on Affected Sheets – Revised, or 

Deleted Sheets 
A digital stamp that crosses out the entire sheet shall be placed on digital contract sheets that 
are affected by Addenda or Design Initiated Change Order. The stamp shall be placed using 
Bluebeam’s Stamp tools and can be found in the tool chest under the miscellaneous stamps or 
in Markup>Stamps as shown below:    
 

 

Figure 87 - Addendum and Change Order Stamp 

If you do not have the stamp in the tool chest you need to download the CTDOT Bluebeam User 
Profile as shown in Appendix A.  If you do not have the stamp in the Markups>Stamp area, see 
Appendix A – Bluebeam Stamps   
 
WARNING – When placing the stamps, removing the digital signature is not allowed.   
XTable 4-1 below lists the notes that shall be used for addenda, construction order requests, and 
as built notes. These notes should be used in conjunction with the cross-out stamp.  
 
The following shows how to apply the stamp to the sheet that needs to be crossed out for an 
Addendum or Change Order.   

1. Select the stamp from the Tool chest or Markup>Stamps and place it: 
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Figure 88 - Addendum and Change Order Stamp 

 
 
 

2. After the stamp is placed a box will pop up.  Enter the applicable note from table 4-1 
below in all caps as shown below: 

 

Figure 89 - Enter Note for Addendum and Change Order Stamp 

Table 4-1 Modifications to Existing Sheets by Addendum, Construction Orders and As-Builts 

Addendum Notes Description of Use 

THIS SHEET REPLACED BY ADDENDUM NO. Y The revised sheet is considered to replace, in 
total, the original sheet. 

VOIDED BY ADDENDUM NO. Y Sheet is voided by Addendum. 

  

Design Initiated Change Order Notes Description of Use  

THIS SHEET REPLACED BY DESIGN INITIATED 
CHANGE ORDER NO. Y – mm/dd/yy 

Used for revisions to existing sheets. Changes 
must be noted only on the revised sheet.     

VOIDED BY DESIGN INITIATED CHANGE 

ORDER NO. Y – mm/dd/yy 

Use this for voiding of existing sheets. 

 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued 04-2016 93 Version 3.13 
     

3. The following shows a completed stamp. 

 

Figure 90 Typical Sheet Replaced by Addendum 1 

 

 

Figure 91 Typical Sheet Replaced by DCO 
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 As-Built Comments - Final Plans Section 5

As stated in the CTDOT’s Construction Manual chapter 1-313 “Final Revisions of Plans and Cross 
Sections”, it is the responsibility of either the Contracting Engineers (Consultant Inspectors) or 
State Forces (Office of Construction) to perform final as-built revisions of Contract Plans.  As-
Built revisions shall be recorded in accordance with Chapter 1-313 of the Construction Manual, 
amended as follows: 

Final as-built revisions will be applied to the digitally signed PDF plans as a digital 
comment, using Adobe or Bluebeam’s commenting tools. Digital comments are placed 
over the top of the digital signature and its security, therefore, the original content of 
the PDF plans can never be altered. Because as-built comments are digital and placed 
over the top of the plans they are easily recognizable, searchable, and may be turned off 
if necessary. 

As-built comments shall be applied to the latest sheet, whether it’s the original, 
addenda, or construction order plans, located in ProjectWise within the project’s 
100_Contract Plans folder.  

If additional As-Built information has been created, (information that cannot be placed 
on the digitally signed contract plans), these sheets shall be combined by subset number 
and uploaded into the 100_Contract Plans folder in Projectwise.  

CAD drawings may be updated, at the discretion of each design office, to reflect any 
addenda, change orders, and as-built revisions for use in the future; however the 
original digitally signed as-built PDF plans shall not be replaced and shall be the PDF set 
for permanent records.  

5.1 As-Built Revisions (Digital Comments) Workflow 
Two methods for applying as-built revisions to the digital PDF plans are provided in the following 
sections; 5.1.1 and 5.1.2.  
 
The first method, Section 5.1.1 Post Construction, district staff shall record as-built revisions on 
their record set (paper copies) during construction. Once construction is completed these 
revisions shall then be applied as comments to the digital PDF per the workflow in section 5.1.1. 
 
The second method, using Section 5.1.2 Active As-Built, district staff shall record as-built 
revisions on their record set (paper copies), and shall apply them as comment to the final set of 
digital PDF plans on an intermittent bases, during construction. By using this method as-built 
information becomes available to all parties that have access to ProjectWise during the 
construction process, improving communication and transparency.  
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5.1.1 Post Construction As-Built 
 

As-Built Workflow 

 
Step Personnel  Task 

1 Chief Inspector Notify the Contracting Engineer or Designated District Staff that 
As-Builts can be applied to the Contract Plans. 

2 Contracting Engineer 
or District Staff 

Change the state of the Contract Plans to “Perform As Built”, 
see Section 3.2.12 

3 Contracting Engineer 
or District Staff 

Apply As-Built revisions to the Contract Plans in accordance 
with Section 5.3 

4 Contracting Engineer 
or District Staff 

Change the state of the Contract Plans to “As Built Complete”, 
see Section 3.2.12 

5 Contracting Engineer 
or District Staff 

Notify all applicable personnel list in the Section 5.4.2 that the 
As-Builts have been completed for this project. 

 

5.2 As-Built Markup of Contract Plans 

All as-built information will be placed using a few basic Bluebeam commenting tools.  These 
tools include text tools, line and arrow tools, and stamp tools (all other tools will still be 
available under the main toolbar).  These tools will be in the right-hand panel under “CTDOT As 
Built Tools” tool box when the CTDOT As-Builts Profile is selected (see CTDOT Bluebeam Profile): 

 

Figure 92 - As-Built Commenting Tools 
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5.3 Applying As-Built Comments to Contract Plans 

5.3.1 Before Using Bluebeam for As-Builts 
All CTDOT users are required to complete the steps in Appendix A prior to applying as-built 
revisions. By completing these steps as-built revisions will be standardized across the all 
CTDOT users.   These steps only need to be completed the first time using Bluebeam or when 
the user logs into a new computer. 

 Perform the initial login steps for Bluebeam.  Initial Log Into Bluebeam 

 Download the CTDOT Bluebeam profile.  Download CTDOT Bluebeam Profile 

 The user must have a ProjectWise login/password.  Contact Julie Annino if you do 

not have a Projectwise Username and Password. 

5.3.2 Opening the Contract Plans from Projectwise 
The contract plans are located in the 100_Contract_Plans folder of the project in Projectwise, as 
shown below: 

 

Figure 93 - Location of the Contract Plans in Projectwise 
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1. Login into Projectwise, then browse to the 100_Contract_Plans folder of the project you 

are working on.   

2. To open a document with Bluebeam right click on the document, and select “Open 

With” as shown below: 

 

Figure 94 - Open With Bluebeam 

3. Select the Bluebeam icon and check “Always use this program” and select OK.  The 

document will now be checked out of Projectwise and open with Bluebeam: 

 

Figure 95 - Open with Bluebeam 

Note:  Since we checked “Always use this program”, the next time you open a pdf in 
ProjectWise all you need to do is double click on the file. 
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4. After the As-Builts are applied to the contract plans click save in Bluebeam and then 

select “Check In” when a projectwise dialog box pops up.  If the document is not 

checked back into Projectwise the As-Builts will not be uploaded to Projectwise.   

5.3.3 Applying Digital As-Built Stamps 

5.3.3.1 Construction Started & Completed Dates 
The construction started and complete date stamps must be applied to the PDF title sheet, 
located in the 01_General subset, as stated below: 
   

1. Select the ”ConstructionStartedandCompletedDates”: stamp from the  “CTDOT As Built 

Tools” tool box and place it at a conspicuous location on the title sheet: 

 

Figure 96 - Construction Started and Completed Date Stamp 

2. Enter Start and end and click OK as shown below: 

 

Figure 97 - Entering the Dates for the Stamp 
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Below is an example of the placed stamp: 

 

Figure 98 - Placed Stamp 
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5.3.3.2 This Sheet Not Corrected Stamp 
This stamp must be placed on all PDF sheets that do not contain as-built revisions. Detail 
Estimate Sheets must never be revised; therefore, they always receive this stamp. 
 

1.  To place the “THIS SHEET NOT CORRECTED” stamp on an individual PDF sheet, select 

that stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand 

corner of the sheet, by clicking once. 

If the majority of the sheets do not contain as-built revisions it is easier to apply this note to 
every sheet included in plan set, including the as-built revised sheets, and then go back and 
remove it from the sheets that were corrected.  
 

1. To place the “THIS SHEET NOT CORRECTED” stamp on the entire plan set, select that 

stamp from the CTDOT As Built Tools tool box and place it in the lower right-hand corner 

of the first sheet in the plan set: 

 

Figure 99 - Placing the "This Sheet Not Corrected Stamp" 
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2. Right click on the stamp that was placed and select “Apply to All Pages”: 

 

Figure 100 - Placing the Stamp on All Pages 

This will place the “THIS SHEET NOT CORRECTED” stamp on every plan sheet within the 
pdf set.   
 

NOTE:  You must go back and replace this note on the sheets that contain as-built revisions 
with the appropriate stamp.  
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5.3.3.3 This Sheet Corrected 
 
This stamp must be applied to all PDF sheets that contain as-built revisions.  
 

1. To place the “THIS SHEET CORRECTED” stamp on an individual PDF sheet, select that 

stamp from the CTDOT As-Built Tools tool box and place it in the lower right-hand 

corner of the sheet, by clicking once. 

If the majority of the sheets contain as-built revisions it is easier to apply this note to every 
sheet included in plan set, including sheets that do not contain as-built revisions, and then go 
back and replace it, with the appropriate stamp, on the sheets that were not corrected.  
 
 

1. To place the “THIS SHEET CORRECTED” stamp on the entire plan set, select that stamp 

from the CTDOT As Built Tools tool box and place it in the lower right-hand corner of the 

first sheet in the plan set: 

2. NOTE:  You must go back and replace this note on the sheets that do not contain as-
built revisions with the “THIS SHEET NOT CORRECTED” stamp.  

 

5.3.4 Applying Digital As-Built Notes 
To place an as-built revision, simply select any of the provided tools located within the as-built 
tool box shown below and apply it to the document that is being as-built.   
 
 

 

Figure 101 - As-Built Tools 
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In the following example, the Line tool was used to cross out the existing text and the Text Box 
tool was used to add text:  

 

Figure 102 - As-Built Note Example 

 
 
 
Additional tools are available by selecting Markup: 

 

Figure 103 - Other Markup Tools 

These tools include: 

 

           A    B     C     D    E     F     G           H       I      J      K    L    M     N    O     P     Q     R 

List of Commenting Tools: 

A. Text – commonly used tool for as-builts 

B. Typewriter – Do Not Use for As-Builts – cannot edit text 

C. Note - Do Not Use for As-Builts – will not print 

D. Flag  

E. Pen 

F. Highlight 

G. Eraser - Do Not Use for As-Builts – cannot edit graphics 

H. Line– commonly used tool for as-builts 

I. Arrow– commonly used tool for as-builts 

J. Arc 

K. Polyline 

L. Callout– commonly used tool for as-builts 

M. Dimension  
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N. Box 

O. Circle 

P. Polygon 

Q. Cloud – Do Not Use for As-Builts - this may be confused with change orders or 
addendums 

R. Picture – Pictures can be inserted into a document or attached.  It is 
reccommended that pictures be attached  as not to obstruct any part of the pdf. 

Do not add a note to a comment by double clicking on the comment.  For example, if a line 
was placed the user could double click on the line and add notes to it: 

 

Figure 104 - Incorect Way to Add Text 

 If notes are added this way they do not print.  

5.3.4.1 Digital As-Built Stamps and Notes Using 
ADOBE 

The following stamp files need to be downloaded to the user’s computer and placed in this 
folder:  
C:\Documents and Settings\User\Application Data\Adobe\Acrobat\8.0\Stamps\.  This could be 
either C:\ or D:\ Drive depending on your computer. With the “User” folder being the current 
user’s login Username.  If Acrobat version 9 is being used, replace 8.0 with 9.0 in the previous 
sentence, if version 10  is used replace with 10.   
Stamp Files 
As-Built stamps.pdf  
Construction started and completed dates.pdf 
 
These stamps are to be placed following Section 5.3 above. 
 
As-Built notes shall be placed on the plans in accordance with Section 5.3 using the Adobe 
commenting tools in the following format: 

1. Text Font shall be Cambria 16, and the color Red. 

2. All line work shall be line width 2 and the color Red. 

 

 

 

 

 

http://www.ct.gov/dot/lib/dot/documents/aec/as-builtstamps.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/constructionstartedandcompleteddates.pdf
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5.3.5 Additional As-Built Information  
Additional As-Built Information that cannot be applied to the contract plans can be uploaded to 
Projectwise for future use.  This information shall be uploaded to Projectwise in accordance with 
the following: 

 Combine the additional As-Built information into (1) PDF for each discipline subset.  
For example if the 03-Highway and the 04-Structures set had additional As-Built 
information, 2 separate PDFs would need to be uploaded to Projectwise.   

 After the additional As-Built information is combined into their respective files they 
will need to be uploaded and attributed into Projectwise in accordance with the 
following: 

a. Log into Projectwise Explorer. 
b. Make sure the Interface “CTDOT_Doc_Code” is selected. 
c. Drag and drop the PDF into the 100 Contract Plans folder in Projectwise. 
d. Select the advanced wizard. 
e. Click next until you get to the attributes page shown below and assign the 

following attributes: 

 Discipline = CT 

 Main Category = CON 

 Sub-Category = ASB 

 Label = Subset No. and name, for example for the 03-Highway set 
type 03-Highways. 

 Description = Additional As-Built information for…. 

 

Figure 105 - Additional As-Built Information 

f. Then click next until the document uploads.   
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5.4 Notifications 

5.4.1 Notifying Department Personnel 
After the as-built information has been completed, the person responsible for the as-built 
revisions shall notify the appropriate Department personnel (via e-mail): 

 Lead Designer 

 Chief Inspector 

 Central Surveys 

 ROW 

 Central Construction 

 Bridge Maintenance (if a structure is on the project)  

 Mathew Calkins and Julie Annino – AEC Applications  Email Mathew Calkins 
and Julie Annino 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

mailto:mathew.calkins@ct.gov;%20julie.annino@ct.gov?subject=As-Builts%20Completed
mailto:mathew.calkins@ct.gov;%20julie.annino@ct.gov?subject=As-Builts%20Completed
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 Contractor Submittals Section 6

This section details how various contractor submittals shall be formatted, submitted, and 
reviewed by CTDOT for projects that are not using a Document Control Software such as 
SharePoint or Primavera Contract Manager. 
 
The contractor submittals that are detailed in this section are as follows: 

 Working Drawings for Permanent Structures 

 Working Drawings for Temporary Structures 

 Shop Drawings 

 Product Data 

 Submittals 

 RFIs 

 RFCs 
 
The following workflows take advantage of Bluebeam and CTDOT’s Projectwise site, which allow 
the Contractor and CTDOT to collaborate on the Contractor Submittals in a centralized location.  
Projectwise also allows the Contractor to access the Department’s comments quickly after the 
submittals are reviewed.   
 

Contractor Requirements 
The Contractor requirements for this procedure are as follows: 

 Purchase a license of Blubeam REVU or Extreme.  This can be purchased from 
www.bluebeam.com or various resellers.  

 All submittals that require a PE Stamp are required to be digitally signed using an ADOBE 
CDS or AATL Signature, see section 2 of this manual for more information.  

 Upload all submittals into CTDOT’s Projectwise Site.  Fill out the following form to have a 
CTDOT Projectwise username and password set up for your company: CTDOT 
Projectwise New User Form 

 The Contractor’s instructions for this procedure can be found here: Contractor Submittal 
Instructions   

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.bluebeam.com/
http://www.ct.gov/dot/lib/dot/documents/aec/ProjectWise_New_User_Form.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/ProjectWise_New_User_Form.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/contractor_submittal_instructions.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/contractor_submittal_instructions.pdf
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6.1 Workflows 
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6.2 Contractor Submittal Review Process 
(CTDOT/Consultant) 

CTDOT/Consultant shall review the contractor submittals using Bluebeam as follows.  Before 
starting a review make sure you have downloaded the CTDOT Bluebeam profile.  This profile 
contains all the markup tools as well as the submittal stamp that needs to be applied to all 
contractor submittals.    
 
CTDOT Newington Employees – The profile is located on the X:// Drive in the V8 
Admin>Bluebeam Resources>Settings folder.  Just double click on the file called CTDOT 
Bluebeam User.   
 
CTDOT District Construction Employees – Save this file to your desktop and then double click on 
it: Bluebeam Profile 
 
Outside Consultants/Designers – A custom stamp must be created that includes your 
company’s information.  See Appendix D of this manual to download and edit the stamp for 
your firm.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.ct.gov/dot/lib/dot/documents/aec/ctdot_bluebeam_user_profile.zip
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6.2.1 Contractor Submittal Review 
CTDOT or Consultant Review 
The following shows how to review a contractor submittal.  The figures show a shop drawing 
submittal but the procedures are the same for a Shop Drawing, Working Drawing, or Product 
Data submittals.   

1. Log into Projectwise. 

2. Browse out to your project and open the 120_Contractor Submittal folder of that 

project.   

3. Then change the state of the submittal to be reviewed to REVIEWING.  To do this right 

click on the submittal, select Change State, and then Next.   

 

Figure 106 - Changing the State of the Submittal 

4. Then double click on the contractor submittal file to open and check out the file. 
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5. When the submittal opens, you should see the submittal cover letter followed by the 

shop drawings, working drawings, calculation and supporting documents, or Product 

Data Documents as shown below:  The following shows a shop drawing submittal but 

the procedure is the same for a Working Drawing or Product Data submittal.  

 

Figure 107 - Example of a Submittal 

6. To review the drawings/document double click on one of the files to open it.  A new tab 

will open as shown below.  Markup the drawings/document with comments using the 

markup tools located in the tool chest shown below.   

 

Figure 108 – Shop/Working Drawing Review Tools 
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Submittal Review Stamp 
7. For CTDOT employees the submittal review stamp is located in the tool chest in 

Bluebeam and should be placed on an open area of the drawing.  For Consultants 

Appendix D must be followed before their stamp is located in the tool chest.   

8. To place the stamp, left click on the stamp in the tool chest and then place it.   

 

Figure 109 - Placing Submittal Stamp 

9. Next select the appropriate option from the java script window.   

 

Figure 110 - Submittal Review Stamp 
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10. If the stamp is too big and is covering part of the drawing, resize the stamp by dragging 

a corner as shown below: 

 

Figure 111 - Submittal Review Stamp 

The stamp is now resized as shown below: 

 

Figure 112 - Resized Stamp 
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11. After the review is completed, close the file and click yes to save. 

 

Figure 113 - Saving the Shop Drawing 

12. Repeat the review process for the each drawing/document in the submittal. 
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13. After all the drawings/documents in the contractor submittal has been review, 

download the Contractor Submittal Response form:  Click for Form  

14. Then add the response form to the submittal as shown below: 

 

Figure 114 - Submittal Response Form 

15. Next open the form, fill out the general information part, and then fill in a response.  

 Shop Drawings, Product Data, or Other Submittal Types - Only the top designer 

response will need to be filled out.  Then the Designer can digitally sign the response 

form.     

 Working Drawings for Permanent Structures – The Designer shall fill in the general 

information part and then the top designer response portion.  If another design unit 

needs to review this submittal, notify that design unit and include a link to the 

document.  After the Designer(s) has finished their review, they shall notify 

Construction.  Then Construction shall open up the file, fill in a response in their 

area and then digitally sign the response form.    

 Working Drawings for Temporary Structures – For submittals that do not require a 

design review, Construction shall fill out the general information part of the form, 

fill in a response, and then digitally sign the form.  If the submittal requires a design 

review follow the same procedure as a Working Drawing for Permanent Structure. 

 

 

 

 

 

 

 

http://www.ct.gov/dot/lib/dot/documents/aec/00-contractor_submittal_response_form.pdf
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16. After filling out the response form, save the file and close Bluebeam.  Then check the 

document back into Projectwise by clicking on Check In in the Check In dialog box as 

shown below: 

 

Figure 115 - Check In Dialog 

17. Then change the state of the submittal to CLOSED.  The state shall be changed by the 

group that digitally signs the response form.   

Typical Workflows 

Shop Drawings, Product Data, or Other Types of Submittals - Shall have the state changed 

by the Engineer. 

Working Drawing - Shall have the state changed by District Construction. 

To change the state, follow the figures below: 

 

Figure 116 – Changing the State of a Document 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued 04-2016 120 Version 3.13 
     

 

Figure 117 - Changing the State 

18. For Shop Drawings, Product Data, or Other types of Submittals, the Designer shall send 

an email notification to the Contractor stating their review is complete.  For Working 

Drawings, District Construction shall send an email notification to the Contractor.  
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 Digital Review and Commenting Section 7

This section details the digital review process using Bluebeam’s collaborative online review tool 
called “Studio”.  The procedures outlined below describe how to:  1) Create a review session, 2) 
Invite people to a session, 3) Join a session, 4)  Comment in a session, 5)  Close the session, and 
6) Respond to comments made in the session. Also, directions for locking the documents after 
the review process to create a read-only final record copy to be stored for future use are also 
provided. 
 
The following video gives an overview of the Digital Review Process: Digital Review Video.  
Specific details are found in this document  
 
Connecticut Department Engineering Directive 2015-4-E, implemented this procedure. 

7.1 Introduction 
A digital review is when a document is reviewed in its native digital format or as a digital copy of 
the original paper document.  Any required markups are placed directly on the document using 
a computer with software designed for managing digital reviews.  The documents can also be 
printed from the review session and the paper copy marked up; however, those markups must 
get transferred back to the digital copy.   
Advantages of a Digital Review Compared to Conventional Paper Review 

1. Higher Transparency – Increased Collaboration. 
2. Digital markups are searchable and sortable, by comment, author, etc. 
3. Real time collaboration review process improves turnaround time and quality of the 

review. 
4. Real time feedback allows easier handling of large amounts of data. 
5. Reduces the time required to compile and resolve comments.  
6. Eliminates document mailing time.  
7. Reduces document printing. 
8. Eliminates shipping cost. 
9. Easily store a permanent digital record on the cloud. 
10. Overall reduction in review time. 

 
Types of Reviews: 
This manual may be used as a guide to perform a digital document review on any digital 
document. Below is a list of examples of the types of documents that may be reviewed: 

 Preliminary Design Plans 

 Structure Type Studies 

 Semi-Final Plans 

 Final Plans for Review 

 Specifications 

 Engineering Reports 
Review Process: 
To help participants of a digital review more easily track the digital review process it has been 
split up into six Phases as listed below: 

 Phase 1 – Preparation of the Digital Documents  

 Phase 2 – Set Up Digital Review 

 Phase 3 – Invite Attendees to Review 

 Phase 4 – Digital Review 

 Phase 5 – Ending the Digital Review 

 Phase 6 – Resolve Comments 

http://www.ct.gov/dot/lib/dot/documents/aec/Digital_Review_Video.html
http://www.ct.gov/dot/lib/dot/documents/aec/2015-4-E.pdf
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Each phase and its required steps will be discussed later in detail. 
Digital Comments: 
In this review process, all comments must be applied to the documents in the review session.  
Reviewers have the ability to print the digital review documents to paper and mark them up, 
however, when done, all must be transferred from paper to the digital documents, see Section 
7.7.3.  If a unit cannot print their own paper copies they should contact MaryAnn Cass by email 
MaryAnn.Cass@ct.gov.  In the email include the project number and list documents that need to 
be printed, and include the address of where they are to be mailed.  In the case of preliminary 
contract plan reviews, the original digital documents, with comments, will become the final 
record.   
 
All comments associated with a design submission should be applied to the digital documents.  
Telephone of email comments must be applied to the correct digital document by the staff 
member who received them.  Be sure to use engineering judgment to determine the most 
appropriate location for the comments in the document.  General project comments can be 
placed on the first sheet of the document using the note markup tool in Bluebeam. This process 
is detailed in Section 7.7.3.  If any outside entities (railroads or utilities) will not participate in the 
digital review, their comments with your responses should be attached to the final record copy 
in accordance with Section 7.7.3.  It is not necessary to transpose these comments individually 
as all comments can be attached at one time.    
 
FOI Requests 
Contract Document Digital Reviews - After a digital review session has been completed and all 
the comments have been resolved, a read-only copy of the review documents with the 
comments and resolutions will be stored in the 310_Review Documents folder under the 
project.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:MaryAnn.Cass@ct.gov
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7.2 Prerequisites 
1. CTDOT has standardized its digital review process using the document format PDF, and 

the software Bluebeam.   This software was chosen for the following reasons: 
a. Includes a collaborative live review feature (STUDIO) with real time feedback, 

enabling all reviewers to comment on the same document at the same time out 
on the cloud.     

b. A license for Bluebeam is more cost effective than competitive software like 
Adobe Acrobat.  Thus it is much less expensive to purchase and maintain.  

c. Only the Organizer of the review is required to have a licensed copy of 
Bluebeam. All other attendees can participate in the digital review using 
Bluebeam’s free version, Bluebeam VU. 

d. Bluebeam is integrated with ProjectWise. This simplifies the delivery of the 
original review documents as well as saves the final reviewed copies and their 
comments. 

2. The following table lists the software required to organize and/or participate in a CTDOT 
digital review.  Note:  It is recommended that the latest version of the software be used.  

Role Software 
Organizer – Manages review Bluebeam  Extreme or Revu Standard  and Projectwise Explorer 

Author – Produces documents Projectwise Explorer  

Reviewer – Reviews documents Bluebeam  Extreme or Revu Standard or Bluebeam VU* 
*Bluebeam VU is a free viewer that allows reviewers to participate in a digital review (NOT create/organize a review).  
When a staff or consultant is invited to a digital review and they do not have Bluebeam VU or a licensed copy of 
Bluebeam Revu Standard installed on their computer, a link to download Bluebeam VU will be included with the 
invitation.  Note:  An IT administrator may have to install this software on the computer.  

3. All CTDOT digital review participants are required to complete the steps provided in 
Appendix A prior to organizing or joining a review session.  Completing these steps will 
standardize the Bluebeam format across all CTDOT digital reviews.     
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7.3 Digital Review Workflow 

 

Figure 118 

All CTDOT digital review participants are required to complete the steps provided in Appendix 
A prior to organizing or joining a review session.  Completing these steps will standardize the 
Bluebeam format across all CTDOT digital reviews.     
 
Roles 
Organizer – The organizer sets up and coordinates the review session.  For in-house projects this 
would be the project lead and for consultant jobs this will be the Consultant Liaison.  
Author – Group that produces a document(s) for the review. 
Reviewer – Group that participates in the review session to review documents.   
 

Step Role Task Section  

Phase 1 – Preparation and Delivery of the Digital Documents 
1.1 Organizer Coordinate the organization and preparation of the review 

documents.  Request all Authors to upload their review 
documents into Projectwise. 

Section 7.4 

1.2 Author Prepare and upload review documents into Projectwise.  
Notify the Organizer that this step has been completed.   

Section 7.4 

1.3 Organizer Check that all review documents have been prepared and 
uploaded correctly into Projectwise. 

Section 7.4 

Phase 2 – Set up Digital Review 
2.1 Organizer Change the state of the review documents in Projectwise to 

“Review” and then start a Bluebeam review session. 
Section 7.5 

Phase 3 – Invitation to Review  
3.1 Organizer Create a Digital Review memo, which includes a link to the 

digital review session, and send it to all Reviewers. 
Section 7.6 

Phase 4 – Digital Review 

4.1 Reviewer Join the review session by clicking on the link provided in the 
review memo.  Become familiar with the review session 
layout.   

Section 7.7.1 and 
Section 7.7.2 

4.2 Reviewer Set Status to “Reviewing” Section 7.7.3 

4.3 Reviewer  Review the documents in the Bluebeam review session and 
place comments on documents as necessary.   Documents 
can be printed, marked up, and then comments transferred 
the PDFs.  If the documents cannot be printed out, send a 
request to engineering records.  

Section 7.7.3 

4.4 Reviewer When finished reviewing, in Bluebeam, Set Status to 
“Finished”  

Section 7.7.3 

4.5 Reviewer Send a Review Comment Memo to the Review Organizer Section 7.7.3 
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Phase 5– Closing the Digital Review 

5.1 Organizer Close the Bluebeam review session and check the 
documents back into Projectwise. 

Section 7.8 

Phase 6 – Resolve Comments 
6.1 Organizer Notify the Authors that they can review the markups on 

their review documents in Projectwise.  Provide them with a 
link to the folder in Projectwise.  

Section 7. 9.1 

6.2 Author Open the specific document(s) from Projectwise.   Section 7.9.2 

6.3 Author For each comment on your document, type a final 
resolution.   

Section 7.9.2 

6.4 Author After all resolutions are applied to comments, Notify the 
Organizer that you applied your resolutions.   

 

6.5 Organizer Change the state of the review documents to “Review 
Complete” to make all review documents read only after the 
resolutions have been applied.    

Section 7.10 

6.6 Organizer Send out a Completion of Review Session Memo to all the 
personnel associated with the review session that the all 
comments have been resolved on the documents located in 
Projectwise.   

Section 7.10 

7.4 Phase 1 – Digital Document Preparation 

7.4.1 Organization 

Below are the guidelines by which the review documents should be organized: 

Preliminary Contract Document Reviews – PD, SF, FPFR, etc. 

1. Plans - Must be in discipline subsets.  The review Organizer is responsible for assigning 
each Author a subset number in accordance with Section 1.10 or Section 1.11 Note:  
CTDOT Standard Subsets cannot be added to a review session because they are 
combined in a PDF Package (Portfolio).  

2. Specifications – Each discipline shall combine all of their specifications into one (1) PDF 
document.  Each discipline’s specifications will remain separate throughout the review 
session; they will not be combined with the other discipline’s specifications.      

3. Other Documents – Shall be individual PDF documents. 
4. All Authors must upload their documents into the 310_Review Document folder under 

the project in Projectwise.  
Other Reviews 

1. The only requirement for the organization of other types of reviews is that the 
documents must be in PDF format.   

7.4.2 Preparation and Format 
Authors shall prepare their digital documents in accordance with the following guidelines: 
Preliminary Contract Document Reviews – PD, SF, FPFR, etc. 

1. Plans: 
a. Must be in PDF format 
b. Plans must be in discipline subsets 
c. Plans must be sized 34” x 22” 
d. Do not need watermarks, sheet numbers or to be digitally signed. 

2. Specifications: 
a. Each discipline shall combine all of their specifications for review into one (1) 

PDF document. 
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b. Sized 8.5” x 11” 
3. Other Documents: 

a. Must be in PDF Format 

Other Reviews 

1. Documents: 
a. Must be in PDF Format 

7.4.3 Uploading Digital Documents 
Authors shall upload their digital documents into Projectwise in accordance with the following: 
For Preliminary Contract Document Reviews – PD, SF, FPFR, etc. 

1. Launch Projectwise and log in. 
2. Browse out to the project this review is for and open up the 310_Review_Documents 

folder and the specific review folder:  If the three subfolders are not in the project 
contact Mathew.Calkins@ct.gov  

 

Figure 119 - Projectwise Project 

 
 
 

mailto:Mathew.Calkins@ct.gov


 Connecticut Department of Transportation – Digital Project Development Manual

Issued 04-2016 127 Version 3.13 
     

 

3. Make sure the “CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a 
time into Projectwise as shown below:   

Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface.  Then 
you will be able to select the correct Interface.  

 

Figure 120 - Uploading Documents into Projectwise 

4. Select Advanced Wizard 

 

Figure 121 - Advanced Wizard 
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5. Click next until the attributes screen appears as shown below.  Enter the correct 
attributes from Table 2 below, and then click next until the document uploads.   

 

Figure 122 - Attributing a Document 

The Label attribute must start out with 30%, 60%, 90%, or 100% where applicable.  This allows 
for the documents to be sorted together in Projectwise.  Below are some examples: 
 

 Document Attributes 

Document Disc. Main 
Category 

Sub 
Category 

Label Description 

Discipline 
Subsets 

CT CON PRE 
30% - 01-General, 30% - 03-Highways, etc. 
60% - 01-General, 60% - 03-Highways, etc. 
90% - 01-General, 90% - 03-Highways, etc 

01-General Semi Final Plans… 

Specification CT CON PRE 
30% - HWY- Specs, 30% - SB-Specs 
60% - HWY- Specs, 60% - SB-Specs 

Highway Semi Final Specs,  

PD Statement CT REPORT Reports  30% - PD Statement Preliminary Design Statement 

Cost Estimate CT CALCS Estimates 90% - Cost PD Cost Estimate 

Bike 
Assessment 

CT ANALYSIS Analysis 30% - Bike Assessment i.e.  PD Bike Assessment 

Calendar Day 
Est. 

CT CALCS Estimates 90% - Calendar Day i.e. SF Calendar Day Esitmate 

Table 2 - Projectwise Document Attributes 
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For Other Reviews 

1. Launch Projectwise and log in. 
2. Browse to the folder where the digital documents are to be stored. 
3. Make sure the “CTDOT_Doc_Code” Interface is selected and drag your file(s) one at a 

time into Projectwise as shown below:   

Note: If the interface box is not displayed, go to the menu View>Toolbars>Interface.  Then 
you will be able to select the correct Interface.  

 

 

Figure 123 - Uploading Documents into Projectwise 

4. Select Advanced Wizard 

 

Figure 124 - Advanced Wizard 
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5. Click Next until the attribute screen appears shown below. Enter the correct attributes 
for the review documents and then click next until the document uploads.   Make sure a 
good label and description are entered.   

 

Figure 125 - Uploading Documents 

6. Notify the Organizer that the documents have been uploaded into Projectwise. 
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7.5 Phase 2 – Set Up Digital Review 
The Organizer shall set up the review session in accordance with the following:  Note: The 
example below is for initiating a Semi-Final review but can be followed for other types of 
reviews.     

1. Launch Projectwise Explorer from the shortcut on your desktop or the start menu.   
2. Browse out to the project’s 310_Review_Documents folder. (For other reviews browse 

out to the folder in Projectwise where the documents are located.  Note:  The document 
does not need to be in Projectwise to use Bluebeam’s Studio feature.)  

 

Figure 126 - Preliminary Design Documents Folder 

3. Select all the documents to be included in the Bluebeam review session. 

 

Figure 127 - Select Documents to be Included in Bluebeam Review Session 
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4. Change the state of the documents to “Review” as shown below: 

 

Figure 128 - Changing the State to Review 

Then click OK next on the box that pops up.  The documents will now be in the Review 
state. 

 

Figure 129 - State of Documents 
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5. Next right click on the selected documents and select Start Studio Session: 

 

Figure 130 - Start Studio Session 
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6. Using the naming guidelines from the table below, type in the applicable review session 
name in the box entitled “Session Name”. 

Review Review Name 

Preliminary Design (30%) Project #XXXX-XXXX PD Review 

Structure Type Study Project #XXXX-XXXX Structure Type Study Review 

Semi-Final (60%) Project #XXXX-XXXX SF Review 

Final Plans for Review (90%) Project #XXXX-XXXX FPFR Review 

Other Include Project number if necessary and give a good description 
of the review 

 
Also, as shown in the figure below, make sure that all the options are checked.  Note:  Setting 
the Session Expires date is optional.  If set, this date can always be changed after the session is 
created.  
 

 
 

Figure 131 – Initiating a Review Session  
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7. In the next dialog box click copy invitation as shown below.  The invitation will be copied 
to the clipboard of the computer and then can be pasted into an email or memo.   

 

 

Figure 132 - Adding Email Address to Studio Session 

Next paste the invitation into a blank Word Document or email.  The following is an invitation 
that has been pasted into an email.  Note how the session URL appears in blue. Then you can 
copy the URL from the blank document or email into a formal memo.  

 

Figure 133 - Session URL 
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7.6 Phase 3 – Invitation to Review Session 
The Organizer shall invite Reviewers to the review session in accordance with the following: 
For Preliminary Contract Document Reviews – PD, SF, FPFR, etc. 
 
The invitation to the digital review will be a PDF version of a review memorandum that includes 
the following:   

1. A table of all documents that are in the review session.  
2. Links to relevant documents that are not included in the review session but still need to 

be referenced.  These documents shall be located in Projectwise and Projectwise links 
shall be included. (Not shown in the example below) 

3. A link to this manual (Digital Project Development Manual) 
4. A link to the Review session.  To do this, paste the invitation that was copied when you 

created the review session.     

The PDF of the review memorandum shall be emailed to all Reviewers; this should include the 
Principal, Supervisor and TE3 level of the reviewing unit where applicable.  It is the Organizer’s 
responsibility to compile a complete distribution list so the review invitation gets sent to the 
applicable personnel.   Below is an example of a memorandum for a preliminary design review: 
 

 

Figure 134 - Sample Review Memo 

The Organizer shall also send out a reminder notification to all the reviewers two weeks prior to 
the end of the review session.   
 
For Other Reviews 
Invitations for less formal reviews may not require a memo.  It is recommended that an email be 
sent which includes the links to this manual and the review session. 
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7.7 Phase 4 – Digital Review 

7.7.1 Joining a Review Session 
To join a review session, either click on the link provided in the review memorandum for a 
preliminary design review, or for less formal reviews, click on the link in the email.  Below is an 
example of an email for a preliminary design review (semi-final).  Remember the link to the 
review session is included in the memo that was emailed to all the reviewers.   

1. Open the email from the Organizer and open the review memorandum. 

 

Figure 135 - Review Memorandum 
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2. Click on the link to the Review Session. 

 

Figure 136 - Link to the Review Session 
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3. Click Allow on the box that pops up in Internet Explorer.  Ignore the text written in the 
webpage as shown below:   

 

Figure 137 - Accessing the Review Session 

4. Bluebeam will now launch.  If this is the first time in a review session, a Studio Account 
must be created.  To do so click on Create Account and then enter in a State email 
address and a password.  In the Name box type in the First Initial then Last name and 
unit.  See below for an example.    

 

 

Figure 138 - Creating a Studio Account 

  

Figure 139 - Studio Session Account 
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If this is not the first time in a review session, enter the studio login information as shown 
below:  If you forgot your password click lost password and an email will be sent to you.   

 

Figure 140 - Review Session 

5. If this is your first time into a review session you must import the CTDOT Bluebeam 
Profile, See Appendix A  
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7.7.2 Review Session Layout 
Below is the typical layout in the review session.  On the right tab, there are the tool chest for 
commenting, the attendees of the session, and the documents in the session.  On the bottom, 
there are the list of comments.   

 

Figure 141 - Review Session Layout 

All comments that are made get saved instantly to the Bluebeam review session; these do not 
need to be manually saved.  Each user can only delete their own comments and can leave and 
rejoin as many times as they want as long as the review session has not been closed.  The review 
session will be closed by the Organizer in accordance with the date on the review memo.  
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7.7.3 Reviewing 
This section shows the procedures for reviewing and commenting on documents in a digital 
review.  Reviewers may print digital review documents to paper by going to File>Print and mark 
them up; however, they must transfer these comments onto the digital review documents in 
accordance with this section.  If a unit cannot print their own paper copies they should contact 
MaryAnn Cass by email MaryAnn.Cass@ct.gov.  In the email include the project number and list 
documents that need to be printed, and included the address of where they are to be mailed.      
 
In the case of preliminary contract plan reviews, the original digital documents, with comments, 
will become the final record.   
 
All comments associated with a design submission should be applied to the digital documents, 
including any email or phone call comments.  These types of comments must be applied, by the 
staff member who received the email or phone call, to the correct digital document, use 
engineering judgment to determine the most appropriate location.   
 
General Project wide comments can be placed on the first sheet of the document using the note 
markup tool in Bluebeam as shown below:  Using the note tool you can copy and paste text 
from any source such as an email or a Word document.  This allows larger project wide 
comments to be applied to the plans.    

 

Figure 142 - Note Markup Tool 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:MaryAnn.Cass@ct.gov
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Note about Commenting in a Review Session and Supervisor Approvals  
In most cases, the unit that reviews a document has an internal approval process whereby the 
supervisor finalizes the comments from staff members.  The workflow described in this Chapter 
does not specify or dictate an approval process within each unit; rather, it outlines the review 
procedures once the review comments have been compiled from each unit.    Therefore, it is 
important that only the reviewing unit’s final comments be added to the review session.  Once 
the session ends, the comments made in a review session will be considered final.    
 
The following shows a few options for a supervisor approval procedure, but the digital review 
process is flexible for any procedure a reviewing unit develops.  The only restriction is the final 
comments must be placed on the digital documents located in the review session before the 
reviews session ends:   
 

1. A lower level employee can join the session and comment on the documents in the 
review session.  Then the supervisor can join the session and filter out their 
subordinates comments for their review.  If there is an issue with a comment the 
supervisor will have to direct the lower level employee to fix that comment. If there are 
not any issues with the lower level employee’s comments then nothing has to be fixed.  
After this supervisor review, a lower level employee will join the session and fix the 
applicable comments.  In section 7.1 of this manual there is a list of advantages to using 
this digital review process.  With this option, all of these advantages are realized.         
 

2. A lower level employee can join the review session and save a copy of the review 
documents to their computer.  Then they can markup the documents offline and have 
their supervisor approve those comments.  After the supervisor approves the 
comments, those comments can then be imported into the documents in the review 
session. In section 7.1 of this manual there are a number of advantages to this digital 
review process.  With this option, advantages 3 and 4 are eliminated due to the 
comments made offline.     
 

3. A lower level employee can join the session and print the documents in that review 
session.  Then they can markup the prints and have their supervisor approve the 
comments.  After the approval, a lower level employee can transfer the comments to 
the digital documents in the review session.  In section 7.1 of this manual there is a list 
of advantages to this digital review process.  With this option, advantages 3 and 4 are 
eliminated due to the comments made offline.     

 
Notes about Outside Entities that will not Participate in a Digital Review 
If an outside entity such as a railroad or utility company will not participate in a digital review it 
is still important to add their comments to the final record document in Projectwise.  It is 
encouraged to have these entities participate in the digital review and AEC Applications is 
available to provide support and technical assistance in these efforts.   
 
The following details how the comments from a non-participating entity and your responses to 
those comments shall be attached to the final record document in Projectwise: 

1. Create a PDF document that includes the non-participating outside entity’s comments 
and your responses to those comments.   

2. Then add the pages from that document to the end of the final record document in 
Projectwise in accordance with section 7.9.1.    
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Reviewer 

1. First set your review status to Reviewing by clicking on the drop down shown below: 

Note: If you leave the session and return your status will stay as Reviewing.   

  

Figure 143 - Set Status to Reviewing 

2. Next select a document to review from the studio session tab.  The document will open 
up and can be reviewed.  

 

Figure 144 - Selecting a Document to Comment On 
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3. Select a commenting tool from the tool chest and mark up the plans.  If you do not have 
the CTDOT Review Tools show below, follow Appendix A  to have them imported in the 
Bluebeam Profile. Below are the commenting tools a CTDOT user will have available to 
them in Bluebeam.   

 

Figure 145 - Bluebeam Commenting Tools 

Custom tools can also be created.  Contact DOT.AECApplications@ct.gov for custom tool 
development.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:DOT.AECApplications@ct.gov
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MUST READ BEFORE PLACING COMMENTS 
The following shows best practice for applying text notes in a review session.       
 
There are two basic commenting tools in Bluebeam: Text Tools and Non-Text Tools (line, arrow, 
cloud, rectangle, etc.).  Each type can have a note attached to them.  The text tools already have 
a note when you type text, but the non-text tools can also have a note attached to them.  To 
attach a text note to a non-text tool place the comment and then double click on that markup.  
Then you can type in your note.  The text note box must be closed after the comment is made 
by clicking on the X in the top right corner of the note.  The example below shows a note being 
attached to the cloud tool the correct way:   

 

Figure 146 – Correct Way to Add Text to a Non Text Commenting Tool 

General Project wide comments can be placed on the first sheet of the document using the note 
markup tool located in the tool chest. Text can be copied and pasted into the note tool as 
necessary.  
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4. After you have completed your set your status to Finished. 

Note: You can still enter the session if your status is set to Finished.  You can also change your 
status back to Reviewing if necessary.  This status is for the Organizer so they know which 
Reviewers have completed their reviews.   

 

Figure 147 - Set Review Status 

5. Create a review comment report of your comments.  First filter out the comments so 
only your comments are displayed as shown below: 

 

Figure 148 - Filtering Comments 
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6. Now that the comments are filtered by your name create a comment report as shown 
below: 

 

Figure 149 - Creating a Comment Report 

Next type in a title for the comment report that includes Project No, What review it is plus the 
word “Comments”, and what document this comment report is for.  See below for an example: 
 

Project ####-#### Semi Final Review Comments 03-Highways 
 

Make sure all the settings are set as shown below and click OK: 

 

Figure 150 - Comment Report 
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7. The comment report will now be created and opened in Bluebeam, leave the comment 
report open in Bluebeam.  We will be copying this report into the comment report 
memo. 

8. Next save the following review comment memo to your computer: Review Comment 

Memo. 
9. Open the memo and fill in the correct information. 
10. Then copy all the pages from the comment report as shown below: 

 

Figure 151 - Copying the Comment Report Memo 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.ct.gov/dot/lib/dot/documents/aec/review_comment_memo.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/review_comment_memo.pdf


 Connecticut Department of Transportation – Digital Project Development Manual

Issued 04-2016 150 Version 3.13 
     

11. Then paste the pages into the memo as shown below: 

 

Figure 152 - Pasting the Comment Report Pages 

12. Save the memo and process this memo as your unit requires. 
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7.8 Phase 5 – Closing the Digital Review 
The Organizer will be responsible for closing the review.  The review session will be closed per 
the date on the review memorandum.   

1. Click Finish to close a Bluebeam Review Session as shown below: 

 

Figure 153 - Terminating a Session 

 
 
 
 
 
 
 
 
 
 
 
 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued 04-2016 152 Version 3.13 
     

2. Make sure all the reviewers in the list below are selected (they will be by default) and 
the Save (Overwrite Existing) button is checked and click OK. 

 

Figure 154 - Terminating a Session 

3. Click OK in the figure below. 

 

 

Figure 155 - Overwriting Existing Documents 
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4. Close Bluebeam Revu and check in each document to Projectwise.  Note: A check in box 
will pop up for each document in the review session.   

 

Figure 156 - Checking a Document Into Projectwise 

5. Notify the Document Authors that the session has been closed so they can resolve the 
comments on their documents. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued 04-2016 154 Version 3.13 
     

7.9 Phase 6 – Resolve Comments 
This section shows how the comments from the review session will be resolved by the 
Document Authors.  After the comments have been resolved in the PDF documents located in 
Projectwise the Document Author shall notify the Organizer that they have finished applying 
their resolutions to the documents.   
 
Note:  Comments cannot be resolved until the review session has been finished.  The Review 
Organizer will notify the Document Authors when the session has been finished.  If the 
document authors go into the documents located in Projectwise before the session is finished 
there will be no comments on the documents.   

7.9.1 Resolving Comments 
All comments on the review documents shall be resolved by the Document Author directly on 
the digital PDF review documents using Bluebeam.  The following shows the steps for resolving 
comments. 

1. Open your document(s) from Projectwise.   
2. Next select a comment in the comment list and right click.  The select Reply.   

 

Figure 157 - Comment Resolutions 
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3. In the box that pops up, type in a final resolution in the following format: 

Note: For plan sheets, include “Change Plans” or “No Change to Plans” where necessary.   

Resolution – Type in resolution...No Change to Plans 
 
The resolutions applied to the plans shall be the final resolution decided by the Document 
Author’s unit.  There shall only be one resolution for each comment.   
 
Below is an example of a resolution: 
 
 

 

Figure 158 - Typing in a Resolution 
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Below is an example of how the resolutions will look in the comment list. 

 

Figure 159 – Resolutions 

4. Next attach a PDF document that includes any non-participating entities comments with 
your responses to the review document.  This should be done by adding that PDF 
document to the end of the review document as shown below: 

 

Figure 160 - Attaching Comments 
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5. Browse out to the PDF document you want to add and then select to insert after the last 
page: 

 

Figure 161 - Adding Comments 

6. When all the resolutions have been applied, make sure to save the documents and 
check them back into Projectwise.  

7. Notify the Review Organizer that you have completed your resolutions.   
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7.10 Locking the Review Documents after the Review 
The Organizer shall change the state of the documents to make them document read-only after 
the resolutions have been applied to the review documents.   
 
To make the documents read-only, change the state of the documents in Projectwise to “Review 
Completed” as shown below: 

1. Select the document(s) and change the state of the documents to “Review Completed” 
as shown below: 

 

Figure 162 - Changing the State to Review 

 

 

Figure 163 - Review Complete State 
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2. Then right click on all the documents again and select Change State > Set Final Status.  
This will lock the documents.   

 

Figure 164 - Setting Final Status 

3. Send out Completion of Review Memo to all the personnel associated with the review 
session indicating that the review session is over and all comments have been resolved 
on the documents in Projectwise.  Create a comment report of all the comments from 
each review document and include that in the memo.  Link to: Completion of Design 
Review Memo 

 
 
 
 
 

http://www.ct.gov/dot/lib/dot/documents/aec/Completion_of_Design_Review_Memo.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/Completion_of_Design_Review_Memo.pdf
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 Design Phase Project Scheduling  Section 8

A directive was issued to establish protocols and minimum requirements for design-phase 
scheduling.  Link to Directive:  2015-8-E. The Project Management group within the AEC 
Application’s unit in cooperation with engineers from several engineering divisions, are 
facilitating the implementation, training, maintenance, and evolution of the Scheduling 
Directive.  
 
An Engineering working group evaluated several scheduling software options to support the 
mission statement. Microsoft Project 2010 was selected because it offers the following features 
and advantages: 

 Accommodates any number of milestones and tasks (i.e., easily scalable), 

 Graphically displays series and parallel tasks, 

 Provides baseline and tracking Gantt charts, 

 Displays the critical path, 

 Ability to link notes and documents, and 

 Interfaces with Outlook, Excel, SharePoint and other Microsoft products. 
 

Microsoft Project 2010 shall be used to develop design phase schedules meeting the following 
minimum requirements: 

1. Includes all the activities identified by the Minimum Requirement Schedule 
Template; more detailed templates and project-specific schedules are encouraged,   

2. Baseline schedule,   
3. Task Indicator columns are used to link applicable instructional and reference 

documents, 
4. Explanations for changes in task durations are added as task notes,  
5. Tracking View/Gantt chart functions are used, 
6. Task-level progress is tracked regularly,  
7. Files are stored in the ProjectWise project container as indicated by the Digital 

Project Development Manual, and 

8. Microsoft Project files are maintained and current, with projected schedules in 

accord with the obligation plan. 

Base templates were developed by a committee that included Engineering Management and 
Subject Matter Experts (SMEs) from each engineering discipline. The Office of Engineering SMEs 
are as follows: 

 Bridge Design – Kevin Blasi and David Gruttadauria 

 Consultant Bridge Design – Derick Lessard and Marc Byrnes 

 Highway Design – Scott Bushee, Jordan Pike, and Vitalij Staroverov 

 Consultant Design State Roads – Nilesh Patel and Meredith Andrews 

 Traffic Projects Design – Barry Schilling and Michael Chachakis  

 Traffic Studies & Safety – Erika Lindeberg,  Daniel Veronesi and Colin Baummer 

 Facilities Design – Eric Feldblum and Jesse Benson 
 
The SMEs are responsible for developing and maintaining division specific project templates and 
corresponding task libraries in ProjectWise. They shall be the first point of contact regarding 
discipline specific template and guidance document inquiries and maintenance.  
 
For questions, suggestions and issues pertaining to Microsoft Project and the Scheduling 
Directive, please contact Bruce Bourgoin (Bruce.Bourgoin@ct.gov) or Nick Langer 
(Nicholas.Langer@ct.gov).  

http://www.ct.gov/dot/lib/dot/documents/aec/2015-8-E.pdf
mailto:Bruce.Bourgoin@ct.gov
mailto:Nicholas.Langer@ct.gov
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The table below details the minimum tasks included in the template: 

Table 3 - List of Minimum Tasks 

Task Name  

Project XXXX-XXXX  

Project Initiation  

 Prepare and Submit PPI  

 Prepare and Approve RPM   

 Secure Funding/Authorization   

Preliminary Design  

 Survey   

 NEPA/CEPA  

 Develop PD through Design Approval  

 Design Approval  

Final Design  

 Prepare Semi-Final Design Submission  

 Prepare Final Design Submission  

ROW Coordination  

 Prepare and Submit Final Accepted Property Maps  

 Acquire Properties  

Permit Acquisition Process  

 Permit A  

o Prepare and Submit Permits to Regulatory Authority  

o Regulatory Authority Review and Issuance of Permit  

 Permit B  

o Prepare and Submit Permits to Regulatory Authority  

o Regulatory Authority Review and Issuance of Permit  

 Permit C  

o Prepare and Submit Permits to Regulatory Authority  

o Regulatory Authority Review and Issuance of Permit  

FDP  

DCD  

ADV 

 
The Minimum Requirement Schedule template is stored in ProjectWise and can be found here: 
AEC Scheduling Documents (Minimum Req) 
 
 
 
 
 
 
 
 
 
 
 
 
 

pw://ctdot.projectwiseonline.com:CTDOT/Documents/04.00%20-%20Engineering%20Libraries/Scheduling%20Directive/AEC%20Scheduling%20Documents%20(Minimum%20Req)/
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8.1 Microsoft Project File Set Up 
The following steps show how to set up a Microsoft Project file:  

1. Open ProjectWise Explorer by going to Start> All Programs> Bentley> ProjectWise 
V8i (SELECT series 4), and click on ProjectWise Explorer as shown below:  

 

Figure 165 – Launching Projectwise 

2. Then double Click on CTDOT and then sign into ProjectWise with your username and 
password.  If this is your first time logging into Projectwise, you will be asked to 
create a working directory, click Yes: 

 

Figure 166 – Logging Into Projectwise 
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3. Browse to Documents>04.00 Engineering Libraries>Scheduling Directive. Select the 
applicable division’s Scheduling Documents folder.  The below example presents 
where the Minimum Requirement Schedule Template is located: 
 

 

Figure 167 - Schedule Templates 

4. Right click on the most applicable template and select Copy  

 

Figure 168 - Copying a MS Project Schedule 

pw://ctdot.projectwiseonline.com:CTDOT/Documents/04.00%20-%20Engineering%20Libraries/Scheduling%20Directive/


 Connecticut Department of Transportation – Digital Project Development Manual

Issued 04-2016 164 Version 3.13 
     

5. The next step is dependent upon if a project is in the Project Initiation Phase or has 
progressed to Preliminary Design Phase.  Project Initiation is typically complete 
when Funding and Authorization is received, and a ProjectWise project container is 
created.  If a ProjectWise container has not been created, contact Julie Annino in 
AEC Applications. 

 
Projects in Project Initiation Phase 
a.  If the project is in Project Initiation the MS Project schedule should be 

pasted to the respective discipline specific Initiation Phase Scheduling 
ProjectWise folder:  

 

 

Figure 169 - Discipline Specific Initiation Phase Scheduling folders 

  Projects in Preliminary Phase 
b. If the project is in preliminary design phase the schedule should be saved to 

the ProjectWise 140_Project Administration folder under the project. 

 

Figure 170 - Project 140_Project Administration Folder 
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6. To paste the project file, right click on the folder and select Paste and then Yes.  

 

Figure 171 - Save schedules to the 140 Project Administration Folder 

7. Then click Advanced Wizard and click OK. 
8. Then click next until you get to the attributes screen shown below, then assign the 

attributes as shown below: 

 

Figure 172 - ProjectWise Attributes 
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9. Then click next until the file uploads.   
10. Next open the project file. 
11. Then click on the File menu, select Info, select the Project Information dropdown 

and then Advanced Properties as shown below: 
 

 

Figure 173 - Setting Advanced Project Properties 

 
12. In the dialogue box that pops up, fill out the information as shown below: 

 

Figure 174 - Project Information 
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13. Next set the project start date by selecting the File menu > select Info, then select 
the date as shown below: 
 

 

Figure 175 - Setting the Start Date 

 

8.2 Basic MS Project Function 
This section presents the following schedule basic terminology and functions:  

 Scheduling Terminology  

 Task Relationships (Predecessors and Successors) 

 Adding , Renaming, Indenting and Deleting a Task 

 Adding/Adjusting Durations 

 Lead and Lag Times 

 Adding Hyperlinks 

 Combining Multiple Projects 
 

8.2.1 Scheduling Terminology 
The most common scheduling view is the Gantt chart view, which illustrates a project schedule 
using task names, durations, start and finish dates on the left, and bar charts presenting these 
dates and durations to the right.  
 

 

Figure 176 - Basic Terms 

Task Indicator Column - Present task Notes and Hyperlinks.  
Milestone - A major schedule date, such as an FDP. 
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Parent Task - Shown as a Grey Bar, signifies it is a Parent Task. Its duration is populated by the 
Child Tasks. 
Critical Path - Shown in Red, signifies the task relationships that control major milestone dates. 
Non-Critical Task -  Shown in Blue, signifies sub-tasks that do not control major milestone dates. 
 

8.2.2 Task Relationships (Predecessor and 
Successors) 

Predecessor is a task which has a start or finish date that affects the start or finish of another 

task.  

Successor is a task which has a start or finish date that is affected by another task.  

There are different ways of defining task relationships, these are  

 Finish-to-Start: This is the default dependency in Microsoft Project in which the successor 

cannot begin until the predecessor is complete. A Finish-to Start task relation is denoted by 

FS, or simply, as the predecessor’s Task ID. A Task ID is found on the column to the far left.  

 

Figure 177 - Finish to Start relation 

 Start-to-Start: The successor cannot begin until the predecessor begins. The successor task 

can start at any time after predecessor begins. Start-to-Start relationship is designated by 

SS. 

 

Figure 178 - Finish to Finish relation 

 Finish-to-Finish: the successor cannot be completed until the predecessor is completed. 

The successor can be completed at any time after the predecessor is completed. Finish-to-

Finish task relation is denoted by FF. 

 

Figure 179 - Start to Finish relation 
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 Start-to-Finish: the successor cannot be completed until the predecessor begins. The 

successor can be completed at any time after the predecessor has started. The Start-to-

Finish task relation is denoted by SF. 

 

Figure 180 - Start to Finish relation 

The schedule should have a Predecessors column where task relationships can be defined. To 

define a task relation, enter the Task ID and the Task Relationship in the associated task’s 

Predecessor Cell. For example, in the Figure below the PPI is a predecessor and the RPM is a 

successor task. The PPI must Finish before the RPM can Start. This relationship is denoted in the 

RPM Process row’s Predecessors cell, as the number 2. The number 2 represents the 

Predecessor’s Task ID. The absence of a task relationship abbreviation means that the relation is 

a Finish-to-Start or FS. A FS is the standard task relationship and therefore the abbreviation is 

not presented, unless it is accompanied by a Lead or Lag time, as discussed in a later section.  

 

 
 

Figure 181 - Linking tasks 

 

If the Predecessors column is not shown in the template, double click in the “Add New Column” 

cell and start typing “predecessor,” and from the short list click on Predecessors to add it to the 

current columns. If Add New Column is not shown right click on any column label and select 

Insert Column and then start typing in Predecessors, as presented below:  
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Figure 182 - Add new column 

 

Figure 183 - Adding predecessor column 

 

8.2.3 Adding, Renaming, Indenting and Deleting a 
Task 

 
Adding a Task  
To add a task, right click on the task which will follow the new task and select Insert Task.  For 

example, to add a new task between NEPA/CEPA and Survey, right click NEPA/CEPA and select 

Insert Task, as shown below: 

 

 

Figure 184 - Adding a Task 
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Renaming a Task 
Tasks can be renamed by double clicking on the task to be edited.  In the pop up window under 
General tab you can edit the task name. (Do Not Rename the Base Template Tasks in Bold)      
  

 

Figure 185 - Renaming a task 

 

Outdenting & Indenting 
Outdenting and Indenting provides schedule customization. Outdenting moves a task to the left 

of the task column and indenting moves a task to the right. Indenting a task makes it a ‘child’ of 

the preceding, outdented ‘Parent’ task. Parent task durations are populated by their 

accumulative child task durations, therefore, parent task durations should not be manually 

entered. To set your task as a child or “sub-task”, select the row you would like to modify and 

click the Indent Button in the main toolbar area shown: 

 

 

Figure 186 - Outdent and indent 

 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued 04-2016 172 Version 3.13 
     

Deleting a Task 
A user may delete, enter zero, or enter any small duration for a task if it is irrelevant.  By 
entering zero for the duration the MS Project will view the task as a milestone, if a report is 
generated the report will present all zero duration tasks as milestones. This may confuse report 
reviewers.  A small duration may push back critical milestone dates. It is therefore 
recommended that project managers manually delete and revise predecessor and successor 
relations, as described below. To delete a task right click on it and select delete task. (Do Not 
Delete the Base Template Tasks in Bold) 

 

Figure 187 - Deleting a task 

When a schedule is started the user should remove tasks that do not relate and estimate all 

other pertinent task durations. It is critical to note if the task being deleted is a predecessor. 

You can determine this by following the lines stemming from a task in the Gantt chart. If a task is 

erroneous and must be deleted, but is also a predecessor for other tasks that should not be 

deleted, the successor task must be corrected.  Failing to update a new predecessor will likely 

disrupt task connectivity.  

For example, if a project does not require a Preliminary Hydraulic Analysis, the step should be 

deleted. However, the Hydraulics Analysis is a predecessor for the ABC Analysis; therefore the 

ABC Analysis’ predecessor task should be updated. In this case the Utility Coordination will be 

the new predecessor. See the task relationship and Gantt chart prior to task deletion: 

 

Figure 188 – Before task deletion table 
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Figure 189 – Before task deletion Gantt chart 

 
See Task relationship and Gantt chart after task deletion: 

 

Figure 190 – Post task deletion and predecessor update table 

 

 

Figure 191 - Post task deletion and predecessor update Gantt chart 

 

After the Hydraulic Analysis has been deleted and the new predecessor has been assigned, MS 
Project automatically reconfigures the schedule to show the new critical path. The critical path is 
shown in red and highlights the task relationships that determine a projects finish date.    
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8.2.4 Adding and Adjusting Durations 
All tasks require duration estimates that may vary as projects progress. To set a duration click 
the Duration Cell to the right of the task and enter the task’s estimated period and the 
applicable unit, as presented below:  

 Mons: for months 

 Wks :  for weeks 

 Days :  for days 

 Hrs:    for hours  

 Mins: for minutes   
 

 

Figure 192 - Adding durations 

 
If the duration unit is already entered, then the duration value may directly entered, without 
including the unit. Do not modify durations for parent tasks. Parent tasks are signified by 
having a gray bar in the Gantt chart area and a maximize/minimize arrow. Parent task durations 
are automatically calculated by their subtask durations.  
 
If a parent duration is manually entered, select the parent task and re-select Auto Schedule. 
This will recalculate the appropriate parent duration, based on its child tasks. See below: 
 

 

Figure 193 - Auto Schedule 

 
 
 
 
 
 
 
 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued 04-2016 175 Version 3.13 
     

8.2.5 Lead and Lag Times 
In defining a task relation, a task may have to be delayed or started early.    

 The Lead time will tend to push your duration and a plus sign is used. 

 The Lag time will tend to shorten your duration and a minus sign is used. 

To add a Lead or Lag time: type in the task relation type, then the predecessor task number, a 
plus or minus, and the amount of delay or early start. 
 

For example, Task 18: DCD, is 6 weeks after task 17: FDP, this can be described as 17FS+6wks 

 
Figure 194 - Task relation 

 

This can also be set by right clicking on a task and selecting Information.  Then go to the 

Predecessors tab as shown below, and enter the predecessor ID or Task Name, the relationship 

type and then a positive duration for a lead time or a negative duration for a lag time in the Lag 

column.  

 

Figure 195 - Task relation in Project Information 

 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued 04-2016 176 Version 3.13 
     

8.2.6 Adding Notes and Hyperlinks to a Task 

Adding Task Notes 

As stated in the Directive: “Explanations for changes in task durations are added as task notes.” 
Notes are reserved to clearly indicate when a specific Project Task duration is adjusted from the 
baseline. The note should be placed in the respective task’s indicator column. The note should 
state: 

 The date of the entry, 

 The person writing the note, 

 Justification for the task duration adjustment and 

 Recommended: Recipient Notification. 

The Recipient Notification list is left up to the Project Managers discretion. The purpose is to 
outline a step where project team members who may be interested or are directly impacted by 
a duration change, are notified. Once a note is drafted and the duration is adjusted, it is 
recommended that a notification email be sent to the relevant recipients and that the 
correspondence is saved to the subject project’s 140_Project Administration folder in 
ProjectWise. The recipients may typically include:  

 AEC’s Project Management Unit –Bruce.Bourgoin@ct.gov or Nicholas.Langer@ct.gov 

 Finance, such as the Office of Capitol Planning. 

 Design Engineers within the Project Manager’s division.  

 The group involved with the duration change or the group affected by the change, if 
applicable. For example, if the 6 month estimated duration for a project survey needs to 
be pushed back, the respective survey supervisor who is involved with the task should 
be included as a recipient in the notification email.  

The purpose of the recipient list is to improve communication between units and to harvest 
project data. Meaning, AEC will collect a repository of duration change notes in order to 
continuously reevaluate and improve schedule templates.  
 
To add a note right click on a task and select Notes… as shown below: 
 

 
Figure 196 - Adding Notes 

Then type/insert your notes in the popup window.  

mailto:Bruce.Bourgoin@ct.gov
mailto:Nicholas.Langer@ct.gov
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The other option to access the notes window is to double click on the task and in the Task 

Information window and click on the Notes tab. 

Adding Hyperlinks to a Task 

As stated in the Directive: “Task Indicator columns are used to link applicable instructional and 
reference documents.” For all templates, hyperlinks shall be used to link a task to a division 
specific Schedule Task Library folder located in the Scheduling Directive PW folder. Contact your 
SME or AEC Applications for ProjectWise folder and template document management.  
 
For example, a Permit Task should provide a link to a corresponding ProjectWise folder that 
contains the permit’s regulatory document, suggested points of contact or experts, pre-written 
memorandums, etc... These documents must be added, actively maintained and updated. 
Division SME’s and AEC shall be the active maintainers of the division library modifications. 
When a document is incorrect or has been superseded it is critical that users report this to a 
unit’s SME or to AEC so documents can be updated and maintained. It is suggested that users 
go through their SMEs to hyperlink documents, but the procedure is explained below.  
 

To add a Hyperlink, right click on the task that you want to add a link to and select Hyperlink  

 
Figure 197 - Adding Hyperlink 

 

Then in the following window, insert web address\navigate to a file.  

 
Figure 198 - Add link/browse to a file 

 

To remove a link right click on the link (Task)> Hyperlink> Edit hyperlink > Remove link  

pw://ctdot.projectwiseonline.com:CTDOT/Documents/04.00%20-%20Engineering%20Libraries/Scheduling%20Directive/
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Figure 199 - Removing a link 

 

To access a hyperlink hold the ctrl key and left click the hyperlink icon located in the Indicator 
column.  

8.2.7 Combining Multiple Projects 
It is critical that project managers can combine project schedules to better manage several 
schedules from the same file. MS Project provides this ability through the Subproject combine 
function. As outlined in Section 8, schedules must be stored in the project container: 
140_Project Administration folder. However, to use the combine function, MS Project schedules 
must be exported from the ProjectWise folder to a local server drive, such as the X-Drive. 
Schedules located in a local network can then be combined using the subproject tool. Exporting 
is only recommended when a user wants to use the combine tool. 
 
The following steps show how to combine Microsoft Project files: 

1. Browse to the ProjectWise Project container’s 140_Project Administration folder.  
Right click the Project Schedule and select Export, as shown below: 
 

 

Figure 200 - Schedule Export 
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2. Highlight Export and Click Next as shown below: 
 

 

Figure 201 - Export Option 

 
3. Browse to the network folder where you will keep the schedule file image. This 

network file will likely be in the division specific X-Drive>all_data-folder. 
 

NOTE: DO NOT DELETE THE EXPORTED FILE 
 
The floppy disk means that the file has been exported so the schedule is now read only. A user 
can still access the Project file by double clicking it and opening the file as Read Only. 
 

 

 

Figure 202 - Exported File 

 
4. Create a new “Master” MS Project file that will be used as the container for the 

combined Subprojects. This Master Schedule file can be stored in the local network 
drive (such as the X-Dirve) or on ProjectWise. Browse to the local network schedule 
(the one stored in the X-Drive) and click Insert as shown below: 
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Figure 203 - Subproject 

The schedule has been inserted into the Master Schedule, where it can be actively updated and 
maintained. Initially, sub-tasks will be hidden, but they can be shown by clicking the project’s 
outline symbol. 

 

 

Figure 204 - Added Subprojects 

 
A user can view the most updated schedule via the ProjectWise file by right clicking the schedule 
file and selecting Update Server Copy as shown below: 
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Figure 205 - Update server copy 

 
5. This step updates the ProjectWise schedule from the local network image file that is 

maintained by the user’s Master schedule. This allows any person to view the most-
up-to-date project schedule directly from ProjectWise.  

6. To Import a project schedule back into ProjectWise the user must right click on the 
ProjectWise schedule and click Import. As shown below: 

 

 

Figure 206- Import 

 
7.  If you look back to the local server where the project image file had been saved, 

you will notice that it is no longer there, this is because the file has been imported 
back into ProjectWise.  Now the file can once again be managed directly from 
ProjectWise. If a user wishes to maintain their schedule continuously from their 
master schedule, they should avoid importing the schedule. Once a file is imported 
the user must re-export and re-add the schedule to their master schedule.   
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8.3 Tracking the Project 

8.3.1 Baselining the Project 
Each project file must have a baseline set at the start of Preliminary Design.  The baseline is 
essentially a stamp of the schedule at the start of the Preliminary Design phase. The purpose of 
the baseline is to gage how much a schedule varies from the initial baseline. Projects shall not 
be re-baselined unless there is a major scope change.  Re-baselining requires Engineering 
Administrator approval.  
 

1. To set the baseline, under the Project tab select set baseline and select Set 

Baseline from the dropdown as shown below 

 

Figure 207 - Set Baseline Dropdown 

2. In the dialog box that pops ups, keep the default values and click OK. 

 

Figure 208 - Setting a baseline 

 

Re-Baselining          
If Re-baselining is needed and is approved by the Engineering Administrator, the baseline will be 

set in accordance with the following: 

1. Go to Projects > Set Baseline > Set Baseline. 

2. Then select Set Interim plan, select Baseline from the copy drop down button, then 

select Baseline 10 for the Into dropdown list.  
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Figure 209 - Re-Baselining 

3. Next, go to Project > Set Baseline> set Baseline. 

4. Then in the dialog box that pops up just click OK to save a new Baseline.  

 

Figure 210 - Re-Baselining 

5. When a pop up window asks you if you want to overwrite click yes 

 

Figure 211 - Re-Baselining 

6. After the project has been re-baselined add a note to the top left Identifier cell 

located in the Project No. row. The note should include the details outlined in the 

Adding Notes and Hyperlinks to a Task section. The recipient list should include all 

parties affected by the base-line adjustment.  
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Figure 212 - Re-Baselining Note 

 
After the project has been re-baselined change the view to a Tracking Gantt view.   
 

1. In the left dark grey bar shown below, right click and select Tracking Gantt.   

 

Figure 213 - Changing to a Tracking Gantt 

 

Notice the Gantt shows two bars stacked over each other. The grey bar is the baseline and the 

one on top is the actual duration.   If there is a slip in a task schedule it will be shown as an 

offset. 
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Figure 214 – Tracking Gantt view 

2. Next to change the table of tasks to the tracking mode, click on the left upper corner 

cell to select the entire schedule, then right click and select tracking. 

 

Figure 215 - Changing to tracking table 

The table of tasks will now be in the tracking mode, 

3. Then click save. 

8.3.2 Recording Task Progress 
The project manager will be required to record the project progress by keeping an up to date 
record of the % complete for each task in the project.   This shall be recorded in 25% increments.   
 
The following shows how to record the progress of a task: 

1. Click on a task. 
2. Then in the task menu select the appropriate % complete as shown below: 
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Figure 216 - task update tools 

Important Note:  When the task is completed, do not select 100% complete.  You will need 

to type in the actual finish date for that task.  If 100% complete is selected, Microsoft Project will 

calculate the actual finish date instead of recording the physical date the task was completed.  

In the tracking Gantt, the task will show the percent complete of the task as shown below:  

 

Figure 217 - Updated task view 

 

Also when a task is not started and/or finished on time, it will show as a slipping bar as in the 

following figure. 
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Figure 218 - Tracking View 
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8.4 Generating Reports and Summaries 
Microsoft Project provides different forms of reports and visual summaries.  MS Project has 
three reporting options: 

1. Standard Reports 

2. Custom Reports 

3. Visual Reports 

 

Standard Reports 
Standard Reports are reports predefined by Microsoft on; Overview, Current, Costs, 

assignments and workload.  

  Under Overview the following is reported: 

 Project Summary 

 Top-Level Tasks 

 Critical Tasks 

 Milestones  

 Working days 

Under Current the following is reported: 

 Un started Tasks 

 Tasks Starting Soon 

 Tasks In-Progress 

  Completed Tasks 

 Should have Started Tasks 

 Slipping Tasks 

              Under Cost the following is reported: 

 Cash Flow 

 Budget 

 Overbudget Tasks 

 Overbudget Resources 

 Earned Value 

            Under Assignments the following is reported: 

 Who does what 

 Who does what when 

 To-do List 

 Overallocated Resources  

  

        Under Workload the following is reported: 

 Task usage 

 Resource Usage 
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To access these report options go to Project > Reports  

 

Figure 219 - Report options 

Custom Reports 

A custom report has the ability to customize the report based on templates in the following 

categories: 

 Task 

 Resource  

 Monthly Calendar 

 Crosstab 

 To access custom report tool, go to Project > Reports > and double click on Custom 

 

Figure 220 - Custom Reports 
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Then the report to be edited is first selected from the list of available custom report.  Next, click 

the Edit button. The dialog will show the current report’s setting and all the available report 

settings. 

 

Figure 221 - Customizing a report template 

Other than the Definitions tab you may utilize details and sort tabs for further customization. 

Visual Reports 

Unlike the standard/customized reports which are text based, visual reports present the report 

graphically. Visual reports are pre-formatted excel pivot-tables and pivot-charts as well as Visio 

pivot-diagrams. 

To access go to Projects tab > Visual Reports 

 

Figure 222 - Visual Reports 
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 CTDOT Project Location – Under Section 9

Development 

This section details the required information/documents that need to be submitted to CTDOT to 
locate all of our projects on a GIS (Geographic Information System).   
 
The lead designer shall be responsible for providing the information/documents detailed in the 
following tables when filling out or updating the Project Asset Form located on the Projectwise 
Project Information Webpage at the following link: 
 

Projectwise Composite Data 
 
This information/document needs to be submitted or updated at the following project 
milestones: 

 RPM 

 Design Approval 

 Final Design 
 

The following tables detail what needs to be provided on the Project Asset Form for various 
project types.  If your project type is not listed, contact AEC applications for guidance: 
Mathew.calkins@ct.gov or John.Rinaldi@ct.gov    
 

Project Milestone - RPM 

Project Type Required 
Information/Document  

Instructions 

Highway Paving Routes and Mileage Section 8.1.1 

Guide Rail, Barrier, Safety Improvements Routes and Mileage Section 8.1.1 

All other highway projects Google Earth KML  

  

Bridge Bridge Preservation projects Route and Mileage Section 8.1.2 

Bridge Maintenance projects Route and Mileage Section 8.1.2 

Bridge Replacement or Superstructure 
Replacement 

Google Earth KML Section 8.1.3 

Retaining Wall Projects Google Earth KML Section 8.1.3 

Sign Support Projects List of sign supports in the 
project 

Section 8.1.2 

  

Traffic  Traffic Signals List of traffic signals in the 
project 

Section 8.1.2 

Signing Route and Mileage Section 8.1.1 

Pavement Markings Route and Mileage Section 8.1.1 

Rumble Strip Route and Mileage Section 8.1.1 

  

Facilities  New Facility or Rehab of Existing Facility Google Earth KML Section 8.1.3 

Rail Project Google Earth KML Section 8.1.3 

  

Rails Rail Project  Google Earth KML Section 8.1.3 

 

District Wide 
Projects 

   

http://dot-sdcdbs56v/PW_FederatedData/MainMenu.aspx?SessionExpired=True
mailto:Mathew.calkins@ct.gov
mailto:John.Rinaldi@ct.gov
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State wide 
Projects 

   

 

Project Milestone – Design Approval 

Project Type Required 
Information/Document  

Instructions 

Highway Paving Updated Routes and Mileage if 
necessary 

Section 8.1.1 

Guide Rail, Barrier, Safety 
Improvements 

Updated Routes and Mileage if 
necessary 

Section 8.1.1 

All other highway projects Microstation Project Polygon 
File 

Section 8.2.1 

  

Bridge Bridge Preservation projects Updated list of bridges in the 
project if necessary 

Section 8.1.2 

Bridge Maintenance projects Updated list of bridges in the 
project if necessary 

Section 8.1.2 

Bridge Replacement or 
Superstructure Replacement 

Microstation Project Polygon 
File 

Section 8.2.1 

Retaining Wall Projects Microstation Project Polygon 
File 

Section 8.2.1 

Sign Support Projects Updated list of sign supports in 
the project if necessary 

Section 8.1.2 

  

Traffic  Traffic Signals Updated list of traffic signals in 
the project if necessary 

Section 8.1.2 

Signing Updated Routes and Mileage if 
necessary 

Section 8.1.1 

Pavement Markings Updated Routes and Mileage if 
necessary 

Section 8.1.1 

Rumble Strip Updated Routes and Mileage if 
necessary 

Section 8.1.1 

  

Facilities  New Facility or Rehab of Existing 
Facility 

Microstation Project Polygon 
File 

Section 8.2.1 

Rail Project Microstation Project Polygon 
File 

Section 8.2.1 

  

Rails Rail Project  Microstation Project Polygon 
File 

Section 8.2.1 

 

District Wide 
Projects 

   

State Wide 
Projects 
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Project Milestone – Final Design and Construction 

Project Type Required 
Information/Document  

Instructions 

Highway Paving Updated Routes and 
Mileage if necessary 

Section 8.1.1 

Guide Rail, Barrier, Safety Improvements Updated Routes and 
Mileage if necessary 

Section 8.1.1 

All other highway projects Updated Microstation 
Project Polygon File 

Section 8.2.1 

  

Bridge Bridge Preservation projects Updated list of bridges in 
the project if necessary 

Section 8.1.2 

Bridge Maintenance projects Updated list of bridges in 
the project if necessary 

Section 8.1.2 

Bridge Replacement or Superstructure 
Replacement 

Updated Microstation 
Project Polygon File 

Section 8.2.1 

Retaining Wall Projects Updated Microstation 
Project Polygon File 

Section 8.2.1 

Sign Support Projects Updated list of sign 
supports in the project if 
necessary 

Section 8.1.2 

  

Traffic  Traffic Signals Updated list of traffic 
signals in the project if 
necessary 

Section 8.1.2 

Signing Updated Routes and 
Mileage if necessary 

Section 8.1.1 

Pavement Markings Updated Routes and 
Mileage if necessary 

Section 8.1.1 

Rumble Strip Updated Routes and 
Mileage if necessary 

Section 8.1.1 

  

Facilities  New Facility or Rehab of Existing Facility Updated Microstation 
Project Polygon File 

Section 8.2.1 

Rail Project Updated Microstation 
Project Polygon File 

Section 8.2.1 

  

Rails Rail Project  Updated Microstation 
Project Polygon File 

Section 8.2.1 

 

District Wide 
Projects 

   

State Wide 
Projects 
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9.1 Project Location - RPM 

9.1.1 Route and Mileage 
The lead designer shall provide all routes and mileages for project in accordance with the 
following:  
 

1. Go to the Projectwise Project Information Webpage: Projectwise Composite Data 
2. Click on the Project Asset Form. 

 

Figure 223 - Project Asset Form 

 
3. Select the project from the drop down or if it is a new project click “Add Project”. 

 

Figure 224 - Selecting Project 

4. To get the route and mileage for a project you will need to go to the ALIM system 
found here:     ALIM System 

5. Next add the route and mileages to the Project Asset Form. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://dot-sdcdbs56v/PW_FederatedData/MainMenu.aspx?SessionExpired=True
https://ctdot-geopub.projectwiseonline.com/ctdot2/Framework/default.aspx
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9.1.2 List of Assets for the Project 
 

1. Go to the Projectwise Project Information Webpage: Projectwise Composite Data 
2. Click on the Project Asset Form. 

 

Figure 225 - Project Asset Form 

 
3. Select the project from the drop down or if it is a new project click “Add Project”. 

 

Figure 226 - Selecting Project 

4. On the form add all of the assets in this project.  
 

http://dot-sdcdbs56v/PW_FederatedData/MainMenu.aspx?SessionExpired=True
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Figure 227 - Adding Assets 

9.1.3 Project Polygon Creation and Submission 
The following shows how to create and submit a project polygon KML file for project location.  
The project polygon is created in Google Earth and attached to the Project Asset Form located 
on the Projectwise Project Information webpage.   
 

1. Open Google Earth. 
2. Zoom into the location of the project or use the search tool to locate the area of the 

project.  
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Figure 228 - Searching in Google Earth 

 
3. Next select the polygon tool to place a polygon around your project. 

 

Figure 229 - Polygon Tool 

 
 

4. Next Type the project number in the name field and a description in the description 
field as shown below: 
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Figure 230 - Polygon Settings 

5. Next adjust the style and color of the polygon to the settings shown below, do not 
click OK after you update the settings: 

 

Figure 231 - Polygon Style 
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6. Next draw the polygon for the project.  This polygon should encompasses the whole 
project and include all the roads that this project will affect.  Then click OK. 

 

Figure 232 - Drawing the Polygon 

If you are dissatisfied with the polygon, you can delete it by right clicking on the polygon located 
in the places area, which is in the left hand side of the screen, of Google Earth.  Then redraw the 
polygon by going back to step 3. 

 

Figure 233 - Deleting a Polygon 
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7. If the project has multiple sites, go back to step 3 and create another polygon(s).  
After you create all your polygons they will be listed in the places area in Google 
Earth.   

 

Figure 234 - All Sites for Project 

8. After all the sites are made they need to be added to the temporary places area in 
Google Earth so a combined KML file can be saved.  To add them to the temporary 
places simply drag and drop all the sites into that area as shown below: 
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Figure 235 - Drag all the Sites into the Temporary Places 

9. Next to save a KML file with all the polygons in it right click on Temporary Places and 
select Save Place As: 

 

Figure 236 - Saving the KML File 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued 04-2016 202 Version 3.13 
     

10. Next type in the project number for the file name and select KML for the file format.  
Then select the folder on your computer where you want to save the file too and click 
Save. 

 

Figure 237 - Saving the KML File 

 
11. Go to the Projectwise Project Information Webpage: Projectwise Project 

Information 
12. Click on the Project Asset Form. 

 

Figure 238 - Project Asset Form 

 
13. Select the project from the drop down or if it is a new project click “Add Project”. 

http://dot-sdcdbs56v/PW_FederatedData/MainMenu.aspx?SessionExpired=True
http://dot-sdcdbs56v/PW_FederatedData/MainMenu.aspx?SessionExpired=True
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Figure 239 - Selecting Project 
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14. Next attach the KML file to the Project Asset Form by clicking on Browse and then 
select the file: 

 

Figure 240 - Attaching the KML File 
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15. After you have selected the file click on attach file: 

 

Figure 241 - Attaching the KML File 
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9.2 Project Location - Design Approval through 
Construction 

The following shows how to create and upload a refined project polygon file at and after the 
Design Approval milestone of a project.  The file shall be created by the lead designer in 
accordance with this section and uploaded into the 140_GIS folder of the applicable project in 
ProjectWise.  For projects that were previously located using the assets or route and mileage 
this section does not apply.  If changes are made to projects found using assets or route and 
mileage update that project information in accordance with Section 8.1. 

9.2.1 Project Polygon 
The lead designer is responsible for creating the project polygon dgn and kml files using 
Microstation.  The following section details what needs to be included in the polygon and how 
to make the project polygon file for different project types.   
 
If your project type is not detailed below, contact AEC Applications. Mathew.calkins@ct.gov or 
John.Rinaldi@ct.gov  for guidance.  
 
If a project has more than one site, all the polygons for that project must be included in one 
project polygon file.  All the polygons for each intersection shall be in one file.   
 
Highway Projects that Touch Pavement  
The Project Polygon file shall encompass the entire project extents per site and include all slope 
lines, drainage rights of way, temporary work areas, portions of local affected roads, all affected 
assets, etc. The polygon should be drawn up to the right of way line unless the slope limits or 
temporary work area extends beyond that.  Below is an example of what to include: 
 

 

Figure 242 – Project Extents 

 
 
 
 
 
 
 

mailto:Mathew.calkins@ct.gov
mailto:John.Rinaldi@ct.gov
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The image below is an example of what a typical project polygon will look like after it is drawn in 
Microstation.  

 

 

Figure 243 – Project Polygon example 

Highway Projects that DO NOT Touch Pavement 
This type of project could involve, but not limited to the following: 

 Guard rail replacement 

 Barrier replacement 

 Noise barriers 

 Retaining walls 
 
The Project Polygon file shall encompass the entire project extents per site and include all slope 
lines, temporary work areas, portions of local affected roads, all affected assets, etc. The 
polygon should be drawn up to the right of way line unless the slope limits or temporary work 
area extends beyond that.  If there is only a ROW line on one side of the project, draw the 
polygon relatively close to the edge of the work area.  Below is an example of a noise barrier 
project and shows what to include: 
 
 

 

Figure 244 - Highway Project without Full Depth Reconstruction 
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Full Bridge Replacement or Superstructure Replacement that Touch the Roadway 
The Project Polygon file shall encompass the entire project extents per site and include all slope 
lines, drainage rights of way, temporary work areas, portions of local affected roads, all affected 
assets, etc. The polygon should be drawn up to the right of way line unless the slope limits or 
temporary work area extends beyond that.  Below is an example of what to include: 
 

 

Figure 245 - Bridge Polygon Example 

 
 
 
Full Bridge or Culvert Replacement or Rehabilitation that Do Not Touch the Roadway 
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Facilities Project  
The Project Polygon file shall be drawn on the ROW line or limits of construction for the parcel 
the facility is located on.  Any slope limits or work being done outside of this ROW line shall be 
included in the polygon.  Below is an example of what to include: 
 

Figure 246 - Facilities Project E

xample 
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9.2.2 Project Polygon File(s) Creation 
The following steps explain how to create and submit the Project Polygon file.  One polygon file 
shall be created for each project.  If the project consists of multiple “sites,” the file shall include 
multiple polygons. 

1. Note the datum and units (e.g. NAD 83 Survey Feet) of the Highway Design file to be 
referenced.  This can usually be found within the ground survey file title block.  If there 
is no survey for the project use the 2D Poly 83 FT seed file shown in the next step.   

2. In House CTDOT Users:  Create a new MicroStation design file using the 2D_Poly_83FT 
seed file located in the W: Drive.  See folder address below: 
 
W:/CTDOT_V8_Workspaces\Workspace\Standards\seed\Geospatial\  
 

Note: If your project is NAD 27 FT still use the 83FT seed.   
 

 
Figure 247 – CTDOT CAD resource folders 

 
Consultant Users:  Download the seed files using this link: 2D_Poly_83FT Seed File 

 
3. Reference the Highway Design file into the newly created file using true scale off and 

1:1 

http://www.ct.gov/dot/lib/dot/documents/aec/2d_poly_83ft.zip
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Figure 248 – MicroStation reference file settings 

4. Verify that the tentative coordinates of this file match the referenced design (using 
stationing, grids, etc.).  If your project is in NAD 83FT the coordinates should match, if 
they do not check that the scale of the reference is 1:1.  If your project is NAD 27 FT we 
will move the reference file so the coordinates are correct.  To move the reference file 
do the following: 

a. Select Reference File. 
b. Select Move Reference: 

 

Figure 249 - Move Reference 

c. Next when it prompts you to “Enter point to move from”, in the Key-In Box   
key in XY=0,0 and click Enter. 
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Figure 250 - Key In 

 
 
 
 
 
 
 
 

d. Then when it prompts you to “Move Reference>Enter Point to move to”, in the 
Key-In Box key in DL=400124.9,500038.9. 

 

Figure 251 - Move to Key In 
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Now the tentative coordinates of this file should match the referenced design (using stationing, 
grids, etc.).   
 

5. Set the MicroStation active level to “TOOL_Prelim_Proj_Polygon” for the Project 
Polygon (Note: if this level is not yet available, use “SV_PARCEL_DATA”) 

6. Then place a closed polygon(s) using the shape tool or the smart line tool.   
7. After the polygon has been placed, turn off all reference displays and fit the polygon to 

the view. 
8. Verify that the polygon is spatially correct by exporting the MicroStation file as a kml 

file to Google Earth.   
Do this by choosing: File> Export> Google Earth.   

9. Google Earth should then automatically open and zoom to the Project Polygon(s) 
vicinity. 

9.2.3 Project Polygon File(s) Submission 
The Project Polygon files shall then be uploaded into ProjectWise in accordance with the 
following: 

1. Log into ProjectWise 
2. Browse to your project’s 140_GIS folder in ProjectWise Explorer 
3. Select the Interface, “CTDOT_Doc_Code.”  If the interface box is not shown, select: 

View>Toolbars and select interface 
4. Drag and drop the file into the 140_GIS folder using the Advanced Wizard 

 

Figure 252 – ProjectWise project polygon folder example 

5. Continue to click Next in the Advance Wizard until you get to the Attributes screen and 
assign the attributes shown in Table 5 of Appendix E 

6. Click Next until the file uploads.  
7. When upload is complete, the Lead Designer shall send an email to the following 

people including links to the documents in Projectwise.  To do this, click on the 
document and then highlight and copy the address located in the Address Bar.  Then 
paste it in the email:        
 

John.Rinaldi@ct.gov (AEC), 
Mathew.calkins@ct.gov (AEC) 
Henok.Abdisssa@ct.gov (AEC) 

To submit a revision for the Project Polygon files, use the same steps above but add “Revised” to 
the label attribute.  
 
 

mailto:John.Rinaldi@ct.gov
mailto:Mathew.calkins@ct.gov
mailto:Henok.Abdisssa@ct.gov
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 Rights of Way (ROW) Files  Section 10

This section details the submission of the following Rights of Way (ROW) Files: 

 Property Maps Files (.dgn and PDF) 

 Parcel Polygon Files (.dgn and KML)   
 
These files shall be submitted at the Project Milestone – Design Approval and updated as 
necessary as the project moves through design and construction. 

10.1 Submission of the Property Maps Files 
The .dgn and PDF files for a Property Map shall be uploaded to CTDOT’s Projectwise site in 
accordance with the following: 

1. Log into Projectwise. 
2. Browse out to your project and upload the Property Map DGN and PDF into the 

05_Property_Maps folder and 310_Review folder respectively as shown below: 

 

Figure 253 - Uploading Property Maps 

3. Select the Interface,  “CTDOT_Doc_Code.”  If the interface box is not shown, select: 
View>Toolbars and select interface.   

4. Using the Advanced Wizard, drag and drop the following files into the 140_GIS Folder 
5. For each file, continue to click Next in the Advance Wizard until you get to the 

Attributes screen and assign the attributes shown in Table 5 of Appendix E 
6. Click Next until the file uploads. 
8. When the files are uploaded, the creator of the Property Map shall send an email to 

the following people including links to the documents in Projectwise.  To do this, click 
on the document and then highlight and copy the address located in the Address Bar.  
Then paste it in the email:         

 ROW Supervising Coordinator - Robert.Ike@ct.gov 

 ROW Excess Property Inventory/GIS Unit (EPIU) - John.Durling@ct.gov, 
Shandi.Wong@ct.gov 

 Bureau Records Center (BRC) - Bryan.Deprey@ct.gov, Janet.West@ct.gov 

 Appropriate Project Coordinator - Steven.Degen@ct.gov, 
Michael.Marzi@ct.gov, Douglas.Hummel@ct.gov, Derrick.Ireland@ct.gov  

To submit a revision to the property maps, use the same steps above but add “Revised” to the 
label attribute.  

mailto:Robert.Ike@ct.gov
mailto:John.Durling@ct.gov
mailto:Shandi.Wong@ct.gov
mailto:Bryan.Deprey@ct.gov
mailto:Janet.West@ct.gov
mailto:Steven.Degen@ct.gov
mailto:Michael.Marzi@ct.gov
mailto:Douglas.Hummel@ct.gov
mailto:Derrick.Ireland@ct.gov
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10.2 Parcel Polygon File(s) 
The Parcel Polygon files shall be created by the creator of the property map and represents the 
area to be acquired by the State.  It should be accurately based on existing property lines and 
proposed Rights of Way lines.  These files shall be submitted at the Project Milestone – Design 
Approval and updated as necessary as the project moves through design and construction. 

10.2.1 Parcel Polygon File(s) Creation 
The following steps explain how to create and submit the Parcel Polygon CAD file(s).  One file 
shall be created for each parcel - only permanent land and easement acquisition areas.  
 
When submitting a Parcel Polygon file(s), a PDF of the Property Map and the CAD file of the 
Property Map shall also be submitted into ProjectWise in accordance with this manual, see 
section 9. 
 

 

Figure 254 – Property Map parcel area example 

1. Figure out which datum and units (e.g. NAD 83 Survey Feet) the existing Property Map 
is in.  This is usually found within the referenced ground survey file title block  

2. IN House CTDOT Staff – Then create a new MicroStation design file using the correct 
seed for the datum in the project located in the W: Drive.  See folder address below: 
W:/CTDOT_V8_Workspaces\Workspace\Standards\seed\Geospatial\  
 

 

Figure 255 - Seed File 
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Consultant Staff: Download the seed files using this link:  Geospatial Seeds 
3. Reference the Property Map file into the newly created file using true scale off and 1:1 

 

Figure 256 - Reference File 

4. Verify that the tentative coordinates of the new file match the Property Map (using 
stationing, grids, etc.) 

5. Set the MicroStation active level to “SV_PARCEL_DATA” for Parcel Polygon(s).  
6. Then place a closed polygon using the shape tool or the smart line tool.   
7. CTDOT has a customized a MicroStation task, “CT Property Maps,” to aid in the 

creation of property maps.  The task contains “Shape for GIS” tools which can be used 
for polygon creation:  

 
Figure 257 – Custom MicroStation tasks 

8. After the polygon has been placed, turn off all reference displays and fit the polygon to 
the view. 

9. Verify that the polygon is spatially correct by exporting the MicroStation file as a kml 
file to Google Earth by choosing: File> Export> Google Earth.   

10. Google Earth should then automatically open and zoom to the Project Polygon vicinity. 

http://www.ct.gov/dot/lib/dot/documents/aec/geospatial_seeds.zip
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10.2.2 Parcel Polygon File Submission 
The Parcel Polygon file(s) shall be uploaded into ProjectWise in accordance with the following.  
[Note that if the parcel geometry remains unchanged with subsequent Property Map revisions, 
it is not necessary to recreate and resubmit the Parcel Polygon and KML once initially submitted] 

1. Log into ProjectWise 
2. Using ProjectWise Explorer, browse to the 140_GIS folder of your project. 

 

Figure 258 – ProjectWise parcel polygon folders example 

3. Select the Interface, “CTDOT_Doc_Code.”  If the interface box is not shown, select: 
View>Toolbars and select interface.   

4. Using the Advanced Wizard, drag and drop the following files into the 140_GIS Folder 
5. For each file, continue to click Next in the Advance Wizard until you get to the 

Attributes screen and assign the attributes shown in Table 5 of Appendix E 
6. Click Next until the file uploads. 
9. When the files are uploaded, the creator of the Property Map shall send an email to 

the following people including links to the documents in Projectwise.  To do this, click 
on the document and then highlight and copy the address located in the Address Bar.  
Then paste it in the email:        
 

 ROW Excess Property Inventory/GIS Unit (EPIU) - John.Durling@ct.gov, 
Shandi.Wong@ct.gov 

To submit a revision for the Parcel Polygon files, use the same steps above but add “Revised” to 
the label attribute.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:John.Durling@ct.gov
mailto:Shandi.Wong@ct.gov
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Appendix A - Initial Bluebeam Settings 

Initial Log into Bluebeam 
These steps only need to be completed the first time using Bluebeam or when the user logs into 
a new computer. 

1. Open Bluebeam by selecting the desktop icon:            

If you do not have a desktop icon, select Start>Bluebeam Software.  Right click on Bluebeam 
Revu, select Send To>Desktop (create shortcut).  This will place the Bluebeam icon on your 
desktop: 

 

Figure 259 - Creating Desktop Shortcut 
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2. Then Open Bluebeam by double clicking on the shortcut. 

3. Click on the settings icon in the top right hand corner and click Preferences as shown 
below.  If you cannot find the settings icon in the top right, go to the Edit menu and 
select Preferences.    

 

Figure 260 - Bluebeam Preferences 

4. Click on File Access and make sure the box is checked as shown below:  If ProjectWise is not 

listed click on Add

 

Figure 261 - Projectwise Integration 
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5. Then click Load and enter in your Projectwise Username and password. 

 

Figure 262 - Integrating Projectwise 

After you click Log in the status should read Logged In as shown below: 

 

Figure 263 - Projectwise Integration 
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6. In the General section in the User area type in your name (First Initial and Last Name), 

title, and your office name.  An example for me would be M. Calkins TE 2 AEC 

Applications.  An example for a district construction user would be J. Smith TE 3 D2 

Construction.   

 

Figure 264 - General Preferences 

7. Update the markups options to match the following:

 

Figure 265 - Markup Preferences 
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8. Update the markups tab options to match the following: 

 

Figure 266 - Markup Preferences 

9. Click on the Signature tab and set the algorithm to SHA-1. 

 

Figure 267 - Signature Setting 
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10. Click on the Web Tab section and make sure the box for Open PDF hyperlinks in Web 

Tabs is unchecked.  This will open any hyperlink that is in a PDF document using Internet 

Explorer instead of Bluebeam.  This is the last preference you will need to update so you 

can click Ok at the bottom right now.   

 

Figure 268 - Webtab Preferences 
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Downloading the CTDOT Bluebeam Profile 
1. Download this file and save it to your desktop: CTDOT Bluebeam Profile 

2. Double click on the profile in the zipped folder on your desktop. 

 

Figure 269 - Importing the Bluebeam Tools 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

http://www.ct.gov/dot/lib/dot/documents/aec/ctdot_bluebeam_user_profile.zip
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Appendix B - Usability of PDF Documents 

Usability of PDF Documents  
This section contains information about viewing digital contract documents.   

Structure of Digital Plans  
Final Design Plans, Addendums, and Design Initiated Change Orders 
The contract plans are split up into discipline subsets, which are multiple sheet PDF documents 
digitally signed by the Designer.  Addendums and Change Orders are also submitted as discipline 
subset, with only the changed sheets.  For example, an Addendum that affects the 03-Bridge 
Subset will require the submission of a 03-Bridge_A1 subset.    
 
Digital Plans are located in the 100_Contract_Plans folder in Projectwise.  Below is an example 
of a project’s discipline subsets in Projectwise: 
 

 

Figure 270 - Discipline Subsets in Projectwise 

As-Built’s 
As-built’s will be placed directly on the PDF Subsets using Bluebeam. 

Functionality of PDF Digital Plans 
The PDF digital plans have the following functions when the digital contract plans are created in 
accordance with this manual: 
 Turn levels on and off  
 Search for all text on the documents.   
 PDF plans are measurable  
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Digital Plan Levels 
The plans have the ability to have their levels turned off and on.  This can allow for easier 
viewing of the contract sheets.   See below for turning levels on and off: 
 

 

Figure 271 - Turning Levels On and Off 
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 Searching Digital Plans 
The plans can be searched for any text located on them.  This can be useful if searching for a 
certain pay item.   
 
See below for searching the PDF Plans for text.   
 

 

Figure 272 - Searching for Text in PDF Plans 
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Measuring on the Digital Plans 
The plans have the ability to be measured in PDF.  This is helpful because a paper set does not 
need to be created for on desk measuring.   
 
See below for measuring in PDF. 

 

Figure 273 - Measuring Tool 
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Digital Specification 
The FDP specification package will be one PDF document and located in the 
110_Contract_Specifications folder.  This package includes all specifications, Notice to 
Contractors, Wage information, etc.   
 
The Addendum specifications prepared in the same way as the FDP specification package and 
will also be located in the 110_Contract Specifications folder. 
 
The Design Initiated Change Order specifications will be contained in one PDF document located 
in the 110_Contract Specifications folder when they are released to the Contractor. 
 
Some useful features on the digital specification package are: 

 Search for any text in the document, see Searching Digital Plans 

 Bookmarks for each section in the specification package 
  

 

Figure 274 - Bookmarks in the Spec. Package 
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Document Compare Tools 
Bluebeam has the two tools for comparing documents:  (1) Compare Documents and (2) Overlay 
Pages.  Compare Documents will compare two documents and create a third document that 
clouds all the changes.  Overlay pages will create a third document where the pages of 
document A will become one color and the pages of document be will become another color.  
When the pages are overlaid you will be able to see the changes from the difference in these 
two colors.  Both of these tools can be used for single and multipage PDF documents.  The 
following shows how to perform a document compare and how to use the overlay page tool. 
 
Document Compare 

1. Open the Revised document first and then open the original document that you want to 
compare from Projectwise or your computer.   

2. Next go to Document>Comparison>Compare Documents as shown below: 

 

Figure 275 - Compare Documents 

3. In the window that pops up you will notice the two documents that were just opened.  
Click OK to run the document compare as shown below: 
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Figure 276 - document Compare 

Overlay Pages 

1. Open the Revised document first and then open the original document that you want to 
compare from Projectwise or your computer.  

2. Next go to Document>Comparison>Overlay pages as shown below: 

 

Figure 277 - Overlay Pages 

3. In the window that pops up you will need to select which pages of each document you 
want to overlay.  To do this double click on a file, then in the window that pops up type 
the pages you want to overlay.  The example below shows pages 1-28.  Once you select 
the pages you want to overlay click OK. 
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Figure 278 - Overlay Pages 

 

igure 279 - Overlay Pages 
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Appendix C - Using the Set File 

Opening the Set File 
Double click on the set file from Projectwise and open as shown below:  This may take a while 

please be patient.  Note: The first time opening a set file will take longer than any subsequent 

times.  

 

Figure 280 - Opening a Set File 

Viewing the Plans Sheets within a Set File 
All the plans sheets will be combined and shown on the left hand side of the screen in a 
thumbnail view.  To view a sheet, simply click on that sheet and it will open up. 

 

Figure 281 - Viewing a Plan Sheet from a Set File 
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Marking Up a Set File 
1. Open up the set file by following Section 1.4.1.  You will notice on the left hand side of 

the screen will be thumbnails of all the sheets in the set file.   

 

Figure 282 - Sheets in the Set File 
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2. To mark up a sheet scroll down to the sheet that needs to be marked up and click on it.  

You will notice that sheet opens up on the right: 

 

Figure 283 - Marking Up a Sheet 
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3. Next to markup the document we must unlock it (Check Out of Projectwise).  To do this, 

right click on the lock and select Check Out. 

 

Figure 284 - Checking Out a Document 

4. Notice the lock changes to a Check and you will be able to markup the document. 

 

Figure 285 - Checking Out a Document for Editing 
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5. To mark up the plans use the tools located in the tool chest shown below:  

 

Figure 286 - Marking up the Plan Sheets 
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6. When finished, click Save and then right click on the Check and select “Check In”. 

 

Figure 287 - Saving Markups and Checking Into Projectwise 
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Searching a Set File 
 
The Set feature in Bluebeam allows you to search across the entire set file.  The following shows 
how to search a set file: 

1. Click on the Search Set file icon and then type in what you want to search for as shown 

below: 

 

Figure 288 - Searching the Set File 
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Creating a Consolidated PDF of the Files in the Set File 
Bluebeam allows you to create a consolidated pdf of all the files in a set file.  The following 
shows how to create a consolidated pdf: 

1. Select the Publish Icon and select Combine: 

 

Figure 289 - Consolidating Files 

2. Next keep the default settings and click OK on the dialog box shown below: 

 

Figure 290 - Consolidating Files 
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3. Bluebeam will then create a consolidated file of all the PDF in the set file.  

 

Figure 291 - Consolidated File 
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Printing the Entire Set File 
Bluebeam allows you to print the entire Set file, only the latest revisions, or previous revisions.  
Printing the entire set will print all the sheets in the set file.  Printing the latest revisions will 
print the most up to date sheets and not print the previous revisions.  Printing the previous 
revisions will only print the sheets that were changed by a revision.   
The following shows how print a set file: 

1. Select the print set file icon and select the desired option: 

 

Figure 292 - Printing a Set File 
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Appendix D – Consultant Submittal Review 

Stamps 

Consultant Designers can import the Bluebeam User Profile using the following link.  This profile 
imports all the commenting tools in the correct format.   
Download the profile from this link: CTDOT Bluebeam User Profile.  Just double click on the file 
located in the zip file and the profile will be imported.   
After the profile is imported the following must be done. 

1. Delete the Submittal Review stamp that is in the tool chest as shown below: 

 

Figure 293 - Deleting the Stamp 

 
 

2. Next Consultant Designers will need to save the following stamp to their computer and 

edit it to add their company name and address.  The following will show how to do that: 

3. Save this stamp file to your computer in a folder somewhere called Blubeam Stamps.  

Note:  The stamp file will be a PDF.    Form 816 - Consultant Submittal Review Stamp or 

January 2015 Supplemental Form 816 Stamp – Consultant Submittal Review Stamp 

Supplementals 

4. Open the stamp file using Bluebeam. 

 

http://www.ct.gov/dot/lib/dot/documents/aec/ctdot_bluebeam_user_profile.zip
http://www.ct.gov/dot/lib/dot/documents/aec/consultant_submittal_review.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/02-submittal_review.pdf
http://www.ct.gov/dot/lib/dot/documents/aec/02-submittal_review.pdf
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5. Update the Company Name and Address as shown below: 

 

Figure 294 - Updating Stamp for Company Name and Address 

After the company name and address is updated it should look like this: 

 

Figure 295 - Updated Stamp 

6. After the stamp is updated click save.   
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7. Next go to Markup>Stamp> and Select Change Stamp Folder.   

 

Figure 296 - Changing the Stamp Folder 

8. Browse out to where the submittal review stamp has been saved and click OK: 

 

Figure 297 - Browsing to the Stamp 

9. Now when you click on Markup>Stamp it will be in the list. 
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10. Next go into the tool chest and open the “Recent tools” as shown below: 

 

Figure 298 - Bluebeam Recent Tools 

11. Now place the stamp on any PDF document by selecting it in Markup>Stamp as shown 

below: 

 

Figure 299 - Placing a Stamp in Bluebeam 
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12. Select Conforms when the javascript window pops up and click OK: 

 

Figure 300 - Bluebeam Stamp 

13. After the stamp has been placed you will see the stamp in the recent tools.  Drag it from 

the recent tools into the CTDOT Shop/Working Drawing Review Tools as shown below: 

 

Figure 301 - Adding the Custom Stamp to the Tool Chest 
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14. Then Save Profile so the stamp will always be in the Tool Chest. 

 

Figure 302 - Saving Bluebeam Profile 
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Appendix E – Projectwise Attributes Table 

Table 4 - Projectwise Attribute Assignments –Contract Plans and Contract Specifications 

 Attributes 

Document Discipline Main 
Category 

Sub 
Category 

Label Description Asset Tags 

Contract Plans – Upload to the 100_Contract_Plans Folder 

Contract 
Plans 

CT CON FDP  Name of the subset, 01-General 
for the General subset.  The 
label should match what is listed 
on the title sheet.  

 FDP and DCD submittals shall 
always have the same label.    

 CTDOT standard drawing shall 
be “CTDOT_HIGHWAY_STD” and 
“CTDOT_TRAFFIC_STD”.  

 For Information Only subsets, 
FIO must be included in the 
Label, 11_AT&T_FIO.  

 

Type in a 
useful 

description 

 Asset Tags shall only 
be assigned to the 
contract plan 
subset(s) that detail 
an asset in a high 
level detail.  For 
example, the subset 
that contains bridge 
plans shall be tagged 
with that asset.  If 
there are multiple 
bridges detailed in a 
subset, the subset 
shall be tagged with 
both bridge nos.   

 

 DO NOT tag the 01-
General, 02-
Revisions, CTDOT 
Highway Standards, 
and CTDOT Traffic 
Standards with Asset 
Tags since they do 
not detail the asset 
in a high level of 
detail.  

 

 To assign the asset 
tag select the 
applicable bridge 
no(s), sign 
structure(s), or signal 
intersection(s) that 
is/are associated 
with the document.  
Hold CTRL to select 
multiple asset 
numbers.  

 

CT CON DCD 

CT CON DCD2 

CT CON FPL 

CT CON ADP  ADP and ACD submittals shall 
have the same label as the FDP 
plans with the addition of A## 
on the end.  For example, 01-
General_A## 

 DCO Submittals shall have the 
same label as the FDP plans with 
the addition of C## on the end.  
For example, 01-General_C## 

CT CON ACD 

CT CON DCO 

Set File CT CON Set File 00-Set File  NA 

Contract Specifications – Upload to the 240_Contract_Development Folder except for CSP specs, upload these to the 
110_Contract_Specifications folder 

Contract 
Specificatio
ns 

CT CON FSP FDP Specs. Type in a 
useful 
description 

Do not assign asset tags to 
specifications CT CON FSR Revised FDP Specs.  

CT CON ASP Addendum # Specs.  

CT CON ASR Revised Addendum Specs. 

CT CON CSP Change Order # Specs.  

 
 
 
 
 
 
 
 
 



 Connecticut Department of Transportation – Digital Project Development Manual

Issued 04-2016 250 Version 3.13 
     

Table 5 - Projectwise Attribute Assignments - Supplemental Contract Documents 

 Attributes 

Document Discipline Main 
Category 

Sub 
Category 

Label Description Asset Tags 

Supplemental Contract Documents – 240_Contract Development Folder 

Proposal Estimate CT CALCS Estimates Proposal 

Type a useful 
description 

N/A 

Proposal Estimate 
Checklist 

CT MISC FInal Proposal Est. Checklist 
 

Federal Estimate CT CALCS Estimates Federal 

Calendar Day Estimate CT CALCS Estimates Calendar Day 

Final Design Report CT REPORT Final Final Design 

Categorical Exclusion  CT MISC Final Categorical Exclusion  

Design Approval Letter CT APPROVAL Final Design Approval 

Environmental Permits CT PERMIT Permits  Inland Wetland 

 SHPO 

 Flood Management 

 Environment Review 

 Natural-Water 
Resources 

 Tribal 

 Endangered Species 

 Fisheries 

DBE/SBE Approval with 
percentages 

CT APPROVAL Final DBE/SBE Approval 

Commitment List CT MISC Final Commitment List 

Agreements CT AGREEMENT Final Name of the Agreement 

Proprietary Item 
Approval 

CT APPROVAL Final Proprietary Item  

Standalone 
Transportation  
Management Plan 
Document,  
taken from the final 
design  
report 

CT MISC Final  Trans. Man. Plan 

Item List for 
Contractor Submittals 

CT MISC Final CNS Item List 
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Table 6 - Projectwise Attribute Assignments – Engineering Reports, GIS Documents, and ROW 
Documents 

 Attributes 

Document Discipline Main 
Category 

Sub 
Category 

Label Document 
Date 

Description Asset Tags 

Engineering Reports – Upload to 130_Engineering Reports Folder 

Hydraulic Report CT REPORT Final Hydraulic 

Date of 
Report 

Type in 
Featured 
Crossed 

Assign 
Applicable 
asset tags 

Hydraulic Report Data CT REPORT Final Hydraulic Data 

Scour Report CT REPORT Final Scour 

Scour Report Data CT REPORT Final Scour Data 

Floodway Report CT REPORT Final Floodway 

Floodway Report Data CT REPORT Final Floodway Data 

Final Drainage Report CT REPORT Final Final Drainage 

Final Drainage Report 
Data 

CT REPORT Final Final Drainage Data 

Geotechnical Report CT REPORT Final Geotechnical  A useful 
description. 

 
 

N/A 
Task 110 CT REPORT Final Task 110 

Task 220 CT REPORT Final Task 220 

Underground Storage 
Tank System Closure 
Reports 

CT REPORT Final Underground Storage 
Tank System Closure 
Reports 

Rehabilitation Reports CT REPORT Final RSR Assign 
Applicable 
asset tags 

Load Rating CT REPORT Final Load Rating 

GIS Documents – Upload to the 150_GIS folder 

Project Polygon File 
(.dgn) 

CT CAD Misc Boundary 

N/A 

Project 
Limits – 
Town(s) 

N/A 

Project Polygon File 
(.KMZ) 

CT CAD Misc Boundary 

ROW Parcel 
Microstation File (.dgn) 

CT CAD Misc Parcel Serial (Town#)  i.e.     
Parcel 004 (157) 

A useful 
description 
such as 
property 
owner’s 
name (e.g 
CL&P) 

ROW Parcel 
Microstation File (.KMZ) 

CT CAD Misc Parcel Serial (Town#)  i.e.     
Parcel 004 (157) 

ROW Documents –Property Map (.dgn) to 500_Pre-Design>05_Property_Maps Folder , Property Map (.pdf) to the 
310_Review_Documents folder 

Property Map (.dgn) CT CAD MAP Parcel Serial (Town#)  i.e.     
Parcel 004 (157) 

N/A 

A useful 
description 

such as 
property 
owner’s 

name (e.g. 
CL&P) 

N/A 
Property Map (.pdf) CT CAD MAP Parcel Serial (Town#)  i.e.     

Parcel 004 (157) 

Table 7 - Projectwise Attribute Assignments – Contractor Submittals 

 Attributes 

Document Discipline Main Category Sub 
Category 

Label Document 
Date 

Description Asset Tags 

Contractor Submittals – 120_Contractor_Submittals 

Working Drawings 
for Permanent 
Structures 

CTR CONTRACTOR Working 
Drawings 

###-Item Number-##  

Date of 
Submittal 

Type a useful 
description 

Assign 
Applicable 
asset tags 

Working Drawings 
for Temporary 
Structures 

CTR CONTRACTOR Working 
Drawings 

###-Item Number-##   Assign 
Applicable 
asset tags 

Shop Drawings CTR CONTRACTOR Shop 
Drawings 

###-Item Number-## Assign 
Applicable 
asset tags 

Product Data 
 

CTR CONTRACTOR Product 
Data 

###-Item Number-## Assign 
Applicable 
asset tags 

Submittals CTR CONTRACTOR Submittals ###-Item Number-## Assign 
Applicable 
asset tags 

RFI CTR CONTRACTOR RFI RFI  - # N/A 

RFC CTR CONTRACTOR RFC RFC  - # N/A 
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Table 8 - Projectwise Attribute Assignments – Discipline General Attributes 

The following table shows attributes that are available for each discipline.  The table shows SB 
for Structure Bridge, but the attributes are available to all the disciplines. 

 Attributes 

Document Discipline Main 
Category 

Sub Category Label Document 
Date 

Description Asset Tags 

Design Documents – 140 Project Administration Folder for Final Versions of Documents and 330_Design Data Folders for Draft Versions of 
Documents 

Agreements SB AGREEMENTS Draft or Final Agreement No. or 
Name  

Date 

Type a useful 
description 

Assign Applicable asset tags 

Analysis SB ANALYSIS Draft or Final Title of Analysis Assign Applicable asset tags 

Approvals SB APPROVAL Draft or Final Title of Approval Assign Applicable asset tags 

Design Models SB CAD Design Title of Design, i.e. 
Master Design  

N/A N/A 

Sheet Models SB CAD Sheet Drawing No. i.e. 
PLN-1 or S-1 

N/A N/A 

Misc. DGN File SB CAD Misc Title of file N/A N/A 

Resource Files 
(Microstation 
Data or 
Preference 
Files) 

SB CAD Resource Title of file N/A N/A 

Maps SB CAD MAP Title of Map Date N/A  

Draft Dgn Files SB CAD DRAFT Title of file N/A N/A 

Asset related 
Microstation 
file 

SB CAD ASSET Title of file N/A Assign Applicable asset tags 

Estimate 
Calculations 

SB CALCS Estimates Title of Estimate 
Calc. 

Date N/A 

Quantity 
Calculations 

SB CALCS Quantity Title of Quantity 
Calc. 

Date N/A 

Design 
Calculations 

SB CALCS Design Title of Design Calc. Date Assign Applicable asset tags 

Invoices SB INVOICE Invoices Title of Invoice Date of 
Invoice 

N/A 

Letters SB LETTERS Draft or Final Title of Letter Date of 
Letter 

Assign Applicable asset tags 

Photos SB MEDIA Photos Date or Title of 
Photos 

N/A N/A 

Videos SB MEDIA Videos Date or Title of 
Videos 

N/A N/A 

Presentations SB MEDIA Presentations Title of 
presentation 

N/A N/A 

Meeting 
Related 
Documents 

SB MEETING Draft or Final Title of Meeting 
document 

Date of 
Meeting 

N/A 

Memos SB MEMO Draft or Final Title of Memo Date of 
Memo 

N/A 

Miscellaneous 
Documents 

SB MISC Draft or Final Title of Document N/A N/A 

Permit Related 
Documents 

SB PERMIT Permits Title of Permit 
Document 

Date N/A 

Reports SB REPORT Draft or Final Title of Report Date of 
Report 

Assign Applicable asset tags 

Requests SB REQUEST Draft or Final Title of Request Date of 
Request 

N/A 

Schedules SB SCHEDULES Draft or Final Title of Schedule Date  N/A 

Scopes SB SCOPE Draft or Final Title of Scope Date of 
Scope 

Assign Applicable asset tags 

Specs. SB SPECS Draft or Final    

Ground Files SB SURVEY Ground Ground File Date N/A 

GPS Documents SB SURVEY GPS Title of Document Date N/A 

DEM 
Documents 

SB SURVEY DEM Title of Document Date N/A 

Survey Control 
Documents 

SB SURVEY Control Title of Document Date N/A 
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